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1
product overview

This chapter presents an overview of the hardware components of the hp workstation xw4100. 
For a more detailed overview of all the hardware components and spare part numbers refer to the 
hp workstation xw4100 Illustrated Parts Map.

1.1 product features

1.1.1 front panel components
The following illustration shows a typical hp workstation xw4100. Drive configurations may 
vary depending on the configuration that was purchased.

front panel components 

1 Optical Drive* (optional) 6 Diskette Eject Button q USB (Universal Serial Bus) Ports

2 Optical Drive Activity Lights 7 Optical Drive Eject Button w Headphone Connector

3 5.25 inch drive bays 8 Power On Light e Microphone Connector

4 Diskette Drive (optional) 9 Power Button r IEEE-1394 Connector**

5 Diskette Drive Activity Light - Hard Drive Activity Light

*An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD+R/RW, or CD-RW/DVD combo drive.

**IEEE-1394 is an optional feature. If the workstation was purchased without this option, then this 
connector will be covered.
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1.1.2 rear panel components

rear panel components

1 Power Cord Connector 7 Audio Line-Out Connector (lime)

2 Voltage Select Switch 8 Graphics Adapter (optional)

3 PS/2 Keyboard Connector (purple) 9 Audio Line-In Connector (light blue)

4 Serial Connector (teal) - RJ-45 Network Connector

5 Universal Serial Bus (USB) q Parallel Connector (burgundy)

6 Microphone Connector (pink) w PS/2 Mouse Connector (green)

NOTE: The rear panel connectors are labeled with industry-standard icons to assist you in connecting your 
peripheral devices. Also, industry-standard colors are used in identifying the connectors.
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1.1.3 system board components
The following illustration shows the system board connectors and sockets on the hp workstation 
xw4100.

system board components

1 Control panel connector r DIMM sockets (4)

2 Jumper switches t MultiBay connector

3 Security (TPM module) connector y Secondary IDE connector*

4 Speaker connector u Diskette drive connector

5 Auxiliary audio input connector i Main power connector

6 Front audio connector o Primary IDE connector**

7 CD audio input connector p Front USB connector

8 PCI sockets (5) a Battery

9 AGP socket s Hood lock connector

- Chassis fan connector d CMOS reset button

q Processor socket/heatsink f Serial ATA connectors(2)***

w Processor heatsink fan connector g Hood sensor connector

e 12V auxiliary power connector h SCSI LED connector

*The Secondary IDE connector is generally used for optical drives.
**The Primary IDE connector is generally used for hard drives.
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1.1.4 serial number and COA label location
Each workstation has two unique serial number labels and a certificate of authentication (COA) 
label. The serial number labels 1 are located on the top (in a minitower configuration) of the 
unit and on the rear panel. Keep this number available when contacting customer service for 
assistance. The COA label 2 is located on the top panel (in a minitower configuration).

serial number and COA label locations
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1.2 product specifications
The following table shows the general specifications of the hp workstation xw4100.

1.2.1 graphics and AGP slot power specifications
Your workstation contains five PCI slots that support a total maximum power of 40 W. Each PCI 
slot supports a maximum of 25 W. The workstation also contains a single AGP slot that supports 
a total maximum power of 25W. The total maximum power output that can be supported on all 
slots (PCI and AGP) is 65W.

NOTE: For hardware specifications of other system components, such as graphics cards or optical 
drives, visit the Web site of the specific manufacturer.

weight 16 kg/35 lb

tower dimensions 
(H x W x D)

45.0 x 16.8 x 45.6 cm/17.7 x 6.6 x 17.9 in

power supply input current 3.6 A @ 115 VAC
1.8 A @ 230 VAC

line frequency 50 to 60 Hz

maximum rated power 412 W input, 280 W output

maximum BTU Load 1.47K BTU/HR

temperature operating 
non-operating

10 to 35 C/5 to 95 F 
-30 to 60 C/-22 to 140 F

humidity operating 
non-operating

15% to 80% 
10% to 90%

maximum altitude 
(non-pressurized)

operating 
non-operating

3,048 m/10,000 ft 
4,572 m/15,000 ft
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1.3 Energy Star®
The Energy Star program is a government-backed initiative to promote energy efficiency by 
identifying ways to reduce energy consumption at home or in the office. Select HP workstations 
participate in the Energy Star program.

NOTE: Energy Star is not supported on Linux-based workstations.

For those workstations that support Energy Star and have it enabled, the power management 
features will be set as follows:

■ Monitor—goes into sleep mode after 15 minutes of inactivity.

■ System—goes into Standby mode after 15 minutes of inactivity.

■ Hard Drive—goes into power savings mode after the system goes into Standby mode.

NOTE: Should you have to restore the operating system, Energy Star settings (if applicable) will 
need to be reset after the restore.

To verify the factory default power settings for your product, go to the Control Panel and 
double-click on Power Options.

1.3.1 LED color definitions
An LED light exists on the front panel of your workstation. The following table describes what 
each color signifies. 

1.3.2 Energy Star compliance
HP products purchased with the Energy Star configuration are compliant with the U.S. 
Environmental Protection Agency (EPA) Energy Star Computers Program. The EPA Energy Star 
configuration does not imply endorsement by the EPA. As an Energy Star Partner, HP has 
determined that products with the Energy Star configuration meet the Energy Star guidelines 
for energy efficiency.

The Energy Star Computers Program was created by the EPA to promote energy efficiency and 
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. 
HP products achieve this by reducing the power consumption when not being used.

The power management feature is compatible with operating systems and environments that 
support APM1.2. This means that users in those environments will not be disconnected from 
the network during the low-power operating state.

LED Color System Status

Green System is on. 

Yellow or Orange System is in Standby.

No light System is in Hibernate, or it is off.
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The Power Management feature, when used in conjunction with an external Energy Star 
compliant monitor, will support the power-down features of the monitor. The Power 
Management feature allows an external monitor to go into low-power mode when the 
energy save timeout occurs.

Ä
CAUTION: Using the Energy Save Monitor feature with non–Energy Star compliant monitors may cause 
video distortion when the Energy Save timeout occurs.

1.4 Hyper-Threading Technology
Hyper-Threading Technology is a high performance technology, developed by Intel®, that allows 
a single processor to execute multiple threads of instructions simultaneously. Hyper-Threading 
Technology enables the processor to utilize its execution resources more efficiently, delivering 
performance increases and improving user productivity. Not all systems benefit from the 
Hyper-Threading Technology.

To see if Hyper-Threading Technology can benefit you, test your system by turning the feature 
on. Computer Setup (F10) can be used to turn this feature on. To do this, run F10 Setup 
during boot up and select Advanced > Device Options > Hyper-Threading, and enable the 
Hyper-Threading Technology.

NOTE: If your workstation does not support Hyper-Threading Technology, the Hyper-Threading 
menu item will not be available on the Computer Setup menu.

NOTE: The Hyper-Threading Technology is recommended for use with Windows XP systems. 
This technology is detected by the system and is turned on in the operating system after it is 
enabled in the system BIOS.

NOTE: Hyper-Threading is not recommended for use with Windows 2000-based workstations.

NOTE: With the release of Red Hat Enterprise Linux WS 3.0, Hyper-Threading Technology will 
be compatible with Linux-based systems. An SMP kernel must be installed on your system 
before this technology can be enabled.

For more information about the Hyper-Threading Technology, you can visit the Intel® Web site 
at www.intel.com.
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1.5 finding additional information
The following resources are also available:

■ Documentation Library CD—This CD ships with your workstation and has the following 
documentation:

❏ Getting Started Guide (available in print and PDF on the CD) 
Helps you set up hardware and factory-provided software; also includes basic 
troubleshooting information should you encounter any problems during initial startup.

❏ Safety and Comfort Guide (available in PDF on the CD) 
Provides safety and ergonomic information to assist the user in setting up a safe and 
comfortable workstation environment.

❏ Safety and Regulatory Information Guide (available in PDF on the CD) 
Provides safety and regulatory information that ensures compliance with U.S., Canadian, 
and various international regulations.

■ The following links can also be accessed for additional information:

❏ For information about this and other HP products: 
www.hp.com

❏ For information about the Microsoft Windows operating system: 
www.microsoft.com

❏ For information about the Linux operating system: 
www.redhat.com

■ hp workstation xw4100 Illustrated Parts Map—This document provides an overview of all 
spares for the workstation as well as some basic system information.

■ Quick Reference Guide (QRG)—This document provides general hardware information and 
is offered through a subscription service. To order this document, call 1-800-952-7689 
(1-800-567-1616 in Canada) and ask for part number 184960-001.

■ Additional product information is available from the HP Web site at: 
www.hp.com/go/workstationsupport.
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2
installing or restoring the operating system

Depending on the workstation model, Microsoft™ Windows® 2000 Professional, Windows XP 
Professional, or Red Hat® Linux® is preinstalled and will be configured automatically the first 
time the workstation is turned on.

Ä
CAUTION: Do not add optional hardware devices to your workstation until the operating system is 
successfully installed. Doing so may cause errors and may prevent the operating system from installing 
properly.

Ä
CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION 
UNTIL THE PROCESS IS COMPLETE. Turning off the workstation during the installation process might 
damage the software that runs the workstation.

2.1 installing the operating system and software
The following section discusses the operating system and HP software installation procedures.

2.1.1 Microsoft Windows 2000 Professional
The first time the workstation is turned on, Microsoft Windows and HP software is automatically 
installed. This takes approximately 10 minutes, depending on the system hardware configuration. 
At the beginning of the installation process, you are prompted to select the appropriate language 
for the operating system. Read and follow the instructions that appear on the screen to complete 
the installation. During this process, do not turn off your workstation unless you are directed to 
do so.

For complete operating system installation and configuration instructions, refer to the operating 
system documentation that was provided with the workstation. Additional information is 
available in the online help after you install the operating system.

installing or upgrading device drivers
To install hardware devices such as a printer, a display adapter, or network adapter after the 
operating system installation is completed, the operating system needs access to the appropriate 
software drivers for the devices. These drivers are available on the Support Software CD that 
shipped with your system.

The I386 directory and its subdirectories provide the HP-specific integration of the operating 
system for the workstation model and include device drivers supported by Windows 2000.

When prompted for the I386 directory on the operating system CD, replace the path specification 
with C:\I386 or use the browse button of the dialog box to search for the I386 folder. For 
Windows 2000, no further steps are required.

NOTE: The service pack for Windows 2000 Professional has been integrated into the program.
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creating an emergency repair diskette
1. Click Start > Programs > Accessories > Backup.

2. Select the menu option Tools, then select Create an Emergency Disk.

3. Follow the instructions that appear on the screen.

using the emergency repair diskette
1. Insert the diskette into the diskette drive and restart the workstation (you may boot the 

workstation to the Windows 2000 CD on some workstations).

2. Press Enter to start the repair process, then choose to repair the system.

3. Select the Emergency Repair Process.

4. Follow the instructions that appear on the screen.

2.1.2 Microsoft Windows XP Professional
The first time you turn on your workstation, you will be prompted to select a language for the 
operating system. After selecting the language, read and follow the instructions on the screen 
to complete the installation of the operating system. This takes approximately 10 minutes, 
depending on the system hardware configuration. During the process, do not turn off your 
workstation unless you are directed to do so.

installing or upgrading device drivers
To install hardware devices such as a printer, a display adapter, or network adapter after the 
operating system installation is completed, the operating system needs access to the appropriate 
software drivers for the devices. Device drivers are usually provided on a CD supplied with the 
peripheral device.

Some existing peripheral devices may not have been shipped with drivers developed for 
Windows XP. To locate the most current device drivers, go to www.hp.com.

creating a restore diskette
To create a restore diskette for Windows XP, go to Start > Programs > Accessories > System 
Tools > System Restore, and follow the instructions on the screen.
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2.1.3 Red Hat Linux
The first time the workstation is booted, the Linux Setup Tool utility displays. This program 
allows you to enter your password, network, graphics, time, and keyboard settings for your 
workstation.

Ä
CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION 
UNTIL THE PROCESS IS COMPLETE. Turning off the workstation during the installation process may 
damage the software that runs the workstation or prevent its proper installation.

NOTE: When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you 
may get a blank screen for about 15-30 seconds after you have selected and saved all of your 
settings and have exited the utility. This is normal. The boot process continues its execution after 
the screen returns.

NOTE: In the Time/Time Zone tab of the Linux Setup Tool utility, the Time Zone Region must be 
selected first and then the City, before clicking the Save/Exit button.

upgrading device drivers
Should you ever have to upgrade a Linux device driver, visit the HP Web site at: 
http://www.hp.com/go/workstationsupport.

You can also visit Red Hat’s Web site at www.redhat.com to check the availability of additional 
device drivers.

2.1.4 hp software
The following HP software will also be installed the first time the workstation is turned on: 

■ Computer Setup (F10) Utilities and diagnostic features

■ HP Support Software including device drivers

■ Configuration Record

■ HP Intelligent Manageability (available for download from 
http://www.hp.com/go/workstationsupport)

■ Enhanced HP Insight Personal Edition (Diagnostics for Windows) (not supported for Linux)

■ DMI Support

■ Power Management Setup with energy saver features (not supported for Linux)

■ Security Management tools

■ Software Support Management tools
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Certain drivers and utilities are available only in selected languages. You can obtain the latest 
version of these files, in English and selected other languages, in one of three ways:

■ Support Software CD 

■ HP Web site at www.hp.com

■ Restore Plus! CD, which is supplied with Windows-based workstations

■ hp workstations Red Hat Linux with hp additions CD, which is supplied with Linux-based 
workstations

NOTE: Additional HP software may be required in certain situations.

2.2 restoring the operating system
The following sections discuss the procedures for restoring the operating system and applications 
software.

2.2.1 Microsoft Windows 2000 Professional and Windows XP 
Professional
Restore the original operating system and factory-installed software by using the Restore Plus! 
CD and the OS CD that came with the workstation. Carefully read and follow the instructions 
provided with the Restore Plus! CD.

2.2.2 Red Hat Linux
Should a recovery of the OS or software be required, insert the hp workstations Red Hat Linux 
with hp additions (Binary Disk 1/3) CD and follow the prompts on the screen to successfully 
complete the recovery process.

2.3 protecting the software
To protect software from loss or damage, you should keep a backup copy of all system software, 
applications, and related files stored on the hard drive. See the operating system or backup utility 
documentation for instructions on making backup copies of data files.

2.4 ordering backup software
All software that shipped with the workstation, including the Restore Plus! CD, can be ordered 
from HP as a single set, or you can order the various software packages separately.

NOTE: Before calling HP to order the software, be sure to have the serial number of the 
workstation available. This number is necessary for all diskette orders. See the “serial number 
and COA label location” section in Chapter 1, for the location of the serial number on the 
workstation.
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system management

This section discusses the various tools and utilities that allow for the system management of the 
hp workstation xw4100.

3.1 Computer Setup (F10)
The Computer Setup (F10) utilities that allow you to:

■ Change factory default settings and to set or change the system configuration, which may be 
necessary when you add or remove hardware.

■ Determine if all of the devices installed on the workstation are recognized by the system and 
functioning properly.

■ Determine information about the operating environment of the workstation.

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Establish and manage passwords and other security features.

■ Establish and manage energy-saving timeouts (not supported for Linux platforms).

■ Modify or restore factory default settings.

■ Set the system date and time.

■ Set, view, change, or verify the system configuration including settings for processor, 
graphics, memory, audio, storage, communications, and input devices.

■ Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, 
or LS-120 drives.

■ Configure the boot priority of IDE (ATA) and SCSI hard drive controllers.

■ Enable Quick Boot which is faster than Full Boot but does not run all of the diagnostic tests 
run during a Full Boot. You can set your system to:

❏ always Quick Boot (default);
❏ periodically Full Boot (from every 1 to 30 days); or
❏ always Full Boot.

■ Enable or disable Network Server Mode, which allows the workstation to boot the operating 
system when the power-on password is enabled with or without a keyboard or mouse 
attached. When attached to the system, the keyboard and mouse remain locked until the 
power-on password is entered.

■ Select POST Messages Enabled or Disabled to change the display status of Power-On 
Self-Test (POST) messages. POST Messages Disabled suppresses most POST messages, 
such as memory count, product name, and other non-error text messages. If a POST error 
occurs, the error is displayed regardless of the mode selected. To manually switch to POST 
Messages Enabled during POST, press any key (except F1 through F12).
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■ Establish an Ownership Tag, the text of which is displayed each time the system is turned on 
or restarted.

■ Enter the Asset Tag or property identification number assigned by your company to this 
workstation.

■ Enable power-on password prompting during system restarts (warm boots) as well as during 
power-on.

■ Secure the integrated I/O functionality, including the serial, USB, or parallel ports, audio, or 
embedded NIC, so that they cannot be used until they are unsecured.

■ Enable or disable Master Boot Record (MBR) Security.

■ Enable or disable removable media boot ability.

■ Enable or disable removable media write ability (when supported by hardware).

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Replicate your system setup by saving system configuration information on diskette and 
restoring it on one or more workstations.

■ Execute self-tests on a specified IDE (ATA) hard drive (when supported by the drive).

NOTE: All features identified in this chapter may not be available on all HP products.

3.1.1 using Computer Setup (F10)
Computer Setup can be accessed only by turning on the workstation or restarting the system. To 
access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the workstation. If you are in Windows, click Start > Shut Down > Restart 
the Computer.

2. Press the F10 key as soon as the monitor light turns green.

NOTE: If you do not press the F10 key at the appropriate time, you must turn the workstation off, 
then on again, and press the F10 key again to access the utility.

3. Select your language from the list and press the Enter key. A choice of four headings 
appears in the Computer Setup Utilities menu: File, Storage, Security, and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and 
down) keys to select the option you want, then press Enter.

5. To apply and save changes, select File > Save Changes and Exit.

❏ If you have made changes that you do not want applied, select Ignore Changes and Exit.

❏ To reset to factory settings, select Set Defaults and Exit. This option will restore the 
original factory system defaults.

Ä
CAUTION: Do NOT turn the workstation power OFF while the ROM is saving your Computer Setup F10 
changes because the CMOS could become corrupted. It is safe to turn off all power to the workstation 
after you exit the F10 Setup screen.
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3.1.2 Computer Setup menu
.

heading option description

File System Information Lists product name, processor type/speed/stepping, cache size 
(L1/L2), system ROM family and version, installed memory 
size, chassis serial number, integrated MAC for enabled or 
embedded NIC (if applicable), and asset tracking number.

About Displays copyright information.

Set Time and Date Allows you to set system time and date.

Save to Diskette Saves system configuration, including CMOS, to a formatted blank 
1.44-MB diskette in file CPQsetup.txt. Save/Restore for DiskOnKey 
is supported.

Restore from 
Diskette

Restores system configuration from a diskette. Save/Restore for 
DiskOnKey is supported.

Set Defaults 
and Exit

Restores factory default settings which includes clearing any 
established passwords.

Ignore Changes 
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes 
and Exit

Saves changes to system configuration and exits Computer Setup.

Storage Device 
Configuration

Lists all installed non-SCSI storage devices. 
NOTE: SCSI storage drives will not be listed in Computer Setup (F10).

When a device is selected, detailed information and options are 
displayed. The following options may be presented:

Diskette Type (for legacy diskette drives only) 
Identifies the highest capacity media type accepted by the diskette 
drive. Options are 3.5" 1.44 MB, 5.25" 1.2 MB, and Not Installed.

Drive Emulation (IDE devices only) 
Allows you to select a drive emulation type for a storage device. 
(For example, a Zip drive can be made bootable by selecting disk 
emulation.)

Drive Type Emulation Options

ATAPI Zip drive None (treated as Other).

Diskette (treated as diskette drive).

Disk (treated as hard drive).

IDE Hard disk None (treated as Other). 
Disk (treated as hard drive).

Legacy diskette No emulation options available.

IDE CD-ROM No emulation options available.

ATAPI LS-120 No emulation options available.
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Storage 
(continued)

Device 
Configuration 
(continued)

Transfer Mode (IDE devices only) 
Specifies the active data transfer mode. Options (subject to device 
capabilities) are PIO 0, Max PIO, Enhanced DMA, Ultra DMA 0, 
and Max UDMA.

Translation Mode (IDE disks only) 
Lets you select the translation mode to be used for the device. This 
enables the BIOS to access disks partitioned and formatted on other 
systems and may be necessary for users of older versions of Unix 
(e.g., SCO Unix version 3.2). Options are Bit-Shift, LBA Assisted, 
User, and None.

Ä Ordinarily, the translation mode selected automatically by the 
BIOS should not be changed. If the selected translation mode is 
not compatible with the translation mode that was active when the 
disk was partitioned and formatted, the data on the disk will be 
inaccessible.

Translation Parameters (IDE disks only) 
Allows you to specify the parameters (logical cylinders, heads, and 
sectors per track) used by the BIOS to translate disk I/O requests 
(from the operating system or an application) into terms the hard 
drive can accept. Logical cylinders may not exceed 1024. The 
number of heads may not exceed 256. The number of sectors 
per track may not exceed 63. These fields are only visible and 
changeable when the drive translation mode is set to User.

Multisector Transfers (IDE disks only) 
Specifies how many sectors are transferred per multi-sector PIO 
operation. Options (subject to device capabilities) are Disabled, 
8, and 16.

Options Removable Media Boot
Enables/disables ability to boot the system from removable media.
Removable Media Write
Enables/disables ability to write data to removable media.

NOTE: This feature applies only to legacy diskette, (IDE/ATA) LS-120 
Superdisk, (IDE/ATA) LS-240 Superdisk, and (IDE/ATA) PD-optical 
drives.
NOTE: After saving changes to Removable Media Boot, the 
workstation will restart. Manually, turn the workstation off, then on.

Primary IDE Controller
Allows you to enable or disable the primary IDE/ATA controller.

Secondary IDE Controller
Allows you to enable or disable the secondary IDE/ATA controller.

BIOS IDE DMA
Allows you to enable or disable the BIOS use of DMA for IDE data 
transfers.

Storage 
(continued)

Options 
(continued)

SATA Configuration
Allows you to select how the SATA controller will be configured 
(adds as Separate Controller or Replace Primary IDE Controller).

heading option description
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Diskette MBR Validation
Allows you to enable or disable strict validation of the diskette 
Master Boot Record (MBR). 

NOTE: If you use a bootable diskette image that you know to be 
valid, and it does not boot with Diskette MBR Validation enabled, you 
may need to disable this option in order to use the diskette.

IDE DPS Self-Test Allows you to execute self-tests on IDE hard drives capable 
of performing the Drive Protection System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive 
capable of performing the IDE DPS self-tests is attached to the system.

Controller Order 
(this feature is 
supported on 
select models 
only.)

Allows you to specify the order of the attached hard drive 
controllers. The first hard drive controller in the order will have 
priority in the boot sequence and will be recognized as drive C 
(if any devices are attached).

NOTE: The selection will not appear if all hard drives are attached to 
the embedded IDE controllers.

SCSI Narrow 
Termination 
(supported on 
select models 
only.)

Allows you to configure SCSI termination on the external SCSI 
connector for narrow SCSI drives. The feature should only be 
enabled if using a narrow SCSI drive to terminate the external SCSI 
channel.

Boot Order Allows you to specify the order in which attached peripheral devices 
(such as a diskette drive, hard drive, optical drive, or network 
interface card) are checked for bootable operating system image. 
Each device on the list may be individually excluded from or 
included for consideration as a bootable operating system source.

NOTE: MS-DOS drive lettering assignments may not apply after a 
non-MS-DOS operating system has started.

Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device 
specified in Boot Order, restart the workstation and press F9 when 
the F10=Setup message appears on the screen. After POST is 
completed, a list of bootable devices is displayed. Use the arrow 
keys to select the preferred bootable device and press Enter. The 
workstation then boots from the selected non-default device for this 
one time.

Security Setup Password Allows you to set and enables setup (administrator) password.
NOTE: If the setup password is set, it is required to change Computer 
Setup options, flash the ROM, and make changes to certain plug and 
play settings under Windows.

Power-On 
Password

Allows you to set and enable power-on password.

Security 
(continued)

Password Options 
(This selection 
will appear only 
if a power-on 
password is set.)

Allows you to specify whether the password is required for warm 
boot (CTRL+ALT+DEL).

heading option description
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Hood cover sensor Allows you to enable/disable solenoid hood cover lock.
NOTE: Notify User alerts the user that the sensor has detected that the 
cover has been removed. Setup Password requires that the setup 
password be entered to boot the workstation if the sensor detects that 
the cover has been removed.

This feature is supported on select models only.

DriveLock Allows you to assign or modify a master or user password for 
certain hard drives. When enabled, the user is prompted to provide 
one of the DriveLock passwords during POST. If neither is 
successfully entered, the hard drive will remain inaccessible until 
one of the passwords is successfully provided during a subsequent 
cold-boot sequence.
This selection will only appear when at least one drive that supports 
the DriveLock feature is attached to the system.

Master Boot 
Record Security*

Allows you to enable or disable Master Boot Record (MBR) Security.
When enabled, the BIOS rejects all requests to write to the MBR on 
the current bootable disk. Each time the workstation is powered on 
or rebooted, the BIOS compares the MBR of the bootable disk to the 
previously saved MBR. If changes are detected, you are given the 
option of saving the MBR on the current bootable disk, restoring the 
previously-saved MBR, or disabling MBR security. You must know 
the setup password if one is set.

NOTE: Disable MBR Security before intentionally changing the 
formatting or partitioning of the current bootable disk. Several disk 
utilities (such as FDISK and FORMAT) attempt to update the MBR. 
 
If MBR Security is enabled and disk accesses are being serviced by the 
BIOS, write requests to the MBR are rejected, causing the utilities to 
report errors. 
 
If MBR Security is enabled and disk accesses are being serviced by the 
operating system, any MBR change will be detected by the BIOS 
during the next reboot, and an MBR Security warning message will be 
displayed.

Save Master Boot 
Record*

Saves a backup copy of the Master Boot Record of the current 
bootable disk.

NOTE: Only appears if MBR Security is enabled.

*Option supported on select models.

heading option description
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Security 
(continued)

Restore Master 
Boot Record*

Restores the backup Master Boot Record to the current bootable 
disk.

NOTE: Only appears if all of the following conditions are true: 
MBR Security is enabled. 
A backup copy of the MBR has been previously saved. 
The current bootable disk is the same disk from which the backup copy 
of the MBR was saved.

Ä Restoring a previously saved MBR after a disk utility or operating 
system has modified the MBR may cause the data on the disk to 
become inaccessible. Only restore a previously saved MBR ifyou 
are confident that the current bootable disk’s MBR has been 
corrupted or infected with a virus.

Device Security* Enables/disables serial ports A and B, parallel port, front USB 
ports, all USB ports, system audio, network controllers (some 
models), and SCSI controllers (some models).

Network Service 
Boot

Enables/disables the workstation’s ability to boot from an operating 
system installed on a network server. (Feature available on NIC 
models only; the network controller must reside on the PCI bus or 
be embedded on the system board.)

System IDs Allows you to set:
• Asset tag (18-byte identifier) and ownership Tag (80-byte 

identifier displayed during POST).
• Chassis serial number or Universal Unique Identifier (UUID) 

number. The UUID can only be updated if the current chassis 
serial number is invalid. (These ID numbers are normally set in 
the factory and are used to uniquely identify the system.)

• Keyboard locale setting (for example, English or German) for 
System ID entry.

*Option supported on select models.

heading option description
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Advanced** Power-On Options Allows you to set:
• POST mode (QuickBoot, FullBoot, or FullBoot every 1-30 days).
• POST messages (enable/disable).
• Safe POST* (enable/disable). Enabling this feature allows the 

ROM to monitor add-in cards during boot. If an add-in card 
does not work or initialize correctly, then on the next boot all 
cards will be skipped during POST.

• F9 prompt (enable/disable). Enabling this feature will display 
the text F9=Boot Menu during POST. Disabling this feature 
prevents the text from being displayed but pressing F9 will still 
access the Shortcut Boot (Order) Menu screen. See Storage > 
Boot Order for more information.

• F10 prompt (enable/disable). Enabling this feature will display 
the text F10=Setup during POST. Disabling this feature 
prevents the text from being displayed but pressing F10 will 
still access the Setup screen.

• F12 prompt (enable/disable). Enabling this feature will display 
the text F12=Network Service Boot during POST. 
Disabling this feature prevents the text from being displayed 
but pressing F12 will still force the system to attempt booting 
from the network.

• Option ROM* prompt (enable/disable). Enabling this feature 
will cause the system to display a message before loading 
options ROMs. 

• Remote wakeup boot source (remote server/local hard drive).
• After Power Loss (off/on): After power loss, if you connect your 

workstation to an electric power strip and would like to turn on 
power to the workstation using the switch on the power strip, set 
this option to ON.
NOTE: If you turn off power to your workstation using the switch on a 
power strip, you will not be able to use the suspend/sleep feature or 
the Remote Management features.

• POST Delay (in seconds) (enable/disable). Enabling this feature 
will add a user-specified delay to the POST process. This delay 
is sometimes needed for hard disks on some PCI cards that spin 
up very slowly; so slowly that they are not ready to boot by the 
time POST is finished. The POST delay also gives you more time 
to select F10 to enter Computer Setup (F10).

*Available on select models.
**These options should be used by advanced users only.

heading option description
3–8 hp workstation xw4100 service and technical reference guide



system management
Advanced** 
(continued)

Power-On Options 
(continued)

Allows you to set: (continued)
• I/O APIC Mode (enable/disable). Enabling this feature will 

allow Microsoft Windows Operating system to run optimally. 
This feature must be disabled for certain non-Microsoft 
Operating Systems to work properly.

• ACPI/USB Buffers @ Top of Memory (enable/disable). 
Enabling this feature places USB memory buffers at the top of 
memory. The advantage of remapping is that it allows space in 
the DOS Compatibility Hole range, below 1MB, to be made 
available for additional PCI plug-in cards that need option 
ROM space.

Onboard Devices Allows you to set resources for or disable onboard system devices 
(serial port, parallel port, or diskette controller).

PCI Devices Lists currently installed PCI devices and their IRQ settings.
Allows you to reconfigure IRQ settings for these devices or to 
disable them entirely. These settings have no effect under an 
APIC-based operating system.

Bus Options* Allows you to enable or disable:
• PCI bus mastering, which allows a PCI device to take control of 

the PCI bus.
• PCI VGA palette snooping, which sets the VGA palette 

snooping bit in PCI configuration space; only needed when 
more than one graphics controller is installed.

• PCI SERR# generation.
• ECC support allows hardware-based error correction for 

ECC-capable memories.

*Available on select models.
**These options should be used by advanced users only.

heading option description
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Advanced** 
(continued)

Device options Allows you to set:
• Printer mode (bi-directional, EPP+ECP, output only).
• Num Lock state at power-on (off/on).
• PME (power management event) wakeup events 

(enable/disable).
• Processor cache (enable/disable).
• Hyper-Threading* (enable/disable).
• ACPI S3* support (enable/disable). S3 is an ACPI (advanced 

configuration and power interface) sleep state that some add-in 
hardware options may not support.
NOTE: ACPI S3 selections are supported on select models only. If the 
ACPI S3 support option is not presented, the other ACPI S3 options 
(ACPI S3 Video REPOST, ACPI S3 Hard disk Reset, and ACPI S3 PS2 
Mouse Wakeup) will not be available. 

• ACPI S3 Video REPOST* (enable/disable). This feature reruns 
the video option ROM on a boot from the S3 state.

• ACPI S3 Hard Disk Reset* (enable/disable). Resets the hard 
disk on a boot from the S3 sleep state.

• ACPI S3 PS2 Mouse Wakeup* (enable/disable). Allows the 
mouse to wake the system from the S3 sleep state.

• AGP Aperture size*. Allows you to specify the amount of system 
memory reserved for use by your graphics controller.

• Monitor Tracking (enable/disable). Allows ROM to save 
monitor asset information.

• Unique Sleep State Blink Patterns*. Allows you to choose an 
LED blink pattern that uniquely identifies each sleep state.

• Frame Buffer Size*. Allows you to specify amount of system 
memory dedicated to the embedded graphics frame buffer. 
The AUTO setting attempts to optimize the frame buffer size 
depending on the amount of total system memory.

*Available on select models.
**These options should be used by advanced users only.

heading option description
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Advanced** 
(continued)

Device options 
(continued)

Allows you to set: (continued)
• PCI Slot x Option ROM Download. Allows you to 

enable/disable the downloading of the PCI slot option ROM. 
“x” can be a value of 1, 2, 3, 4, or 5.

• NIC PXE (enable/disable). The BIOS contains an embedded 
NIC option ROM to allow the unit to boot through the network 
to a PXE server. This is typically used to download a corporate 
image to a hard drive. The NIC option ROM takes up memory 
space below 1MB commonly referred to as DOS Compatibility 
Hole (DCH) space. This space is limited. The F10 option allows 
you to disable the downloading of the embedded NIC option 
ROM, giving more DCH space for other PCI cards which may 
need option ROM space. The default setting for the NIC option 
ROM is “enabled.”

PCI VGA 
Configuration

Displayed only if there are multiple PCI video adapters in the 
system. Allows you to specify which VGA controller will be the 
“boot” or primary VGA controller.

*Available on select models.
**These options should be used by advanced users only.

heading option description
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3.2 desktop management
HP Intelligent Manageability (available for download from 
http://www.hp.com/go/workstationsupport) provides standards-based solutions for managing 
and controlling workstations in a networked environment. This section summarizes the 
capabilities and features of the four key components of desktop management:

■ initial configuration and deployment

■ software updating and management

■ asset tracking and security

■ fault notification and recovery

NOTE: Support for specific features described in this guide may vary by model or software 
version.

3.2.1 initial configuration and deployment
HP workstations come with a preinstalled system software image. After a very brief software 
“unbundling” process, the workstation is ready to be used.

You may prefer to replace the preinstalled software image with a customized set of system and 
application software. There are several methods for deploying a customized software image. 
They include:

■ Installing additional software applications after unbundling the preinstalled software image.

■ Using software deployment tools, such as Microsoft MS Batch or NT Distribution Share 
(NTDS), or Altiris eXpress to replace the preinstalled software with a customized software 
image.

■ Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment 
and processes. The PC Deployment section of the Solutions and Services Web site 
(http://h18000.www1.hp.com/solutions/pcsolutions/) provides information to help you 
select the best deployment method. You’ll also find guides and utilities to integrate Microsoft 
or PXE-based deployment tools.

The Restore or the Restore Plus! CD, ROM-based setup, and ACPI-ready hardware provide 
further assistance with recovery of system software, configuration management and 
troubleshooting, and power management.
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3.2.2 Remote System Installation
Remote System Installation lets you start and set up your system using the software and 
configuration information located on a network server. This feature is usually used as a system 
setup and configuration tool, and can be used for the following tasks:

■ Deploying a software image on one or more new PCs.

■ Formatting a hard drive.

■ Installing application software or drivers.

■ Updating the operating system, application software, or drivers.

To initiate Remote System Installation, press F12 when the F12=Network Service Boot 
message appears in the lower-right corner of the HP logo screen. Follow the instructions on the 
screen to continue the process.

3.2.3 software updating and management
HP provides several tools for managing and updating software on desktops and 
workstations—Altiris eXpress, Altiris PC Transplant Pro, PC Transplant, Insight Manager™ LC, 
System Software Manager, and Remote Management Setup Utilities. Using Insight Manager LC, 
you can also monitor a workgroup of PCs from a central console and remotely update the system 
software, security settings, flash ROM, or hardware device drivers, for each of the managed PCs 
individually.

Altiris eXpress
Altiris eXpress allows the system administrator to create and quickly deploy a customized, 
corporate-standard software image across one or more networked client PCs with an interface 
as simple to use as Windows Explorer. Altiris eXpress supports Intel’s Wired for Management 
and Preboot Execution Environment (PXE). Using Altiris eXpress and the Remote System 
Installation features of the workstation, there is no need for the system administrator to visit 
each new PC individually to deploy the software image.

Altiris eXpress is able to install a disk image containing the operating system, application 
software, and the Altiris eXpress client, without requiring the use of a separate boot diskette. 
With Altiris eXpress, the network administrator can:

■ Create a new image or edit an existing image, or clone a PC on the network which may have 
the ideal image.

■ Create any number of customized disk images for a variety of workgroups.

■ Edit image files, modifying them without having to start from scratch. This is possible 
because Altiris eXpress stores files in its native format: NTFS, FAT16, or FAT32.

■ Establish a “New PC Event,” a script that will run automatically when a new PC is added to 
the network. The script can, for instance, format the PC hard drive, flash the ROM BIOS, and 
install a full, standard software image.

■ Schedule an event to run on a group of workstations.

Altiris eXpress also includes easy-to-use software distribution capabilities. You can use Altiris 
eXpress to update operating systems and application software from a central console. When used 
in conjunction with System Software Manager, Altiris eXpress can also update ROM BIOS and 
device driver software.

For more information, refer to the HP Web site at www.hp.com.
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PC Transplant Pro and PC Transplant
PC Transplant is designed to assist you in personalizing your new HP workstation. It can be 
downloaded free from the HP web site. It lets you preserve the “personality” or the customized 
settings, such as Start menu entries, drive and printer mappings, software application options, 
and so on of an existing PC. It will then transfer those unique settings to a workstation.

For more information, refer to the HP Web site at www.hp.com.

hp Insight Manager LC
HP Insight Manager LC is a web-based tool for managing workgroups of PCs. It provides 
a unified “browser-based roaming console,” not only for HP clients but any standard DMI 
2.0-based PC on the network. It can automatically discover, view system information, and 
receive alerts from any DMI 2.0 PC on a specified domain or workgroup.

For more information, refer to the HP Web site at www.hp.com.

System Software Manager
System Software Manager (SSM) is a utility that lets you update system-level software on 
multiple systems simultaneously. When executed on a PC client system, SSM detects both 
hardware and software versions, then updates the appropriate software from a central repository, 
also known as a file store. Support software that works with SSM is flagged with the PC 
Lifecycle Management icon on the HP web site. To download the utility or to obtain more 
information on SSM, visit the HP Web site at www.hp.com.

Remote Management Setup Utilities
The Remote Management Setup Utilities, when integrated with Management Solutions Partners 
products supplement the capabilities of Solutions Partners products for distributing new 
applications, device drivers, and other system software. The HP web site includes updated ROM 
images and device drivers which can be distributed to client PCs using these software tools.

For more information, refer to the online Remote Management Administrators Guide. The 
Remote Management Administrators Guide is included with the Remote Management Setup 
Utilities, which are available on the HP Web site at www.hp.com. The following sections provide 
information on using these utilities to accomplish various remote management functions 
including ROM flash, changing security settings, and wakeup/shutdown.

remote ROM flash
Your workstation comes with a reprogrammable flash ROM (read only memory). By establishing 
a setup password in Computer Setup, you can protect the ROM from being unintentionally 
updated or overwritten. This is important to ensure the operating integrity of the workstation. 
Should you need or want to upgrade your ROM, you may:

■ Order an upgraded ROMPaq diskette from HP.

■ Download the latest ROMPaq images from the HP Web site (www.hp.com).

Ä
CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password 
prevents unauthorized ROM upgrades. HP Insight Manager LC allows the system administrator to set the 
setup password on one or more PCs simultaneously. For more information, visit the HP Web site at 
www.hp.com.
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using Remote ROM flash

Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP 
workstations directly from the centralized network management console. Enabling the system 
administrator to perform this task remotely on multiple workstations results in a consistent 
deployment of and greater control over ROM images over the network.

All ROMPaq ROM images from HP are digitally signed to ensure authenticity and minimize 
potential corruption. Your system ROM may include a Boot Block that is protected during the 
flash process and allows the workstation to be restarted, in the unlikely event of an unsuccessful 
ROM flash.

NOTE: Your workstation must be powered on, or turned on through Remote Wakeup, to take 
advantage of Remote ROM Flash. Use of Remote ROM Flash also requires an established setup 
password.

For more information on enabling Remote ROM Flash, refer to the online Remote Management 
Administrators Guide. The Remote Management Administrators Guide is included with the 
Remote Management Setup Utilities, and is available on the HP Web site at www.hp.com.

FailSafe Boot Block ROM

The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash 
failure, for example, if a power failure were to occur during a ROM upgrade. The Boot Block is a 
flash-protected section of the ROM that checks for a valid system ROM flash when power to the 
system is turned on.

■ If the system ROM is valid, the system starts normally.

■ If the system ROM fails the validation check, the FailSafe Boot Block ROM provides 
enough support to start the system from a ROMPaq diskette, which will program the system 
ROM with a valid image.

When the Boot Block detects an invalid system ROM, the system sounds a series of beeps (one 
long and three short) and flashes the three keyboard lights (on and off two times). A Boot Block 
recovery mode message is displayed on the screen.

To recover the system after it enters Boot Block recovery mode, complete the following steps:

1. Remove any diskettes from the diskette drive and turn off the power.

2. Insert a ROMPaq diskette into the diskette drive.

3. Turn on power to the system.

4. If no ROMPaq diskette is found, you will be prompted to insert one and restart the 
workstation.

5. If a setup password has been established, the Caps Lock light will turn on and you will be 
prompted to enter the password.

6. Enter the setup password.

7. If the system successfully starts from the diskette and successfully reprograms the ROM, 
then the three keyboard lights will turn on. A “rising tone” series of beeps also signals 
successful completion.
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The following table lists the various keyboard light combinations used by the Boot Block ROM, 
as well as the meaning and action associated with each combination.

3.2.4 remote security management
Remote Security Management allows the system administrator to safely set or modify security 
features on remote workstations directly from the centralized network management console. 
Enabling the system administrator to perform these tasks remotely, on multiple workstations, 
results in consistent deployment of and greater control over client workstation security 
parameters over the network.

NOTE: Your workstation must be powered on, or turned on through Remote Wakeup, to take 
advantage of Remote Security Management. Use of Remote Security Management also requires 
an established setup password.

For more information about the Remote Management Setup software and enabling Remote 
Security Management, refer to the online Remote Management Administrators Guide. The 
Remote Management Administrators Guide is included with the Remote Management Setup 
Utilities, and is available on the HP Web site at www.hp.com.

remote wakeup and remote shutdown 
If your workstation has a network card installed, it may support the Remote Wakeup and Remote 
Shutdown functions. These functions allow a system administrator to power on and power off a 
client workstation from a remote location supported by PC LAN management tools.

NOTE: Third-party software tools are required to remotely distribute software.

keyboard light combinations used by Boot Block ROM

failsafe 
boot block 
mode

keyboard 
LED color

keyboard LED 
activity state/message

Num Lock Green On ROMPaq diskette not present, is bad, 
or drive not ready.*

Caps Lock Green On Enter password.*

Num, Caps, 
Scroll Lock

Green Turn on and off 
2 times (accompanied 
by 1 long and 3 short 
beeps)

ROM flash failed.*

Num, Caps, 
Scroll Lock

Green On Boot Block ROM Flash successful. 
Turn power off, then on to reboot.

NOTE: Diagnostic lights do not flash on USB keyboards.

*Insert valid ROMPaq diskette in drive A. Turn power switch off, then on to reflash ROM. If ROM 
flash is successful, all three keyboard LEDs will light up, and you will hear a rising tone series of 
beeps. Remove diskette and turn power off, then on to restart the workstation.
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Remote Wakeup allows the network interface controller to continue functioning when power to 
the workstation has been turned off, but the power cord is still connected to an electrical outlet.

NOTE: The workstation continues to consume a small amount of electricity even after you turn it 
off. Only when you disconnect the power cord from the electrical outlet does the workstation 
stop consuming electricity.

To enable Remote Wakeup and Remote Shutdown, complete the following steps:

1. Double-click the Network Icon, located in the Control Panel.

2. Double-click the appropriate network controller.

3. Click the Advanced Properties tab.

4. Select Remote Wakeup.

5. Change the value to ON.

6. Click OK to save and apply changes, then click OK to exit the Network dialog.

For more information on using Remote Wakeup and Remote Shutdown, refer to the online 
Remote Management Administrators Guide. The Remote Management Administrators Guide is 
included with the Remote Management Setup Utilities, and is available on the HP Web site at 
www.hp.com.

NIC Alert
The NIC Alert function enables desktop PCs to send an immediate alert to the network 
administrator when there is a hardware or operating system failure, or evidence of tampering. 
An alert will be sent even if the system is powered off or the operating system has not yet started.

replicating your setup
This procedure gives an administrator the ability to easily copy one setup configuration to other 
workstations of the same model. This allows for faster, more consistent configuration of multiple 
workstations. To replicate your setup:

1. Access the Computer Setup Utilities menu.

2. Click File > Save to Diskette. Follow the instructions on the screen.

NOTE: This requires an internal diskette drive or a portable, external diskette drive.

3. To replicate the configuration, click File > Restore from Diskette, and follow the instructions 
on the screen.

Altiris eXpress and PC Transplant make it easy to replicate the configuration and custom settings 
of one PC and copy it to one or more PCs. For more information, visit the HP Web site at 
www.hp.com.
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dual-state power button
With Advanced Configuration and Power Interface (ACPI) enabled for Windows, the power 
button can function either as an on/off switch or as a suspend button. The suspend feature does 
not completely turn off power, but instead causes the workstation to enter a low-power standby. 
This allows you to quickly power down without closing applications and to quickly return to the 
same operational state without any data loss.

To change the power button's configuration, complete the following steps:

1. Access the Computer Setup menu.

2. Select Power > Energy Saver. Select Minimal or Advanced to turn on the Energy Saver 
Options menu.

3. Select Power > Energy Saver Options. Set the power button configuration to either On/Off or 
Suspend/Wakeup, as desired.

4. See the “Computer Setup (F10)” section of this guide for more detailed information about 
the features of Computer Setup.

5. Select File > Save Changes and Exit.

After configuring the power button to function as a suspend button, press the power button to put 
the system in a very low power state (suspend). Press the button again to quickly bring the system 
out of suspend to full power status. To completely turn off all power to the system, press and hold 
the power button for four seconds.

NOTE: If you have selected the “Blink LED during Energy Save” option in Computer Setup, the 
power-on light will blink green once every two seconds while the workstation is in suspend. See 
to the “Computer Setup menu” section earlier in this chapter for more information on using 
Computer Setup.

power management
Power Management is a feature that saves energy by shutting down certain components of 
the workstation when they are not in use, saving energy without having to shut down the 
workstation. Timeouts (the period of inactivity allowed before shutting down these components) 
can be enabled, customized, or disabled using the Control Panel program (Power Options). More 
advanced customization of the power management settings is available through Computer Setup.

NOTE: The power saver and power management features are not supported on Linux-based 
workstations.

1. Access the Computer Setup menu.

2. Select Power > Energy Saver. Select Advanced to turn on the Timeouts menu.

3. Select Power > Timeouts. Enable, customize, or disable timeouts.

4. See to the “Computer Setup menu” section earlier in this chapter for additional information 
about the features of Computer Setup.

5. Select File > Save Changes and Exit.

Use Display Properties to establish, modify, or disable Power Management settings for the 
monitor. To access Display Properties, right-click on the Windows Desktop, then choose 
Properties.
3–18 hp workstation xw4100 service and technical reference guide



system management
World Wide Web site
When making the transition to new or revised operating systems, it is important to implement the 
support software designed for that operating system. If you plan to run a version of Microsoft 
Windows that is different from the version included with your workstation, you must install 
corresponding device drivers and utilities to ensure that all features are supported and 
functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software 
easier. You can download the software from the HP Web site at www.hp.com.

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to 
run the latest Microsoft Windows operating system on your HP workstation.

Desktop Management Interface (DMI)
The Desktop Management Task Force (DMTF) is an industry body with the goal of standardizing 
systems manageability. DMTF established the Desktop Management Interface (DMI) framework 
to standardize access to PC configuration data. HP delivers hardware and software 
instrumentation that supports the DMI standard.

For more information on configuring the DMI software, refer to the online Intelligent 
Manageability Guide.

Wired for Management
Intel's Wired for Management initiative is focused on reducing the support and administration 
cost of Intel architecture-based systems without compromising flexibility and performance. 
The Wired for Management guidelines provide a baseline set of building blocks that are utilized 
in Intelligent Manageability to provide standardized management of desktop inventories, 
remote system configuration, off-hours maintenance, and next generation power management. 
Additional capabilities have been incorporated into Intelligent Manageability to provide an 
extensive solution for managing networked computing environments.

Wired for Management technologies include:

■ Desktop Management Interface (DMI) 2.0

■ Remote System Installation

■ Remote Wakeup and Remote Shutdown

■ ACPI-Ready Hardware

■ SMBIOS

■ Pre-boot Execution (PXE) support

■ Boot Integrity Services (BIS)
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3.2.5 asset tracking and security
The asset control features incorporated into the workstation provide key asset tracking data 
that can be managed using HP Insight Manager products and Management Solutions Partners 
products. Seamless, automatic integration between AssetControl features and these products 
enables you to choose the management tool that is best suited to your environment and to 
leverage your investment in existing tools.

HP workstations are manufactured with the hardware and firmware required to fully support the 
DMI 2.0 standard.

HP also offers several solutions for controlling access to valuable components and information. 
Security features such as the hood cover sensor and the solenoid hood cover lock, available as an 
option, help to prevent unauthorized access to the internal components of the workstation. By 
disabling parallel, serial, or USB ports, or by disabling removable media boot capability, you can 
protect valuable data assets. Memory Change and hood cover sensor alerts can be automatically 
forwarded to HP Insight Manager products to deliver proactive notification of tampering with a 
workstation’s internal components.

There are three ways to manage security settings on your HP workstations:

■ Locally, using the Setup Utilities. See the “Computer Setup menu” section earlier in this 
chapter for additional information and instructions on using the Computer Setup Utilities.

■ Remotely, using the Remote Security Management software. This software enables the 
secure, consistent deployment and control of security settings from a central point on the 
network using a third-party PC LAN management application such as Microsoft SMS.

■ Remotely, using HP Insight Manager LC, a tool for managing PC workgroups.
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The following table and sections refer to managing security features of your workstation 
locally through the Setup Utilities. Refer to the Remote Management Setup Utilities for more 
information on using the Remote Security Management software. These utilities are available on 
the HP web site at www.hp.com.

security features overview  

feature purpose how it is established

Removable Media Boot 
Control

Prevents booting from the removable 
media drives.

From the Setup Utilities menu.

Serial, Parallel, USB, 
or Infrared Interface 
Control

Prevents transfer of data through the 
integrated serial, parallel, USB  
(universal serial bus), or infrared 
interface.

From the Setup Utilities menu.

Power-On Password Prevents use of the workstation until 
the password is entered. This can 
apply to both initial system startup 
and restarts.

From the Setup Utilities menu.

Setup Password Prevents reconfiguration of the 
workstation (use of the Setup 
Utilities) until the password is 
entered.

From the Setup Utilities menu.

Network Server Mode Provides unique security features for 
workstations being used as servers.

From the Setup Utilities menu.

DriveLock Prevents unauthorized access to the 
data on specific hard drives.

From the Setup Utilities menu.

Hood Cover Sensor 
(optional feature)

Indicates that hood cover has been 
removed. Can be set to require 
the setup password to restart the 
workstation, after the cover has 
been removed.

From the Setup Utilities menu.

Solenoid Hood Cover 
Lock (optional feature)

This is a software controlled lock the 
prevents the unauthorized removal 
of the hood cover.

From the Setup Utilities menu.

Master Boot Record 
Security

May prevent unintentional or  
malicious changes to the Master 
Boot Record of the current 
bootable disk, and provides a 
means of recovering the “last known 
good” MBR.

From the Setup Utilities menu.

Memory Change Alerts Detects when memory modules 
have been added, moved, or 
removed; notifies user and system 
administrator.

For information on enabling 
Memory Change Alerts, refer 
to the online Intelligent  
Manageability Guide.

Ownership Tag Displays ownership information, as 
defined by the system administrator, 
during system startup (protected by 
setup password).

From the Setup Utilities menu.
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password security
The power-on password prevents unauthorized use of the workstation by requiring entry of a 
password to access applications or data each time the workstation is turned on or restarted. The 
setup password specifically prevents unauthorized access to Computer Setup, and can also 
be used as an override to the power-on password. That is, when prompted for the power-on 
password, entering the setup password instead will allow access to the workstation.

A network-wide setup password can be established to enable the system administrator to log in to 
all network systems to perform maintenance without having to know the power-on password, 
even if one has been established.

establishing a setup password using Computer Setup

Establishing a setup password through Computer Setup prevents reconfiguration of the 
workstation (use of the Computer Setup utility) until the password is entered.

1. Turn on or restart the workstation. If you are in Windows, click Start > Shut Down > Restart 
the workstation.

2. When the F10=Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, you must restart the 
workstation to access the utility.

3. Select Security, then select Setup Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

Kensington Cable Lock 
Provision

Inhibits access to the interior of the 
workstation to prevent unwanted 
configuration changes or 
component removal. Can also 
be used to secure the workstation 
to a fixed object to prevent theft.

Install a Kensington cable 
lock to secure the workstation 
to a fixed object.

Padlock loop Prevents hood cover from being 
removed. This loop can also be 
used to secure the unit to a fixed 
object.

Install a padlock.

NOTE: For more information about Computer Setup, see the “Computer Setup menu” section earlier 
in this chapter.

security features overview  (Continued)

feature purpose how it is established
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establishing a power-on password using Computer Setup

Establishing a power-on password through Computer Setup prevents access to the workstation 
when power is turned on, unless the password is entered. When a power-on password is set, 
Computer Setup presents Password Options under the Security menu. The password options 
include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, the password must be entered each time the workstation 
is turned on when the key icon appears on the monitor. When Password Prompt on Warm Boot 
is enabled, the password must also be entered each time the workstation is rebooted. When 
Network Server Mode is enabled, the password prompt is not presented during POST, but any 
attached PS/2 keyboard will remain locked until the user enters the power-on password.

1. Turn on or restart the workstation. If you are in Windows, click Start > Shut Down > Restart 
the Computer.

2. When the F10=Setup message appears in the lower-right corner of the screen, press the 
F10 key. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, you must restart the 
workstation to access the utility.

3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

entering a power-on password

To enter a power-on password, complete the following steps:

1. Turn on or restart the workstation. If you are in Windows, click Start > Shut Down > Restart 
the Computer.

2. When the key icon appears on the monitor, type your current password, then press Enter.

NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the workstation, then turn it on again before you can 
continue.

entering a setup password

If a setup password has been established on the workstation, you will be prompted to enter it each 
time you run Computer Setup.

1. Turn on or restart the workstation. If you are in Windows, click Start > Shut Down > Restart 
the Computer.

2. When the F10=Setup message appears in the lower-right corner of the screen, press the 
F10 key.

NOTE: If you do not press the F10 key while the message is displayed, you must restart the 
workstation to access the utility.
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3. When the key icon appears on the monitor, type the setup password, then press the 
Enter key.

NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three 
unsuccessful tries, you must turn off the workstation, then turn it on again before you can 
continue.

changing a power-on or setup password

1. Turn on or restart the workstation. If you are in Windows, click Start > Shut Down > Restart 
the Computer. To change the setup password, run Computer Setup.

2. When the key icon appears, type your current password, a slash (/) or alternate delimiter 
character, your new password, another slash (/) or alternate delimiter character, and your new 
password again as shown: 
 
current password/new password/new password

NOTE: Type carefully; for security reasons, the characters you type do not appear on the screen.

3. Press the Enter key.

The new password takes effect the next time you turn on the workstation.

NOTE: See the “national keyboard delimiter characters” section in this chapter for information 
about the alternate delimiter characters. 
 
The power-on password and setup password may also be changed using the Security options in 
Computer Setup.

deleting a power-on or setup password
1. Turn on or restart the workstation. Use the appropriate operating system shutdown process. 

To delete the setup password, run Computer Setup.

2. When the key icon appears, type your current password followed by a slash (/) or alternate 
delimiter character as shown: 
 
current password/

3. Press the Enter key.

NOTE: See the “national keyboard delimiter characters” section for information about the 
alternate delimiter characters. The power-on password and setup password may also be changed 
using the Security options in Computer Setup.
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national keyboard delimiter characters

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you 
use for changing or deleting your password depend on the keyboard that came with your 
workstation.

clearing passwords

If you forget your password, you cannot access the workstation. See Appendix G, “additional 
password security and resetting CMOS” for instructions on clearing passwords.

network server mode
Network Server Mode provides unique security features for workstations being used as servers. It 
is only available when a power-on password has been set in Computer Setup. When the Network 
Server Mode is enabled, the power-on password is not required to boot the hard drive, and a 
keyboard is not required to be attached to the system. If a PS/2 keyboard is present, it will be 
locked until the user enters the power-on password. If a USB keyboard is present, it will remain 
usable by default. To prevent USB keyboard access after the operating system has loaded, a user 
must hide the USB Port under the Device Security option of Computer Setup’s Security menu. 
When used in conjunction with the Computer Setup After Power Loss power-on option, Network 
Server Mode permits the “server” to automatically reboot after a power interruption without user 
intervention. While Network Server Mode is enabled, the power-on password must be entered to 
boot the removable media (e.g. diskettes) or removable devices (e.g. USB flash devices).

DriveLock
DriveLock is a security feature that prevents unauthorized access to the data on specific hard 
drives. DriveLock has been implemented as an extension to Computer Setup. It is only available 
on certain systems and only when DriveLock-capable hard drives are detected.

DriveLock employs a two-password security scheme. One password is intended to be set and 
used by a system administrator while the other is typically set and used by the end-user. There is 
no “back-door” that can be used to unlock the drive if both passwords are forgotten. Therefore, 
DriveLock is most safely used when the data contained on the hard drive is replicated on a 
corporate information system or is regularly backed-up.

Ä
CAUTION: In the event that both DriveLock passwords are lost, the hard drive is rendered unusable.

national keyboard delimiter characters
Arabic / Greek - Russian /
Belgian = Hebrew . Slovakian -
BHCSY* - Hungarian - Spanish -
Brazilian / Italian - Swedish/Finnish /
Chinese / Japanese / Swiss -
Czech - Korean / Taiwanese /
Danish - Latin American - Thai /
French ! Norwegian - Turkish .
French Canadian é Polish - U.K. English /
German - Portuguese - U.S. English /
*For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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using DriveLock

The DriveLock option appears under the Security menu in Computer Setup. The user is 
presented with options to set the master password or to enable DriveLock. A user password 
must be provided in order to enable DriveLock. Since the initial configuration of DriveLock 
is typically performed by a system administrator, a master password should be set first. HP 
encourages system administrators to set a master password whether they plan to enable 
DriveLock or keep it disabled. This will give the administrator the ability to modify DriveLock 
settings if the drive is locked in the future. Once the master password is set, the system 
administrator may enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a 
power-on password is set and it matches the user password of the device, POST will not prompt 
the user to re-enter the password. Otherwise, the user will be prompted to enter a DriveLock 
password. Either the master or the user password may be used. Users will have two attempts to 
enter a correct password. If neither attempt succeeds, POST will continue but the data on the 
drive will remain inaccessible.

DriveLock applications and recommendations

The most practical use of the DriveLock security feature is in a corporate environment where 
a system administrator provides users with multibay hard drives for use in some desktop 
computers. The system administrator would be responsible for configuring the multibay hard 
drive which would involve, among other things, setting the DriveLock master password. In the 
event that the user forgets the user password or the equipment is passed on to another employee, 
the master password can always be used to reset the user password and regain access to the hard 
drive.

HP recommends that corporate system administrators who choose to enable DriveLock also 
establish a corporate policy for setting and maintaining master passwords. This should be done 
to prevent a situation where an employee intentionally or unintentionally sets both DriveLock 
passwords before leaving the company. In such a scenario, the hard drive would be rendered 
unusable and require replacement. Likewise, by not setting a master password, system 
administrators may find themselves locked out of a hard drive and unable to perform routine 
checks for unauthorized software, other asset control functions and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. 
Users in this category include personal users or users who do not maintain sensitive data on their 
hard drives as a common practice. For these users, the potential loss of a hard drive resulting 
from forgetting both passwords is much greater than the value of the data DriveLock has been 
designed to protect. Access to Computer Setup and DriveLock can be restricted through the 
Setup password. By specifying a Setup password and not giving it to end users, system 
administrators are able to restrict users from enabling DriveLock.
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hood cover sensor
The hood cover sensor is an optional feature that is a combination of hardware and software 
technology that can alert you when the workstation hood cover has been removed. This option is 
available as a kit that includes the solenoid hood cover lock (see the following section). There are 
three levels of protection, as described in the following table.

setting the hood cover sensor protection level

To set the hood cover sensor protection level, complete the following steps:

1. Turn on or restart the workstation.

2. When the F10=Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, you must restart the 
workstation to access the utility.

3. Select Security, then hood cover, and follow the instructions on the screen.

4. Before exiting, click File > Save Changes and Exit.

solenoid hood cover lock
The solenoid hood cover lock is available as an option on hp workstation xw4100 models (this 
options comes as a kit that includes the hood cover sensor). When installed, the solenoid hood 
cover lock can prevent unauthorized access to the internal components.

Ä
CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup password 
prevents unauthorized access to the Computer Setup utility.

hood cover sensor protection levels

level setting description

Level 0 hood cover = Disabled hood cover sensor is disabled (default).

Level 1 hood cover = Notify User When the workstation is restarted, the 
screen displays a message indicating that 
the workstation hood cover has been 
removed.

Level 2 Setup Password = enabled
and
hood cover = notify user

When the workstation is restarted, the 
screen displays a message indicating that 
the workstation hood cover has been 
removed. You must enter the setup password 
to continue.
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locking the solenoid hood cover lock

To activate and lock the solenoid hood cover lock, complete the following steps:

1. Turn on or restart the workstation.

2. When the F10=Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, you must restart the 
workstation to access the utility.

3. Select Security, then select hood cover and the Locked option.

4. Before exiting, click File > Save Changes and Exit.

unlocking the solenoid hood cover lock

1. Turn on or restart the workstation.

2. When the F10=Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, you must restart the 
workstation to access the utility.

3. Select Security > hood cover > Unlocked.

4. Before exiting, click File > Save Changes and Exit.

using the hood cover FailSafe key

If you enable the solenoid hood cover lock and cannot enter your password to disable the lock, 
you will need a hood cover FailSafe Key to open the workstation hood cover. You will need the 
key in any of the following circumstances:

■ Power outage

■ Startup failure

■ PC component failure (such as processor or power supply)

■ Forgotten password

Ä
CAUTION: The hood cover FailSafe Key is a specialized tool available from HP. Be prepared; order this 
key before you need one.

To obtain the FailSafe Key, do any one of the following:

■ Contact your authorized HP reseller or service provider.

■ Refer to the HP Web site (www.hp.com) for ordering information.

■ Call the appropriate number listed in the warranty.
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Master Boot Record security
The Master Boot Record (MBR) contains information needed to successfully boot from a disk 
and to access the data stored on the disk. Master Boot Record Security may prevent unintentional 
or malicious changes to the MBR, such as those caused by some computer viruses or by the 
incorrect use of certain disk utilities. It also allows you to recover the “last known good” MBR, 
should changes to the MBR be detected when the system is restarted.

To enable MBR Security, complete the following steps:

1. Turn on or restart the workstation. If you are in Windows, click Start > Shut Down > Restart 
the Computer.

2. When the F10=Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, you must restart the 
workstation to access the utility.

3. Select Security > Master Boot Record Security > Enabled.

4. Select Security > Save Master Boot Record.

5. Before exiting, click File > Save Changes and Exit.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the 
current bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS 
cannot prevent changes that may occur while the operating system is running.

Each time the workstation is turned on or restarted, the BIOS compares the MBR of the current 
bootable disk to the previously saved MBR. If changes are detected and if the current bootable 
disk is the same disk from which the MBR was previously saved, the following message is 
displayed:

1999 - Master Boot Record has changed.

Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must

■ Save the MBR of the current bootable disk;

■ Restore the previously saved MBR; or

■ Disable the MBR Security feature.

You must know the setup password, if one exists. If changes are detected and if the current 
bootable disk is not the same disk from which the MBR was previously saved, the following 
message is displayed:

2000 - Master Boot Record Hard Drive has changed.

Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must

■ Save the MBR of the current bootable disk; or

■ Disable the MBR Security feature.

You must know the setup password, if one exists.
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In the unlikely event that the previously saved MBR has been corrupted, the following message is 
displayed:

1998 - Master Boot Record has been lost.

Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must

■ Save the MBR of the current bootable disk; or

■ Disable the MBR Security feature.

You must know the setup password, if one exists.

Before you partition or format the current bootable disk, ensure that MBR Security is disabled 
before you change partitioning or formatting of the current bootable disk. Some disk utilities, 
such as FDISK and FORMAT, attempt to update the MBR. If MBR Security is enabled when you 
change partitioning or formatting of the disk, you may receive error messages from the disk 
utility or a warning from MBR Security the next time the workstation is turned on or restarted. 
To disable MBR Security, complete the following steps:

1. Turn on or restart the workstation. If you are in Windows, click Start > Shut Down > Restart 
the Computer.

2. When the F10=Setup message appears in the lower-right corner of the screen, press the F10 
key. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, you must restart the 
workstation to access the utility.

3. Select Security > Master Boot Record Security > Disabled.

4. Before exiting, click File > Save Changes and Exit.

Kensington cable lock provision
The rear panel of the chassis can accommodate a Kensington cable lock accessory that allows the 
workstation to be physically secured to a work area.

For illustrated instructions, see the “cable lock (optional)” section in Chapter 4.

3.2.6 fault notification and recovery
Fault Notification and Recovery features combine innovative hardware and software technology 
to prevent the loss of critical data and minimize unplanned downtime.

When a fault occurs, the workstation displays a Local Alert message containing a description 
of the fault and any recommended actions. You can then view current system health by using 
the Management Agent. If the workstation is connected to a network managed by a HP Insight 
Manager product or other management products from HP Management Solutions Partners, the 
workstation also sends a fault notice to the network management application.
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Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in 
select HP workstations. DPS is designed to help diagnose problems that might result in 
unwarranted hard drive replacement.

Each installed hard drive is tested using DPS, and a permanent record of key information is 
written onto the drive. Each time DPS is run, test results are written to the hard drive. Your 
service provider can use this information to help diagnose conditions that caused you to run 
the DPS software. Refer to the Troubleshooting Guide for instructions on using DPS.

Ultra ATA Integrity Monitoring
Ultra ATA Integrity Monitoring monitors the integrity of data as it is transferred between an Ultra 
ATA hard drive and the system’s core logic. If the workstation detects an abnormal number of 
transmission errors, the workstation displays a Local Alert message with recommended actions.

ECC fault prediction and prefailure warranty
When the workstation encounters an excessive number of error checking and correcting (ECC) 
memory errors, the workstation displays a Local Alert message. This message contains detailed 
information about the errant memory module, allowing you to take action before you experience 
non-correctable memory errors. The Prefailure Warranty for ECC memory modules allows you 
to replace these modules, free of charge, before the modules actually fail. ECC memory modules 
are optional on selected HP systems.

NOTE: To use this feature, you must replace the standard DIMMs with HP ECC DIMMs.

surge-tolerant power supply
An integrated surge-tolerant power supply provides greater reliability when the workstation is hit 
with an unpredictable power surge. This power supply is rated to withstand a power surge of up 
to 2000V (Line to PE or Neutral to PE) and 1000V (Line to Line) without any data loss or system 
downtime.

thermal sensor
The thermal sensor is a hardware and software feature that tracks the internal temperature of the 
workstation. The thermal sensor monitors the processor temperature and if the temperature gets 
too hot, the processor clock automatically begins to throttle. If the temperature does not go down, 
then the system eventually shuts down.
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3.3 Configuration Record
The Configuration Record utility is a windows-based information-gathering tool that gathers 
critical hardware and software information from various workstation subsystems. The 
information includes such things as the ROM, asset tag, processor, physical drives, PCI devices, 
memory, graphics, operating system version number, operating system parameters, and the 
operating system startup files to give a complete view of the workstation. Configuration Record 
provides a means for automatically identifying and comparing configuration changes, and has 
the ability to maintain a configuration history. The information can be saved as a history of 
multiple sessions.

This utility allows the resolution of problems without taking the workstation offline and assists 
in maximizing the workstation availability. The information obtained by the utility is useful in 
troubleshooting system problems, and streamlines the service process by enabling quick and easy 
identification of system configurations.

The utility displays it findings in a Now.log file. If the original Base.log file is present in the 
cpqdiags directory, the Base.log file is displayed next to the Now.log file in a split window with 
the differences between the two highlighted in the color red.

3.3.1 installing Configuration Record 
The Configuration Record is part of Diagnostics for Windows and is automatically installed at 
the same time as Diagnostics for Windows.

3.3.2 running Configuration Record
To run this program:

1. Click Start > HP Information Center > Configuration Record.

Alternately, you can access Diagnostics for Windows via the control panel.

NOTE: The Configuration Record utility has two view options: Show Changed Items Only and 
Show All. The default view is Show Changed Items Only, therefore all the text is displayed in the 
color red since it shows only the differences. Switching to Show All displays the complete, 
comprehensive view of the system.

2. The default view is Show Changed Items Only. To view all the information gathered by 
Configuration Record, click View at the top of the window and select Show All, or click the 
Show All Items icon.

3. To save the information in the left or right window, select File > Save Window File and then 
select Left Window File or Right Window File.

NOTE: Saving the configuration of the workstation periodically allows the user to keep a history 
of the configuration. This history may be useful to you in the future if the system ever encounters 
a problem that needs debugging.

4. To exit Configuration Record, click File, then click Exit.
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removal and replacement procedures

4.1 service considerations
The following sections discuss service considerations that should be reviewed and practiced prior 
to removing and replacing any system components.

Å
WARNING: When lifting or moving the workstation, the front bezel should not be used as a handle 
or lifting point. Lifting the workstation from the front bezel or lifting it incorrectly could cause the unit 
to fall and cause harm to the user and/or damage to the workstation. To properly and safely lift the 
workstation, lift it from the bottom of the unit from either the desktop or minitower configuration.

4.1.1 warnings and safety precautions
Before accessing the components of the workstation, view the following precautions. Also, 
review the Safety and Regulatory Guide that came with your workstation for more information.

avoid electrical shocks

Å
WARNING: To avoid electrical shock, do not open the power supply. There are no user-serviceable 
parts inside. 

Å
WARNING: To avoid electrical shock or harm to your eyes by laser light on systems with an optional 
optical drive, do not open the laser module. The laser module should be serviced by service personnel 
only. Do not attempt to make any adjustment to the laser unit. Refer to the label on the CD-ROM for 
power requirements and wavelength.

electrical

Å
WARNING: For your safety always connect the equipment to a grounded floor outlet. Always use a 
power cord with a properly grounded plug, such as the one provided with the equipment, or one in 
compliance with your national safety standards. This equipment can be disconnected from the power by 
removing the power cord from the power outlet. This means the equipment must be located close to an 
easily accessible power outlet.

multimedia models

Å
WARNING: If your system is a multimedia model, or if you have installed a sound card in your system, 
always turn the volume down before connecting the headphones or speakers. This prevents discomfort 
from unexpected noise or static. Listening to loud sounds for prolonged periods of time may permanently 
damage your hearing. Before putting on headphones, place them around your neck and turn the volume 
down. When you put on the headphones, slowly increase the volume until you find a comfortable 
listening level. When you can hear comfortably and clearly, without distortion, leave the volume in that 
position.
hp workstation xw4100 service and technical reference guide 4–1



removal and replacement procedures
removing and replacing the hood cover

Å
WARNING: For your safety, never remove the system hood cover without first disconnecting the power 
cord from the power outlet and removing any connection to a telecommunications network. Always 
replace the cover before switching the workstation on again.

safety information

Å
WARNING: There is a danger of explosion if the battery is incorrectly installed. For your safety, never 
attempt to recharge, disassemble, or burn an old battery. Replace the battery with the same or equivalent 
type, as recommended by the manufacturer.  
 
The battery in this workstation is a lithium battery that does not contain any heavy metals. However, to 
protect the environment, do not dispose of batteries in household waste. Return used batteries either to the 
shop from which you bought them, to the dealer from whom you purchased your workstation, or to HP so 
that they can either be recycled or disposed of in the correct way. Returned batteries will be accepted 
free of charge.

If you have a modem:

Do not attempt to connect this product to the phone line during a lightning storm. Never install 
telephone jacks in wet locations unless the telephone line has been disconnected at the network 
interface. Never touch uninsulated telephone wires or terminals unless the telephone line has 
been disconnected at the network interface. Use caution when installing or modifying telephone 
lines. Avoid using a telephone (other than a cordless type) during an lightning storm. There may 
be a risk from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Never touch or remove the communications board without first removing the connection to the 
telephone network.

static electricity

Ä
CAUTION: Static electricity can damage electronic components. Turn OFF all equipment. Do not let 
your clothes touch the accessory. To equalize the static electricity, rest the accessory bag on top of the 
system while you are removing the accessory from the bag. Handle the accessory as little as possible and 
with care.

Review the following sections for additional information about electrostatic discharge.
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4.1.2 electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy 
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage 
occurs. An electronic device exposed to electrostatic discharge (ESD) may not appear to be 
affected at all and can work perfectly throughout a normal cycle. The device may function 
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the 
discharge contains enough power to alter device parameters or melt silicon junctions.

generating static
The following table shows that:

■ Different activities generate different amounts of static electricity.

■ Static electricity increases as humidity decreases.

preventing electrostatic damage to equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the 
degree of sensitivity. The following packaging and grounding precautions are necessary to 
prevent damage to electric components and accessories.

■ To avoid hand contact, transport products in static-safe containers such as tubes, bags, or 
boxes.

■ Protect all electrostatic parts and assemblies with conductive or approved containers or 
packaging.

■ Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

■ Place items on a grounded surface before removing them from their container.

■ When handling or touching a sensitive component or assembly, ground yourself by touching 
the chassis.

■ Avoid contact with pins, leads, or circuitry.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging or 
conductive foam.

relative humidity

event 55% 40% 10%

Walking across carpet
Walking across vinyl floor
Motions of bench worker

7,500 V
3,000 V
   400 V

15,000 V
  5,000 V
     800 V

35,000 V
12,000 V
  6,000 V

Removing bubble pack from PCB
Packing PCBs in foam-lined box

7,000 V
5,000 V

20,000 V
11,000 V

26,500 V
21,000 V

NOTE: 700 volts can degrade a product.
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personal grounding methods and equipment
Use the following equipment to prevent static electricity damage to equipment:

■ Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the 
ground cords. To provide proper ground, a strap must be worn snug against bare skin. The 
ground cord must be connected and fit snugly into the banana plug connector on the 
grounding mat or workstation.

■ Heel straps, Toe straps, and Boot straps can be used at standing workstations and are 
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, 
use them on both feet with a maximum of one-megohm ± 10% resistance between the 
operator and ground.

grounding the work area
To prevent static damage at the work area, use the following precautions:

■ Cover the work surface with approved static-dissipative material. Provide a wrist strap 
connected to the work surface and properly grounded tools and equipment.

■ Use static-dissipative mats, foot straps, or air ionizers to give added protection.

■ Handle electrostatic sensitive components, parts, and assemblies by the case or PCB 
laminate. Handle them only at static-free work areas.

■ Turn off power and input signals before inserting and removing connectors or test 
equipment.

■ Use fixtures made of static-safe materials when fixtures must directly contact dissipative 
surfaces.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly aids and 
Styrofoam.

■ Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

■ Static awareness labels

static shielding protection levels
method voltage

Antistatic plastic
Carbon-loaded plastic
Metallized laminate

  1,500
  7,500
15,000
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■ Wrist straps and footwear straps providing one-megohm +/- 10% resistance

■ Material handling packages

■ Conductive plastic bags

■ Conductive plastic tubes

■ Conductive tote boxes

■ Opaque shielding bags

■ Transparent metallized shielding bags

■ Transparent shielding tubes

4.1.3 tools and software requirements
To service the workstation, you may need the following:

■ Torx T-15 screwdriver or Flat-bladed screwdriver (may be used in place of the Torx 
screwdriver)

■ Phillips screwdriver (to remove system fan, if necessary)

■ Diagnostics software

■ Tamper-resistant T-15 wrench (FailSafe key) or Tamper-resistant bits (required if you get 
locked out by the solenoid hood cover lock)

4.1.4 screws
The screws used in the workstation are not interchangeable. They may have standard or metric 
threads and may be of different lengths. If an incorrect screw is used during the reassembly 
process, it can damage the unit. HP strongly recommends that all screws removed during 
disassembly be kept with the part that was removed, then returned to their proper locations.

NOTE: Metric screws have a black finish. American National (unified) screws have a silver finish.

NOTE: As each subassembly is removed from the workstation, it should be placed away from the 
work area to prevent damage.

Additional drive guide screws are provided on the system chassis. There are eight Metric (located 
on chassis near the 5.25 inch optical drive bays). These screws can be used to mount additional 
optical drives or an optional diskette drive. There are four American National screws (located on 
the chassis near the hard drive). These can be used to mount additional hard drives.

NOTE: The Metric (black) and American National (silver) screws are not interchangeable.
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4.1.5 special handling of components
The following components require special handling when servicing the workstation.

Å
WARNING: When lifting or moving the workstation, the front bezel should not be used as a handle 
or lifting point. Lifting the workstation from the front bezel or lifting it incorrectly could cause the unit 
to fall and cause harm to the user and/or damage to the workstation. To properly and safely lift the 
workstation, lift it from the bottom of the unit from either the desktop or minitower configuration.

power supply fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

Ä
CAUTION: The cooling fan is off only when the workstation is turned off or the power cable has been 
disconnected. 
 
The cooling fan is always on when the workstation is either in the “On,” “Standby,” or “Suspend” modes. 
 
You must disconnect the power cord from the power source before opening the workstation to prevent 
system board or component damage.

cables and connectors
Cables must be handled with care to avoid damage. Apply only the tension required to seat or 
unseat the cables during insertion or removal from the connector. Handle cables by the connector 
whenever possible. In all cases, avoid bending or twisting the cables, and ensure that the cables 
are routed in such a way that they cannot be caught or snagged by parts being removed or 
replaced.

Ä
CAUTION: When servicing this workstation, ensure that cables are placed in their proper location 
during the reassembly process. Improper cable placement can damage the workstation.

hard drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. 
This applies to failed drives as well as replacement spares.

■ If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective 
packaging and label the package “Fragile: Handle With Care.”

■ Do not remove hard drives from the shipping package for storage. Keep hard drives in their 
protective packaging until they are actually mounted in the workstation.

■ Avoid dropping drives from any height onto any surface.

■ If you are inserting or removing a hard drive, turn off the workstation. Do not remove a hard 
drive while the workstation is on or in standby mode.

■ Before handling a drive, ensure that you are discharged of static electricity. While handling a 
drive, avoid touching the connector. For more information about preventing electrostatic 
damage, see the “electrostatic discharge information” section in this chapter.

■ Do not use excessive force when inserting a drive.

■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic 
fields such as monitors or speakers.
4–6 hp workstation xw4100 service and technical reference guide



removal and replacement procedures
lithium coin cell battery
The battery that comes with the workstation provides power to the real-time clock and has a 
minimum lifetime of about three years.

See the “ battery” section in this chapter for instructions on the removal and replacement 
procedures.

Å
WARNING: This workstation contains a lithium battery. There is a risk of fire and chemical burn if the 
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in 
water or fire, or expose it to temperatures higher than 140º F (60º C).

Ä
CAUTION: Batteries, battery packs, and accumulators should not be disposed of together with the 
general household waste.

4.2 pre-disassembly procedures
The following steps should be taken prior to servicing the workstation:

1. Remove/disengage any security devices that prohibit opening the workstation. If an optional 
solenoid hood cover lock is installed, disable it in the software prior to turning off the 
workstation.

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette or compact disc from the workstation.

5. Turn off the workstation and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the workstation before disconnecting any cables.

Ä
CAUTION: The cooling fan is off only when the workstation is turned off or the power cable has been 
disconnected. The cooling fan is always on when the workstation is in the “On,” “Standby,” or “Suspend” 
modes. You must disconnect the power cord from the power source before opening the workstation to 
prevent system board or component damage.

6. Disconnect the power cord from the electrical outlet and then from the workstation.

7. Disconnect all peripheral device cables from the workstation.
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4.3 removal and replacement of components
This section discusses the procedures necessary to remove and install various hardware 
components on your workstation. Review the safety and precautions and the “service 
considerations” section at the beginning of this chapter, as well as the Safety and Regulatory 
Guide, before servicing or upgrading your system.

The following general outline will help you to successfully work on the system.

1. Read all safety information and precautions.

2. Locate and clear a suitable work area.

3. Shutdown the system and remove power from the unit.

4. Gather your tools.

5. Service your unit.

6. Restore power to your unit.

4.3.1 security lock (optional)
If a security padlock is installed, it should be removed before servicing the unit. To remove the 
padlock, unlock it and slide it out of the padlock loop as shown in the following illustration.
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4.3.2 cable lock (optional)
If a cable lock is installed, it should be removed before servicing the unit. To remove the cable 
lock, unlock it and pull it out of the cable lock slot as shown in the following illustration.

4.3.3 hood cover
Before accessing the internal components of the hp workstation xw4100, the hood cover must be 
removed. To remove the panel, follow these instructions.

Å
WARNING: Before removing the workstation hood cover, ensure that the workstation is turned off and 
that the power cord is disconnected from the electrical outlet.

1. Remove power from the system.

2. Lay the unit in the desktop position as shown in the following illustration.

3. If necessary, unlock the panel.

4. Pull up and out on the cover latch 1 and at the same time slide the cover 2 away from the 
bezel and then lift up.

To replace the hood cover, slide the cover back on until it snaps into place.
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4.3.4 front bezel
Follow these steps to remove the bezel:

1. With the power disconnected and the hood cover removed, lift up on the two tabs 1 located 
on the front bezel.

2. Rotate the front bezel 2 away from the chassis as shown in the following illustration and 
remove the bezel.

4.3.5 bezel blanks
To remove the bezel blanks do the follow:

1. After removing the front bezel, gently pull the subpanel 1, with the bezel blanks secured in 
it, away from the front bezel.

2. Remove the desired bezel blank 2 by pulling the blank away from the subpanel.

NOTE: The bezel blanks are keyed to assist you in replacing the blanks.
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4.3.6 chassis feet
The hp workstation xw4100 ships in a minitower configuration and chassis feet are installed on 
the base of the workstation. The unit ships with additional feet should you convert the unit to a 
desktop. To install the chassis feet on a desktop-oriented workstation:

1. Situate the unit into the appropriate position as shown in the following illustration.

2. Place the feet into the embossed areas of the unit.

4.3.7 IEEE-1394 (optional)
To install an optional IEEE-1394 adapter:

1. Install the IEEE-1394 card 1 into the PCI socket.

2. Close the PCI levers 2.

3. Connect the power cable 3 into the card.

4. Connect the IEEE-1394 cable adapter 4 to the card.

5. Connect the front IEEE-1394 pre-installed cable 5 to the adapter cable as illustrated in the 
following figure.
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4.3.8 front panel assembly
To remove the front panel assembly:

1. Remove the front bezel.

2. Disconnect the front panel assembly cable from the system board.

3. Remove the two screws 1 that hold the assembly shield to the chassis as shown in the 
following illustration.

4. Slide the front panel assembly 2 (with shield attached) out about two inches away from the 
chassis.

5. Remove the two screws 3 that hold the shield and assembly together and separate the shield 
away from the front panel assembly 4.

 

Å
WARNING: The next step requires the removal of cables through the chassis. Some edges on the 
chassis may be sharp. Care must be taken when removing these cables.

6. Slide the front panel cables through the chassis and out the front of the unit.

To replace the front panel assembly, reverse the previous steps.
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4.3.9 power button assembly
To remove the front power button assembly:

1. Remove the front bezel.

2. Disconnect the power assembly cable from the system board.

3. Slide the power button assembly out from the front of the chassis as shown in the following 
illustration.

4.3.10 power supply
To remove the power supply:

1. Disconnect the power supply from the system board.

2. Disconnect the optical drive(s), diskette drive, hard drive(s), and graphics card (select models 
only) from the power supply.

3. Remove the four screws 1 from the back panel as shown in the following illustration.

4. Slide the power supply 2 toward the front and lift up to remove it from the chassis.

To install the power supply, reverse the previous steps.
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4.3.11 system fan
To remove the system fan:

1. Disconnect the fan connector from the system board.

2. Remove the four screws 1 from the back of the chassis back panel.

3. Slide the fan 2 toward the front of the unit and remove it.

To replace a system fan, reverse the previous steps.

Ä
CAUTION: When installing the system fan, ensure that the fan is situated so that the airflow direction is 
going out of the chassis.
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4.3.12 hood cover sensor (optional)
To remove the hood cover sensor:

1. Disconnect the hood cover sensor from the system board.

2. Slide the hood cover sensor 1 forward as shown in the following illustration.

Ä
CAUTION: Be careful when sliding the hood sensor forward. The hood cover sensor bracket and the 
chassis contain sharp edges that present a safety hazard.

3. Pull the hood cover sensor 2 down and remove it from the chassis.

To replace the hood cover sensor, reverse the previous steps.
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4.3.13 solenoid hood cover lock (optional)
To remove the solenoid hood cover lock:

1. Disconnect the hood cover lock cable from the system board.

2. Using the FailSafe key, unscrew the two screws 1 from the back of the chassis as shown in 
the following diagram.

3. Slide the hood cover lock assembly 2 away from the chassis and out of the unit.

To replace the hood cover lock assembly, reverse the previous steps.

4.3.14 system speaker
To remove the speaker:

1. Disconnect the speaker from the system board.

2. Remove the four screws as shown in the following illustration.

3. Slide the speaker out of the chassis.

To replace the speaker, reverse the previous steps.
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4.3.15 processor heatsink
To remove the heatsink:

NOTE: The heatsink illustrated below is typical of what you might have in your workstation. Be 
aware that different variations of the bracket levers 1 exist, but the overall procedures listed are 
sufficient to assist you in removing the heatsink.

1. Disconnect the heatsink fan from the system board.

2. Pull up on the two bracket levers 1.

3. Pull up on the brackets 2 and lift them 3 away from the heatsink assembly as shown in the 
following illustration.

4. Rotate the heatsink 4 slightly to break the adhesive compound between the heatsink and 
processor.

5. Lift the heatsink 5 unit.

To replace the heatsink assembly, reverse the previous steps. New thermal grease must be applied 
between the heatsink and processor.
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4.3.16 memory
There are four memory sockets in the hp workstation xw4100. The system supports 
industry-standard 184-pin, PC 2700 (ECC or non-ECC) compliant or PC 3200 (ECC only) 
compliant 2.5V unbuffered DDR-SDRAM.

The system is capable of supporting up to 4 GB of memory (1 GB DIMM in each socket). 
Although a single 128 MB DIMM configuration is possible (on XMM1 only), DIMMs should be 
installed in pairs for optimal dual channel operation.

The following parameters relate to the supported memory:

■ Supported DIMM sizes include 128 MB, 256 MB, 512 MB, and 1 GB.

■ Paired DIMMs must be of the same type, size, and speed.

■ The first pair of DIMMs must be installed in XMM1 and XMM3.

■ The mixing of ECC and non-ECC memory is not supported.

■ Registered memory is not supported.

To remove DIMMs from the unit:

1. Gently push outwards on the socket levers 1 as shown in the following illustration.

2. Lift the DIMM 2 straight up and remove it from the unit.

To replace memory, reverse the previous steps.

NOTE: DIMMs and the DIMM sockets are keyed for proper installation. Make sure these guides 
line up when installing a DIMM.
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4.3.17 AGP cards
To install an AGP card:

1. Lift the PCI levers 1 by first pressing down on them and then out.

2. Lift and remove the PCI slot cover 2 directly behind the AGP socket.

3. Insert the AGP card 3 into the AGP socket.

4. Close the PCI levers 4.

5. To remove an AGP card, open the PCI levers 1 by first pressing down and then out.

6. Press in on the AGP socket release latch 2 as shown in the following illustration.

7. Lift the AGP card 3 out of the socket.
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4.3.18 PCI expansion cards (optional)
To remove an optional PCI expansion card:

1. Lift the PCI levers 1 by first pressing down on them and then out.

2. Lift the PCI expansion card 2 and remove it from the system.

To install an optional PCI expansion card:

1. Lift the PCI levers 1 by first pressing down on them and then out.

2. Remove the PCI slot cover 2 as shown in the following illustration.

3. Install the PCI expansion card 3. Verify that the keyed components of the card align with the 
PCI socket.

4. Close the PCI levers 4 as shown.
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4.3.19 battery

Ä
CAUTION: Before removing the battery, make sure your CMOS settings are backed up as all CMOS 
settings will be lost when the battery is removed. To back up the CMOS settings, use Computer Setup and 
run the Save to Diskette option from the File menu.

To remove the battery:

1. Press on the release tab 1 of the battery holder as shown in the following illustration.

2. Slide and lift the battery 2 out.

To install the battery slide the battery back in until it snaps back into place.

4.3.20 optical drive (minitower position)
To remove an optional optical drive, you must first release the drivelock. To release the drivelock:

1. Disconnect the power 1, drive 2, and audio 3 cables from the drive.
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2. After the front bezel and bezel blanks have been removed, lift the green drivelock release 
lever 1 and gently slide the drive 2 out of the chassis.

3. After pulling the drive 1 out, remove the four guide screws 2 from the drive as shown in the 
following illustration.

4. Verify the jumper settings of the new drive are set correctly.
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5. To install a drive, insert the four guide screws 1 and slide the drive 2 into the unit until it 
snaps into place.

6. Connect the drive, power, and audio cables.

4.3.21 optical drive (desktop position)
To remove an optional optical drive, you must first release the drivelock. To release the drivelock:

1. Disconnect the audio 1 , drive 2, and power 3 cables from the drive.
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2. After the front bezel and bezel blanks have been removed, press down on the yellow 
drivelock as shown in the following illustration. As you press on the yellow drivelock 1, 
gently slide the drive 2 out of the chassis.

3. After pulling the drive 1 out, remove the four guide screws 2 from the drive as shown in the 
following illustration.

4. Verify the jumper settings on the new drive are set correctly.

5. To install a drive, insert the four guide screws 1 and slide the drive 2 into the unit until it 
snaps into place.

6. Connect the drive, power, and audio cables.
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4.3.22 diskette drive
To remove an optional diskette drive:

1. Disconnect the cables from the back of the diskette drive.

2. Lift the green drivelock release tab 1 and slide the drive 2 out at the same time.

To replace an optional diskette drive, reverse the previous steps.

4.3.23 hard drive
To remove a hard drive:

1. Disconnect the cables from the back of the hard drive.

2. Lift up on the green drivelock release tab 1 and slide the hard drive 2 out of the chassis at 
the same time.

To install a hard drive, reverse the previous steps, but verify that the jumper settings are set.
hp workstation xw4100 service and technical reference guide 4–25



removal and replacement procedures
 IDE hard drive performance
When installing an IDE hard drive on a Linux-based workstation, the performance is set to 16-bit 
transfers with Direct Memory Access (DMA) turned off by default. This can be confirmed by 
running the following command:

hdparm -c -d /dev/hda

The command returns the following:

/dev/hda: 
I/O support = 0 (default 16-bit) 
using_dma = 0 (off)

To optimize IDE hard drive performance, manually set the transfer rate to 32-bit and turn DMA 
on by runnning the following command:

hdparm -c 1 -d 1 /dev/hda

The command returns the following:

/dev/hda: 
setting 32-bit I/O support flag to 1 
setting using dma to 1 (on) 
I/O support = 1 (32-bit) 
using_dma = 1 (on)

4.3.24 system board
To remove the system board:

1. Disconnect all cabling from the system board.

NOTE: Make note of the cable connections before disconnecting them from the system board.

2. Remove all expansion boards and graphics cards.

3. Press the release tab 1 as shown in the following illustration.

4. Slide the board 2 toward the front of the chassis and then lift it out of the unit.

To replace the system board, slide the board back in and lay it down until the release tab snaps it 
back into place. Re-install all cards and reconnect all cables.
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system diagnostics and troubleshooting

This chapter discusses the various means and tools available to assist you in diagnosing and 
troubleshooting system issues.

5.1 E-Support
For online access to technical support information and tools, go to http://www.hp.com/support. 
Support resources include Web-based troubleshooting tools, technical knowledge databases, 
driver and patch downloads, online communities, and proactive notification services.

5.2 preliminary troubleshooting checklist
If you encounter some minor problem with the workstation or a software application, go through 
the following checklist for possible solutions before running any of the diagnostic utilities:

■ Are the workstation and monitor connected to a working electrical outlet?

■ Is the workstation turned on?

■ Is the green power light illuminated?

■ Is the monitor turned on?

■ Is the green monitor light illuminated?

■ Turn up the monitor brightness and contrast controls if the monitor is dim.

■ Press and hold any key. If the system beeps, then the keyboard is operating correctly.

■ Check all cables for loose or incorrect connections.

■ Reconfigure the workstation after installing a non–Plug and Play expansion board or other 
option, such as a diskette drive.

■ Are all of the necessary device drivers installed?

■ Have all printer drivers been installed for each application?

■ Remove all diskettes and CDs from the drives before you turn on the system.

■ Are all switches set correctly, including the power supply voltage select switch?

■ Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC and 
the riser/system board?
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5.3 Diagnostics for Windows
The Diagnostics for Windows (DFW) utility is a component of Intelligent Manageability that 
allows you to view information about the hardware and software configuration of the workstation 
while running Microsoft Windows (Microsoft Windows 2000 and Microsoft Windows XP). It 
also allows you to perform hardware and software tests on the subsystems of the workstation.

When you invoke Diagnostics for Windows, the current configuration of the workstation is 
shown on the Overview screen. There is access from this screen to several categories of 
information about the workstation and the Test tab. The information in every screen of the 
utility can be saved to a file or printed.

NOTE: Diagnostics for Windows is not available on Linux-based workstations.

NOTE: To test all subsystems, you must log in as the administrator. If you do not log in as the 
administrator, you will be unable to test some subsystems. The inability to test a subsystem will 
be indicated by an error message under the subsystem name in the Test window or by shaded 
check boxes that cannot be selected.

Use Diagnostics for Windows in the following instances to:

■ Determine if all the devices installed on the workstation are recognized by the system and 
functioning properly. Running tests is optional but recommended after installing or 
connecting a new device.

■ Third party devices not supported by HP may not be detected. Save, print, or display the 
information generated by the utility.

5.3.1 detecting Diagnostics for Windows
Some workstations ship with the Diagnostics for Windows preloaded, but not preinstalled.

To determine whether Diagnostics for Windows is installed:

1. Access the location of the Diagnostics icons:

❏ In Windows 2000 Professional, select Start > Settings > Control Panel.

❏ In Windows XP Professional, select Start > Control Panel > Performance and 
Maintenance.

2. If icons for Configuration Record and Diagnostics for Windows are present, the Diagnostics 
for Windows utility is installed. If the icons are not present, the utility is either not preloaded 
or not installed.

5.3.2 installing Diagnostics for Windows 
If Diagnostics for Windows is not preloaded, you can download the Diagnostics for Windows 
SoftPaq from the following Web site:

http://www.hp.com/support/files
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Once the software has been downloaded onto the hard drive it may be installed by performing 
these steps:

1. Close all Windows applications.

2. Install the Diagnostics for Windows utility:

❏ In Windows XP, select Start > Setup Software icon. Select Diagnostics for Windows > 
Next button, then follow the instructions on the screen.

❏ In Windows 2000, select the Setup Software icon on the Desktop > Diagnostics for 
Windows > Next button, then follow the instructions on the screen.

❏ In either Windows XP or Windows 2000, if the Setup Software icon is not on the 
Desktop or in the Start menu, run the Setup program from the C:\CPQAPPS\DIAGS 
directory or select Start > Run and type the following in the command line: 
C:\CPQAPPS\DIAGS\SETUP.

3. Click Next to install Diagnostics for Windows.

4. After the program has finished installing, you may be prompted to restart the workstation, or 
it may automatically restart. If prompted, click Finish to restart the workstation or Cancel to 
exit the program. You must restart the workstation to complete the installation.

NOTE: If you want to upgrade an existing version of Diagnostics for Windows installed on the 
workstation, visit http://www.hp.com/support/files and click on an applicable product. Locate 
the desired software and download the latest version. Execute the downloaded file and select 
Repair to update the installed version. This causes the new version to overwrite the old version.

5.3.3 using Categories in Diagnostics for Windows 
To use categories:

1. Click Start > HP Information Center > Diagnostics for Windows. You can also select the 
Diagnostics for Windows icon, located in the Control Panel.

The screen displays the overview of the workstation hardware and software.

❏ In Windows 2000 Professional, select Start > Settings > Control Panel, then select 
Diagnostics for Windows.

❏ In Windows XP Professional, select Start > Control Panel > Performance and 
Maintenance, then select Diagnostics for Windows.

2. For specific hardware and software information, select a category from the Categories 
pull-down menu or the appropriate icon on the toolbar.

NOTE: As the cursor moves over the toolbar icons, the corresponding category name is displayed.

3. To display more detailed information in a selected category, click More in the Information 
Level box in the lower left corner of the window or click Level at the top of the screen and 
select More.
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4. Review, print, and/or save this information as desired.

❏ To print the information, click File > Print. Select one of the following options: Detailed 
Report (All Categories), Summary Report (All Categories), or Current Category. Click 
OK to print the report you selected.

❏ To save the information, click File > Save As. Select one of the following options: 
Detailed Report (All Categories), Summary Report (All Categories), or Current 
Category. Click OK to save the report you selected.

5. To exit Diagnostics for Windows, click File, and then click Exit.

menu bar—File, Categories, Navigation, Level, Tab, Help 
At the top of the Diagnostics for Windows screen is the Menu Bar consisting of six pull-down 
menus. Selecting an item will provide the following information on the system:

■ File—Save As, Print, Printer Setup, Exit

■ Categories

❏ System—System board, ROM, date, and time 

❏ Asset Control—Asset tag, system serial number, and processor

❏ Input Devices—Keyboard, mouse, and joystick(s)

❏ Communication—Ports

❏ Storage—Storage drives

❏ Graphics—Graphics

❏ Memory—System board and Windows memory

❏ Multimedia—Optical storage (CD, DVD, and so on) and audio

❏ Windows—Windows

❏ Architecture—PCI Device

❏ Resources—IRQ, I/O, and Memory Map

❏ Health—Status of system temperature and hard drives

❏ Miscellaneous—CMOS, DMI, BIOS, System, Product Name, and Serial Number

■ Navigation—Previous Category (F5), Next Category (F6)

■ Level—Less (F7), More (F8) <information on the screen>

■ Tab

❏ Overview—Displays general information about the workstation. This window is 
displayed when first starting the utility. The left side of the window shows hardware 
information, while the right side shows software information.

❏ Test—Allows you to choose various parts of the system to test. You can also choose the 
type of test and testing mode.

❏ Status—Displays the status of each test in progress. You can cancel testing by clicking 
the Cancel Testing button.

❏ Log—Displays a log of tests for each device.

❏ Error—Displays any errors that occurred during device testing. The window lists the 
device being tested, the type and number of errors, and the error code.

■ Help—Contents, How to use Help, About.
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5.3.4 running diagnostic tests in Diagnostics for Windows
To run diagnostic tests:

1. Click Start > HP Information Center > Diagnostics for Windows.

Alternately, you can access Diagnostics for Windows via the control panel.

The screen displays the overview of the workstation hardware and software. Five tabs are 
displayed below the row of icons: Overview, Test, Status, Log, and Error.

2. Click the Test tab, or click Tab at the top of the screen and select Test.

3. Select one of the following options:

❏ Quick Test—Runs a quick, general test on each device. Requires no user intervention if 
Unattended Mode is selected.

❏ Complete Test—Runs maximum testing of each device. The user can select Interactive 
Mode or Unattended Mode.

❏ Custom Test—Runs only the tests you select. To select specific devices or tests, find the 
device in the list, then select the check box beside each test. When selected, a red check 
mark is displayed in the box. Some tests selected may require user intervention.

NOTE: To test all subsystems, you must log in as the administrator. If you do not log in as the 
administrator, you will be unable to test some subsystems. The inability to test a subsystem will 
be indicated by an error message under the subsystem name in the Test window or by shaded 
boxes that cannot be checked.

4. Select Interactive Mode or Unattended Mode. In Interactive Mode, the diagnostic software 
will prompt you for input during tests that require it. Some tests require interaction and will 
display errors or halt testing if selected in conjunction with Unattended Mode.

❏ Interactive Mode provides maximum control over the testing process. You determine 
whether the test passed or failed and may be prompted to insert or remove devices.

❏ Unattended Mode does not display prompts. If errors are found, they are displayed when 
testing is complete.

5. Click the Begin Testing button at the bottom of the window. Test Status is displayed, 
showing the progress and result of each test. For more details on the tests run, click the Log 
tab or click Tab at the top of the screen and select Log.

6. To view a test report, select one of three tabs:

❏ Status—Summarizes the tests run, passed, and failed during the current testing session.

❏ Log—Lists tests run on the system, the numbers of times each test has run, the number 
of errors found on each test, and the total run time of each test.

❏ Error—Lists all errors found on the workstation with their error codes.

7. To save a test report:

❏ Select the Log tab Save button to save a Log tab report.

❏ Select the Error tab Save button to save an Error tab report.

8. To print a test report:

❏ If the report is on the Log tab, select File > Save As, and print the file.

❏ If the report is on the Error tab, select the Error tab Print button.
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9. If errors are found, click the Error tab to display more detailed information and 
recommended actions.

10. Click Print or save the error information for future reference.

11. To exit Diagnostics for Windows, click File > Exit.

5.4 troubleshooting using HP Intelligent 
Manageability features
The Local Alert Pop-Up Dialog notifies you of an impending or actual hardware failure. If the 
workstation is connected to a network and the HP Insight Management Agents are installed and 
configured, a Simple Network Management Protocol (SNMP) trap (message) is sent to the 
specified SNMP-compliant management application.

The Local Alert Pop-Up Dialog also tells you the steps you need to take prior to a hardware 
failure to avoid loss of data and damage to the workstation. The system administrator can create 
a customized action message that might include contact telephone or pager numbers.

To close the Local Alert Pop-Up Dialog, click the Close button. To retrieve fault information 
after closing the dialog, run HP Insight.

For more detailed information, refer to the online Intelligent Manageability Guide.

5.5 diagnostic error codes
This sections gives an overview of the diagnostic lights and error codes that are related to the hp 
workstation xw4100.
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5.5.1 diagnostic light codes

chassis indicator lights 

power LED and 
sound activity diagnosis and service action

none System does not power on
Press power button. If HDD LED = GREEN, then:
1. Verify voltage selected.
2. Remove expansion cards one-at-a-time until the 3.3 V_Aux light 

on the system board illuminates.
3. Replace system board.

OR
Press power button. If HDD LED does not illuminate, then:
1. Verify workstation plugged into live AC outlet.
2. Verify power button harness connected to system board.
3. Verify that both power supply cables are properly connected to 

the system board.
4. Verify that the 3.3 V_Aux light on the system board is illuminated. 

If on, replace the power button harness.
5. If the3.3 V_Aux light on the system board is not illuminated, 

replace the power supply.
6. Replace system board.

Solid GREEN 
Power LED.

Workstation on. No action required.

Solid YELLOW or 
ORANGE.

Workstation is in Standby. No action required.

GREEN Power LED 
flashes 1 X each 
2 seconds.

Workstation in Suspended to RAM mode (select models) or normal 
Suspend mode. No action required.

none Workstation in Suspend to Disk or “Hibernate” mode. No action 
required.

Solid RED LED. CPU not installed:
1. Install CPU. 
2. Reseat CPU.

Blinks RED 2 X, once 
per second, then 
2 second pause.

Thermal Shutdown:
1. Ensure the workstation air vents are not blocked and cooling fan 

is running.
2. Open hood, press power button, and see if processor fan spins. If 

not spinning, ensure fan cable is plugged into the system board. 
ensure fan is fully/properly seated.

3. If fan is plugged in and seated but not spinning, then replace 
processor fan.

4. Reseat CPU heatsink and verify fan assembly properly attached.
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Blinks RED 1 X each 
2 seconds.

Power supply failure:
1. Check that voltage selector set to proper voltage.
2. Open the hood cover and ensure the 4-wire power supply cable 

is properly connected to the system board.
3. Locate faulty device by removing all devices and then reinstalling 

one-at-a-time until workstation fails. Replace the device causing 
the failure. Continue adding devices to ensure all are functioning 
properly.

4. Replace the power supply.
5. Replace the system board.

Blinks RED 5 X, once 
per second, then 
2 second pause. 
5 Beeps.

1. Reseat memory modules.
2. Replace memory modules one-at-a-time to find the faulty module.
3. Replace third-party modules with HP memory.
4. Replace system board.

Blinks RED 6 X, once 
per second, then 
2 second pause. 
6 Beeps.

For system with integrated graphics replace system board.
For system with AGP card:
1. Reseat AGP card.
2. Replace AGP card.
3. Replace system board.

Blinks RED 7 X, once 
per second, then 
2 second pause. 
7 Beeps.

System board failure (ROM detected failure prior to video).
Replace system board.

Blinks RED 8 X, once 
per second, then 
2 second pause. 
8 Beeps.

Invalid ROM based on bad checksum.
1. Reflash ROM.
2. Replace system board.

chassis indicator lights (continued)

power LED and 
sound activity diagnosis and service action
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5.5.2 error codes
Diagnostic error codes occur if the system recognizes a problem while running the HP 
Diagnostics program. These error codes help identify possibly defective subassemblies.

Diagnostic error messages consist of three components, AABB-CC, where

AA = Device Code

BB = Subtest Code

CC = Error Code

The following table lists the device codes (AABB-CC) and the subtest code (AABB-CC) 
covered by HP Diagnostics Tests. Some codes listed in this table will not apply to the 
workstations described in this manual and will not be detailed in the tables that follow.

summary of test error codes

The remaining tables list possible error codes (AABB-CC), descriptions of each error condition, 
and recommended actions to resolve the error condition.

NOTE: Retest the system after completing each step. If the problem has been resolved, do not 
proceed with the remaining steps.

For assistance in the removal and replacement of a particular subassembly, see Chapter 4 in this 
manual.

error code 
range

 
device description

error code 
range

 
device description

0100 - 0199
0200 - 0210
0301 - 0304
0401 - 0498

Processor (P1)
Memory
Keyboard
Parallel Port

3113 - 3199
3206 - 3206
3300 - 3333

Third Processor (P3)
Audio System
Mediavision Spectrum 16
Multimedia

0501 - 0516
0600 - 0699
0802 - 0824
1101 - 1109

Video Display Unit
Diskette Drive
Monochrome Video Card
Serial Port

3400 - 3401
4113 - 4199
5100 - 5130
5234 - 5240

TV Tuner Card Fourth
Processor
Plasma Display System
Advanced Color Graphics 
(AGC)

1201 - 1210
1700 - 1799
1800 - 1823
1900 - 1906

Modem
Hard Drive
CD-ROM
Tape Drive

6000 - 6089
6500 - 6599
6600 - 6699
6700 - 6799

Network Card
SCSI Hard Drives
CD-ROM Drives
SCSI Tape Drives

2113 - 2199
2402 - 2480
 
2502

Second Processor (P2)
Enhanced Color Graphics 
(ECG/VGA)
Pen/Digitizer

7000
8601
8700 - 8702

Server Manager/R Card
Auxiliary Input Interface
Game Port
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microprocessor

error code description recommended action

0101-xx CPU test failed. The following steps apply to 0101-xx through 
0102-xx:
1. Run Computer Checkup or Computer 

Setup and retest.
2. Replace processor and retest.
3. Replace the system board and retest.

0102-xx Coprocessor error.

0103-xx DMA controller failed. The following step applies to 0103-xx 
through 0106-xx:
Replace the system board and retest.

0104-xx Interrupt controller failed.

0105-xx Port error.

0106-xx Keyboard controller self-test 
failed.

0107-xx CMOS RAM test failed. The following steps apply to 0107-xx through 
0110-xx:
1. Replace the battery/clock module and 

retest.
2. Replace the system board and retest.

0108-xx CMOS interrupt test failed.

0109-xx CMOS clock test failed.

0110-xx Programmable timer test 
failed.

0113-01 Protected mode test failed. Replace the system board and retest.

0114-01 Speaker test failed. Verify the speaker connection.
Replace speaker (if applicable) and retest.
Replace the system board and retest.

0199-xx Installed devices test failed. Check system configuration.
Verify cable connections.
Check switch settings.
Run Diagnostics utility.
Remove all devices except processor and 
replace one-at-a-time until a failure occurs.
Replace the system board.
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memory

keyboard

NOTE: Holding any key down during the boot-up sequence causes the Basic Input Output System 
(BIOS) to beep, as a warning of possible keyboard problems. Wait until after the system has 
booted, then press the Num Lock key. If the Num Lock light on the keyboard toggles on and 
off with each press of the key, the keyboard is functioning properly.

error code description recommended action

0200-xx Machine ID test failed. Reinsert memory modules and retest.

0202-xx System ROM checksum 
failed.

The following steps apply to 0202-xx through 
0212-xx:
1. Remove one memory module at a time 

until the error message stops.
2. Replace other removed modules one at a 

time, testing each to ensure the error 
does not return.

3. Replace defective modules.
4. If error continues, replace system board 

and retest.

0203-xx Write/read test failed.

0204-xx Address test failed.

0205-xxx Walking 1s test failed.

0209-xxx RAM long test failed.

0211-xx Random pattern test failed.

0212-xxx Cache test failed.

0214-xx Noise test failed. The following steps apply to 0214-xx through 
0215-xx:
1. Remove one memory module at a time 

until the error message stops.
2. Replace other removed modules one at a 

time, testing each to ensure the error 
does not return.

3. Replace the system board and retest.

0215-xx Random address test failed.

error code description recommended action

0300-xx ID test failed. The following steps apply 0300-xx through 
0304-xx:
1. Check the keyboard connection. If dis-

connected, turn the workstation off and 
connect the keyboard.

2. Replace the keyboard and retest.
3. Replace the system board and retest.

0301-xx Self-test/interface test failed.

0302-xx Individual key test failed.

0304-xx Repeat test failed.
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parallel port

diskette drive

serial port

error code description recommended action

0401-xx Failed or not connected. The following steps apply to 0401-xx through 
0403-xx:
1. Connect the printer.
2. Check power to the printer.
3. Install the loop-back connector and 

retest.
4. Replace system board and retest.

0402-xx Printer port test failed.

0403-xx Pattern test failed.

error code description recommended action

0600-xx ID drive types test failed. The following steps apply to 0600-xx through 
0698-xx:
1. Replace the diskette media and retest.
2. Reseat and/or replace the diskette power 

and signal cables and retest.
3. Replace the diskette drive and retest.
4. Replace the system board and retest.

0601-xx Format failed.

0602-xx Read test failed.

0603-xx Write, read, compare test 
failed.

0604-xx Random seek test failed.

0605-xx ID media test failed.

0606-xx Speed test failed.

0609-xx Diskette reset controller 
failed.

0610-xx Change line test failed.

0697-xx Diskette type error.

0698-xx Diskette drive speed not 
within limits.

0699-xx Diskette drive/media error. 1. Replace the diskette media and retest.
2. Run Computer Setup and TEST.

error code description recommended action

1101-xx Serial port test failed. 1. Run Computer Setup or Windows 2000 
or Windows XP.

2. Replace the system board and retest.
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modem communications

hard drive

error code description recommended action

1201-xx Internal test failed. The following steps apply to 1201-xx through 
1210-xx:
1. Disconnect from the phone line and 

retest.
2. Check the phone number.
3. Check the modem line.
4. Replace the modem and retest.

1203-xx External termination test 
failed.

1204-xx Auto originate test failed.

1205-xx Auto answer test failed.

1210-xx Direct connect test failed.

error code description recommended action

1701-xx Format test failed. The following steps apply to 1701-xx through 
1736-xx:
1. Run Computer Setup and verify drive 

type.
2. Reseat or replace the hard drive signal 

and power cables and retest. 
3. Clear CMOS.
4. Run the hard drive DPS test.
5. Replace the hard drive and retest.
6. Replace the system board and retest.

1702-xx Read test failed.

1703-xx Write/read/compare test 
failed.

1704-xx Random seek test failed.

1705-xx Controller test failed.

1708-xx Format bad track test failed.

1710-xx Park head test failed.

1715-xx Head select test failed.

1716-xx Conditional format test 
failed.

1717-xx ECC* test failed.

1719-xx Power mode test failed.

1724-xx Network preparation test 
failed.

1736-xx Monitoring test failed.

*Error Correction Code
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tape drive

video

error code description recommended action

1900-xx ID test failed. The following steps apply to 1900-xx through 
1910-xx
1. Replace the tape cartridge and retest.
2. Reseat and/or replace the signal cable and 

retest.
3. Check the switch settings on the adapter card 

(if applicable).
4. Replace the tape adapter card (if applicable) 

and retest.
5. Replace the tape drive and retest.
6. Replace the system board and retest.

1901-xx Servo test failed.

1902-xx Format or format 
verification test failed.

1903-xx Sensor test failed.

1904-xx BOT/EOT test failed.

1905-xx Read test failed.

1906-xx Write/read/compare 
failed.

1910-xx Tape erase test failed.

error code description recommended action

501-xx Graphics controller test failed. The following steps apply to 501-xx through 
516-xx:
1. Replace the monitor and retest.
2. Replace the graphics controller and 

retest.
3. Replace the system board and retest.

502-xx Video memory test failed.

503-xx Video attribute test failed.

504-xx Video character test failed.

505-xx Video 80 × 25 mode 9 × 14 
character cell test failed.

506-xx Video 80 × 25 mode 8 × 8 
character cell test failed.

507-xx Video 40 × 25 mode test failed.

508-xx Video 300 × 200 mode color 
set 0 test failed.

509-xx Video 320 × 200 mode color 
set 1 test failed.

510-xx Video 640 × 200 mode test 
failed.

511-xx Video screen memory page test 
failed.

512-xx Video gray scale test failed.

514-xx Video white screen test failed.

516-xx Video noise pattern test failed.

2401-xx Graphics controller test failed. 1. Reseat the video card (if applicable) and 
retest.

2. Replace the video card and retest.
3. Replace the system board and retest.
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2402-xx Memory test failed. The following steps apply to 2402-xx through 
2419-xx:
1. Reseat the video card (if applicable) and 

retest.
2. Run the Configuration and Diagnostics 

utilities.
3. Replace the monitor and retest.
4. Replace the video/system board and 

retest.

2403-xx Attribute test failed.

2404-xx Character set test failed.

2405-xx 80 × 25 mode 9 × 14 
character cell test failed.

2406-xx 80 × 25 mode 8 × 8 character 
cell test failed.

2408-xx 320 × 200 mode color set 0 
test failed.

2409-xx 320 × 200 mode color set 1 
test failed.

2410-xx 640 × 200 mode test failed.

2411-xx Screen memory page test failed.

2412-xx Gray scale test failed.

2418-xx ECG/VGC memory test failed.

2419-xx ECG/VGC ROM checksum test 
failed.

2420-xx Graphics attribute test failed. Replace the monitor and retest.

2421-xx ECG/VGC 640 × 200 graphics 
mode test failed.

1. Reseat the video card (if applicable) and 
retest.

2. Replace the video/system board and 
retest.

2422-xx ECG/VGC 640 × 350 16 color 
set test failed.

The following steps apply to 2422-xx through 
2456-xx:
1. Reseat the video card (if applicable) and 

retest.
2. Run the Configuration and Diagnostics 

utilities.
3. Replace the monitor and retest.
4. Replace the video/system board and 

retest

2423-xx ECG/VGC 640 × 350 64 color 
set test failed.

2424-xx ECG/VGC monochrome text 
mode test failed.

2425-xx ECG/VGC monochrome graph-
ics mode test failed.

2431-xx 640 × 480 graphics test failed.

2432-xx 320 × 200 graphics (256 color 
mode) test failed.

2448-xx Advanced VGA Controller test 
failed.

2451-xx 132-column Advanced VGA test 
failed.

2456-xx Advanced VGA 256 Color test 
failed.

error code description recommended action
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audio

network interface

CD-ROM and DVD-ROM

2458-xx Advanced VGA BitBLT test. The following steps apply to 2458-xx through 
2480-xx:
1. Reseat the video card (if applicable) and 

retest.
2. Replace the video card and retest.
3. Replace the system board and retest.

2468-xx Advanced VGA DAC test.

2477-xx Advanced VGA data path test.

2478-xx Advanced VGA BitBLT test.

2480-xx Advanced VGA Linedraw test.

error code description recommended action

error code description recommended action

3206-xx Audio System Internal Error. Replace the system board and retest.

NOTE: When Windows 2000 or Windows XP is installed, changes to ESS sound device 
configuration do not take effect until the workstation is restarted (turned off and on). 

error code description recommended action

6000-xx ID test failed. The following steps apply to 6000-xx through 
6089-xx:
1. Run Computer Setup or Windows 2000 

or Windows XP utilities.
2. Verify test procedures.
3. Replace the network card, if installed.
4. Replace the system board.

6014-xx Configuration test failed.*

6016-xx Reset test failed.*

6028-xx Internal test failed.*

6029-xx External test failed.*

6054-xx Configuration test failed.**

6056-xx Reset test failed.**

6068-xx Internal test failed.**

6069-xx External test failed.**

6089-xx Open test failed.**

*Ethernet only. 
**Token Ring only.

error code description recommended action

3301-xx CD-ROM drive read test 
failed.

The following steps apply to 3301-xx through 
3305-xx and 6600-xx through 6623-xx:
1. Replace the CD media and retest.
2. Check the jumper settings on the adapter 

card.
3. Verify that the speakers are connected.
4. Reseat and/or replace the power and 

signal cables and retest.
5. Replace the CD-ROM drive and retest.

3305-xx CD-ROM drive seek test 
failed.

6600-xx ID test failed.

6605-xx Read test failed.

6608-xx Controller test failed.

6623-xx Random read test failed.
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pointing devices

5.5.3 special error codes
This section includes the error codes for the following devices:

■ SCSI hard drives

■ SCSI tape drives

■ SCSI PD-CD drives

■ All CD-ROM drives

The SCSI error codes consist of three components, AABB-CC, where

AA = Device Name

BB = Test Name

CC = Error Code

For example, a diagnostic error code of 6523-05 indicates that the diagnostics program was 
testing the hard drive random-read function and received a seek failure. The device is faulty and 
must be replaced.

device names

test names

error code description recommended action

8601-xx Mouse test failed. The following steps apply to 8601-xx through 
8602-xx:
1. Replace with a working mouse and 

retest.
2. Replace the system board and retest.

8602-xx Interface test failed.

65XX-XX
66XX-XX
67XX-XX

Hard Drive
CD-ROM Drive and PD-CD Drive
Tape Drive

XX00-XX
XX05-XX
XX06-XX
XX08-XX

ID
Read
SA/Media
Controller

XX09-XX
XX23-XX
XX28-XX

Media erase
Random read
Media load/unload
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test error codes

error code description recommended action

XXXX-02 Drive not installed. Check cable connections.

XXXX-03 Media not in drive. Check for and install data CD or 
write-enabled tape in drive.

XXXX-05 Seek failure. Replace the indicated device.

XXXX-06 Drive timed out. Replace the indicated device.

XXXX-07 Drive busy. Replace the indicated device.

XXXX-08 Drive already reserved. Replace the indicated device.

XXXX-09 Unknown.

XXXX-10 Unknown.

XXXX-11 Media soft error. Replace the indicated device.

XXXX-12 Drive not ready. Replace the indicated device.

XXXX-13 Media error. Replace the indicated device.

XXXX-14 Drive hardware error. Replace the indicated device.

XXXX-15 Illegal drive command. Replace the indicated device.

XXXX-16 Media was changed. Replace the indicated device.

XXXX-17 Tape write-protected. 1. Disable write-protect on tape cartridge.
2. Replace tape drive.

XXXX-18 No data detected. Replace the indicated device.

XXXX-21 Drive command aborted. Replace the indicated device.

65XX-24 Media hard error. 1. Back up data and perform Surface 
Analysis to reallocate defect.

2. Replace drive.

66XX-24 Media hard error. 1. Replace current data CD with different 
data CD.

2. Replace drive.

67XX-24 Media hard error. 1. Ensure correct media type for this tape 
drive.

2. Replace current tape with new tape.
3. Replace tape drive.

XXXX-25 Unknown.

XXXX-30 Controller timed out. Replace the indicated device.

XXXX-31 Unrecoverable error. Replace the indicated device.

XXXX-32 Controller/drive 
disconnected.

Replace the indicated device.

XXXX-33 Illegal controller command. Replace the indicated device.

XXXX-34 Invalid SCSI bus phase. Replace the indicated device.
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XXXX-35 Invalid SCSI bus phase. Replace the indicated device.

XXXX-36 Invalid SCSI bus phase. Replace the indicated device.

XXXX-39 Error status from drive. Replace the indicated device.

XXXX-40 Target timed out. Replace the indicated device.

XXXX-41 SCSI bus stayed busy. Replace the indicated device.

XXXX-42 ACK/REQ lines bad. Replace the indicated device.

XXXX-43 ACK did not deassert. Replace the indicated device.

XXXX-44 Parity error. Replace the indicated device.

XXXX-50 Data pins bad. Replace the indicated device.

XXXX-51 Data line 7 bad. Replace the indicated device.

XXXX-52 MSG, C/D, and/or I/O 
lines bad.

Replace the indicated device.

XXXX-53 BSY never went busy. Replace the indicated device.

XXXX-54 BSY stayed busy. Replace the indicated device.

XXXX-60 Controller CONFIG-1 
register bad

Replace the indicated device.

XXXX-61 Controller CONFIG-2 
register bad

Replace the indicated device.

XXXX-65 Media not unloaded. Replace the indicated device.

XXXX-90 Fain failure. 1. Ensure fan(s) connected.
2. Replace nonfunctional fan(s).

XXXX-91 Over temperature. 1. Ensure proper air flow.
2. Perform required maintenance and 

cleaning.

XXXX-99 Autoloader reported tapes 
not loaded properly.

1. Install tape(s) in autoloader tape drive 
according to test instructions.

2. Change autoloader magazine.

error code description recommended action
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5.6 troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and includes 
possible solutions for each.

5.6.1 solving minor problems

solving minor problems 

problem cause possible solution

Workstation appears 
locked up and will not 
turn off when the power 
button is pressed.

Software control of the 
power switch is not 
functional.

1. Press and hold the power button 
for at least four seconds until the 
workstation turns off.

2. Disconnect electrical plug from 
outlet.

Workstation will not 
respond to USB 
keyboard or mouse.

Workstation is in 
standby mode.

Press the power button to resume from 
standby mode.

ÄWhen attempting to resume from standby mode, do not hold down the power button for more than 
four seconds. Otherwise, the workstation will shut down and you will lose your data.

Workstation date and 
time display is incorrect.

RTC (real-time clock) 
battery may need to be 
replaced. 

1. Reset the date and time under 
Control Panel. 

2. Replace the RTC battery.

Workstation appears to 
pause periodically.

Network driver is loaded 
and no network 
connection is established.

Establish a network connection, or use 
Computer Setup or Microsoft Windows 
Device Manager to disable the network 
controller.

Cursor will not move 
using the arrow keys on 
the keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The Num 
Lock key can be disabled (or enabled) 
in Computer Setup.

Cannot remove hood 
cover.

Solenoid hood cover lock, 
featured on some 
workstations, is locked.

1. Unlock the solenoid hood cover lock 
using Computer Setup.

2. Use the hood cover FailSafe Key in 
case of forgotten password, power 
loss, or workstation malfunction.

Poor performance is 
experienced.

Processor is hot. 1. Ensure airflow to the workstation is 
not blocked.

2. Ensure the fans are connected and 
working properly (some fans only 
operate when needed).

3. Ensure the processor heatsink is 
installed properly.

Hard drive is full. Transfer data from the hard drive to 
create more space on the hard drive.
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Workstation powered 
off automatically and 
the Power LED flashes 
Red two times, once 
every second, followed 
by a two second pause.

Processor thermal 
protection activated:
A fan may be blocked 
or not turning.
OR 
The heatsink is not 
properly attached to 
the processor.

1. Ensure workstation air vents are not 
blocked and the cooling fan is 
running.

2. Open hood, press power button, 
and see if the processor fan spins. 
If not spinning, make sure the fan’s 
cable is plugged onto the system 
board header. Ensure the fan is 
fully/properly seated or installed.

3. Replace the processor fan.
4. Reseat processor heatsink and 

verify that the fan assembly is 
properly attached.

System does not power 
on and the LEDs on the 
front of the workstation 
are not flashing.

System unable to 
power on.

Press and hold the power button for less 
than 4 seconds. If the hard drive LED 
turns green, then:
1. Check that the voltage selector is set 

to the appropriate voltage.
2. Remove the expansion cards one at 

a time until the 3.3 V_aux light on 
the system board turns on.

3. Replace the system board.
OR
Press and hold the power button for less 
than 4 seconds. If the hard drive LED 
does not turn on green then:
1. Check that the unit is plugged into a 

working AC outlet.
2. Open hood and check that the 

power button harness is properly 
connected to the system board.

3. Check that both power supply 
cables are properly connected to 
the system board.

4. If the 3.3 V_aux light on the system 
board is on, then replace the power 
button harness.

5. If the 3.3 V_aux light on the system 
board is off, then replace the power 
supply.

6. Replace the system board.

solving minor problems (continued)

problem cause possible solution
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5.6.2 solving power supply problems

solving power supply problems 

problem cause solution

Power supply shuts down 
intermittently.

Voltage selector switch 
on rear of workstation 
chassis not switched to 
correct line voltage.

Select the proper AC voltage.

Power supply fault. Replace the power supply.

Workstation powered off 
automatically and the 
Power LED flashes Red two 
times, once every second, 
followed by a two second 
pause.

Processor thermal 
protection activated:
A fan may be blocked 
or not turning.
OR 
The heatsink/fan 
assembly is not properly 
attached to the 
processor.

1. Ensure that the workstation air 
vents are not blocked and the 
cooling fan is running.

2. Open hood, press the power 
button, and see if the processor 
fan spins. If the processor fan is 
not spinning, make sure the fan’s 
cable is plugged onto the system 
board header. Ensure the fan is 
fully/properly seated or installed.

3. Replace the processor fan.
4. Reseat processor heatsink and 

verify that the fan assembly is 
properly attached.

Power LED flashes Red, 
once every two seconds.

Power failure (power 
supply is overloaded).

1. Check that the voltage selector, is 
set to the appropriate voltage.

2. Open the hood and ensure the 
4-wire power supply cable is 
seated into the connector on the 
system board.

3. Check if a device is causing the 
problem by removing ALL attached 
devices). Power on the system. 
If the system enters the POST, 
then power off and replace one 
device at a time and repeat this 
procedure until failure occurs. 
Replace the device causing the 
failure. Continue adding devices 
one at a time to ensure all devices 
are functioning properly.

4. Replace the power supply.
5. Replace the system board.
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5.6.3 solving diskette problems

solving diskette problems 

problem cause solution

Diskette drive light stays on. Diskette is damaged. In Microsoft Windows 2000 and 
Microsoft Windows XP, right-click 
Start, click Explore, and select a 
drive. Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Diskette is incorrectly 
inserted.

Remove diskette and reinsert.

Drive button is not 
pushed in.

Push in drive button.

Files on diskette are 
damaged.

Check the program diskettes.

Drive cable is not 
properly connected.

Reconnect power cable. Ensure that 
all four pins are connected.

Drive not found. Cable is loose. Reseat diskette drive data and power 
cables.

Removable drive is not 
seated properly.

Reseat the drive.

Diskette drive cannot write 
to a diskette.

Diskette is not formatted. Format the diskette.

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.

Writing to the wrong 
drive.

Check the drive letter in the path 
statement.

Not enough space is left 
on the diskette.

Use another diskette.

Diskette write control is 
enabled.

Use Computer Setup to check the 
storage security feature disabled 
settings.

Diskette is damaged. Replace the damaged disk.
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Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, 
you may need to specify diskette 
capacity. For example, to format a 
1.44-MB diskette, type the following 
command at the MS-DOS prompt:

FORMAT A: /F:1440

A problem has occurred 
with a disk transaction.

The directory structure 
is bad, or there is a 
problem with a file.

In Windows 2000 and Windows XP, 
right-click Start, click Explore, 
and select a drive. Select File > 
Properties > Tools. Under 
Error-checking, click Check Now.

Diskette drive cannot read 
a diskette.

Diskette is not formatted. Format the diskette.

You are using the wrong 
diskette type for the drive 
type.

Check the type of drive that you 
are using and use the correct diskette 
type.

You are reading the 
wrong drive.

Check the drive letter in the path 
statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” 
message is displayed.

A diskette that does not 
contain the system files 
needed to start the 
workstation has been 
inserted in the drive.

When drive activity stops, remove the 
diskette and press the Spacebar. 
The workstation should start up.

Diskette error has 
occurred.

Restart the workstation by pressing 
the power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer 
Setup.

Run Computer Setup and enable 
diskette boot in Storage > Boot 
Order.

Removable media boot 
has been disabled in 
Computer Setup.

Run Computer Setup and enable 
Removable Media Boot in Storage > 
Storage Options.

Diskette MBR validation 
is enabled.

Run Computer Setup and disable 
Diskette MBR Validation in Storage > 
Storage Options.

solving diskette problems (continued)

problem cause solution
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5.6.4 solving hard drive problems

solving hard drive problems 

problem cause solution

Hard drive error occurs. Hard disk has bad 
sectors or has failed.

Use a utility to locate and block usage 
of bad sectors. If necessary, reformat 
the hard disk.

Disk transaction problem. Either the directory 
structure is bad or there 
is a problem with a file.

In Windows 2000 and Windows XP, 
right-click Start, click Explore, and 
select a drive. Select File > Properties > 
Tools. Under Error-checking, click 
Check Now.

Drive not found (identified). Loose cable. Check cable connections.

The system may not 
have automatically 
recognized a newly 
installed device.

1. Run Computer Setup.
2. If the system still does not 

recognize the new device, check 
to see if the device is listed within 
Computer Setup. If it is listed, 
the probable cause is a driver 
problem. If it is not listed, the 
probable cause is a hardware 
problem.

3. If this is a newly installed drive, 
enter Setup and try adding a 
POST delay under Advanced > 
Power-On.

Drive jumper settings 
may be incorrect.

If the drive is a secondary drive that 
has just been installed on the same 
cable as the primary drive, verify that 
the jumpers for both drives are set 
correctly.

Drive’s IDE (ATA) 
controller is disabled in 
Computer Setup.

Run Computer Setup and enable the 
Primary and Secondary IDE (ATA) 
controllers in Storage > Storage 
Options.

Drive responds slowly 
immediately after 
power-up.

Run Computer Setup and increase the 
POST Delay in Advanced > Power-On 
Options.

Nonsystem disk/NTLDR 
missing message.

System is trying to start 
from a non-bootable 
diskette.

Remove the diskette from the diskette 
drive.
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Nonsystem disk/NTLDR 
missing message. 
(continued)

System is trying to start 
from a damaged hard 
drive.

1. Insert a bootable diskette into the 
diskette drive and restart the 
workstation.

2. If the hard drive is still inaccessible 
and MBR Security is enabled, try 
restoring the previously saved 
MBR image by entering Setup and 
selecting Security > Restore Master 
Boot Record.

System files missing or 
not properly installed.

1. Insert a bootable system diskette 
and restart.

2. Verify hard drive is partitioned 
and formatted. 

3. Install system files for the 
appropriate operating system 
if necessary.

Hard drive boot 
disabled in Computer 
Setup.

Run Computer Setup and enable the 
hard drive entry in the Storage > Boot 
Order list.

Second Ultra ATA hard 
drive does not perform 
optimally.

Using the wrong cable 
for the drive type.

Reinstall the second Ultra ATA hard 
drive using an 80-conductor cable 
(standard on select models.)

Both slow and fast 
UATA devices are on 
the same data cable.

Connect slower UATA devices to a 
separate data cable connected to the 
secondary IDE (ATA) controller.

Workstation will not start. Hard drive is damaged. Observe the beeps and LED lights on 
the front of the workstation. See the 
“Power-On Self-Test (POST) and error 
messages” section in this chapter.

Workstation seems to be 
locked up.

Program in use has 
stopped responding to 
commands.

1. Attempt the normal Windows 
“Shut Down” procedure. 

2. Press the power button for four 
or more seconds to turn off the 
power. 

3. Restart the workstation using the 
power button.

solving hard drive problems (continued)

problem cause solution
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5.6.5 solving display problems

solving display problems 

problem cause solution

Blank screen (no video). The cable connections 
are not correct.

Check the cable connections from the 
monitor to the workstation and to the 
electrical outlet.

Screen blanking utility 
installed or energy 
saver features enabled.

Press any key or click the mouse button 
and, if set, type your password.

System ROM is bad; 
system is running in 
FailSafe Boot Block 
mode (indicated by 
eight beeps).

Reflash the ROM using a ROMPaq 
diskette.

Fixed-sync monitor will 
not sync at the 
resolution chosen.

Ensure that the monitor can accept the 
same horizontal scan rate as the 
resolution chosen.

Computer is in standby 
mode.

Press the power button to resume from 
standby mode.

ÄWhen attempting to resume from standby mode, do not hold down the power button for 
more than four seconds. Otherwise, the workstation will shut down and you will lose 
your data.

Monitor cable plugged 
into the wrong 
connector.

If the workstation system has both 
an integrated graphics connector and 
an AGP card connector, plug the 
monitor cable into the AGP card 
connector.

Monitor settings in the 
workstation are not 
compatible with the 
monitor.

1. Restart the workstation and press 
F8 during startup when you see 
“Press F8” in the bottom right 
corner of the screen.

2. Using the keyboard arrow keys, 
select Enable VGA Mode and 
press Enter.

3. In Windows Control Panel, 
double-click the Display icon and 
select the Settings tab.

4. Use the sliding control to reset the 
resolution.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the workstation 
beeps six times.

Pre-video graphics 
error.

For systems with a graphics card:
1. Reseat the graphics card. 
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, 
replace the system board.
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Monitor does not function 
properly when used with 
energy saver features.

Monitor without energy 
saver capabilities is 
being used with energy 
saver features enabled.

Disable monitor energy saver feature.

Dim characters. The brightness and 
contrast controls are not 
set properly.

Adjust the monitor brightness and 
contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is 
securely connected to the graphics 
card and the monitor.

Blurry video or requested 
resolution cannot be set.

If the graphics controller 
was upgraded, the 
correct video drivers 
may not be loaded.

Install the video drivers included in the 
upgrade kit.

Monitor is not capable 
of displaying requested 
resolution.

Change requested resolution.

The picture is broken up, 
rolls, jitters, or flashes.

The monitor connections 
may be incomplete or 
the monitor may be 
incorrectly adjusted.

1. Be sure the monitor cable is 
securely connected to the 
workstation.

2. In a two-monitor system or if 
another monitor is in close 
proximity, be sure the monitors are 
not interfering with each other’s 
electromagnetic field by moving 
them apart.

3. Fluorescent lights or fans may be 
too close to the monitor.

Monitor needs to be 
degaussed.

Degauss the monitor. 

Vibrating or rattling noise 
coming from inside a CRT 
monitor when powered on.

Monitor degaussing coil 
has been activated.

None. It is normal for the degaussing 
coil to be activated when the monitor 
is powered on.

Clicking noise coming from 
inside a CRT monitor.

Electronic relays have 
been activated inside 
the monitor.

None. It is normal for some monitors 
to make a clicking noise when turned 
on and off, when going in and out of 
standby mode, and when changing 
resolutions.

High pitched noise coming 
from inside a flat panel 
monitor.

Brightness and/or 
contrast settings are 
too high.

Lower brightness and/or contrast 
settings.

solving display problems (continued)

problem cause solution
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5.6.6 solving audio problems

Fuzzy focus; streaking, 
ghosting, or shadowing 
effects; horizontal scrolling 
lines; faint vertical bars; or 
unable to center the picture 
on the screen. (Flat panel 
monitors using an analog 
VGA input connection 
only.)

Flat panel monitor’s 
internal digital 
conversion circuits may 
be unable to correctly 
interpret the output 
synchronization of the 
graphics card.

1. Select the monitor’s 
Auto-Adjustment option in the 
monitor’s on-screen display menu.

2. Manually synchronize the Clock 
and Clock Phase on-screen display 
functions. Download SoftPaq 
SP20930 or SP22333, depending 
on the monitor, to assist with the 
synchronization.

Certain typed symbols do 
not appear correct.

The font you are using 
does not support that 
particular symbol.

Use the Character Map to locate the 
and select the appropriate symbol. 
Click Start > All Programs > 
Accessories > System Tools > 
Character Map. You can copy the 
symbol from the Character Map into 
a document.

solving display problems (continued)

problem cause solution

solving audio problems 

problem cause solution

Sound does not come 
out of the speaker or 
headphones.

Software volume control 
is turned down.

Double-click the Speaker icon on the 
taskbar and use the volume slider to 
adjust the volume.

The external speakers 
are not turned on.

Turn on the external speakers.

External speakers 
plugged into the wrong 
audio jack.

See the sound card documentation for 
proper speaker connection.

Audio cable not 
connected.

Connect audio cable between CD or 
DVD-ROM drive and the system board.

Digital CD audio is 
not enabled.

Enable digital CD audio:
1. From the Control Panel, select 

System.
2. On the Hardware tab, click the 

Device Manager button.
3. Right-click on the CD/DVD device 

and select Properties.
4. On the Properties tab, make sure 

“Enable digital CD audio for this 
CD-ROM device” is checked.
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Headphones or devices 
connected to the 
line-out connector mute 
the internal speaker.

Turn on and use headphones or 
external speakers, if connected, or 
disconnect headphones or external 
speakers.

Volume is muted. 1. From the Control Panel program, 
click Sound, Speech and Audio 
Devices, then click Sounds and 
Audio Devices.

2. Click the Mute check box to 
remove the check mark from 
the box.

Computer is in standby 
mode.

Press the power button to resume from 
standby mode.

ÄWhen attempting to resume from standby mode, do not hold down the power button for 
more than four seconds. Otherwise, the workstation will shut down and you will lose 
your data.

Noise or no sound comes 
out of the speakers or 
headphones.

1. If using digital speakers that have 
a stereo jack and want the system 
to auto-switch to digital, use a 
stereo-to-mono adapter to properly 
engage the auto-sense feature 
or use the multimedia device 
properties to manually switch 
the audio signal from analog to 
digital.

2. If the headphones have a mono 
jack, use the multimedia device 
properties to switch the system to 
analog out.

NOTE: If you set digital as the Output Mode, the internal speaker and external analog 
speakers will no longer output audio until you switch back to an auto-sense or 
analog mode. 
 
If you set analog as the Output Mode, external digital speakers will not function until you 
change the output mode back to an auto-sense or digital mode.

Sound cuts in and out. Processor resources are 
being used by other 
open applications.

Shut down all open processor-intensive 
applications.

Workstation appears to be 
locked up while recording 
audio.

The hard disk may 
be full.

1. Before recording, make sure there 
is enough free space on the hard 
disk. 

2. Try recording the audio file in a 
compressed format.

solving audio problems (continued)

problem cause solution
5–30 hp workstation xw4100 service and technical reference guide



system diagnostics and troubleshooting
5.6.7 solving printer problems

solving printer problems 

problem cause solution

Printer will not print. Printer is not turned on 
and online.

Turn the printer on and make sure it is 
online.

The correct printer 
driver for the 
application are not 
installed.

1. Install the correct printer driver for 
the application.

2. Try printing using the MS-DOS 
command:
DIR C:\ > [printer port]
where [printer port] is the 
address of the printer being used. 
If the printer works, reload the 
printer driver.

If you are on a network, 
you may not have made 
the connection to the 
printer.

Make the proper network connections 
to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on. The cables may not be 
connected properly.

Reconnect all cables.

Printer prints garbled 
information.

The correct printer 
driver is not installed.

Install the correct printer driver for the 
application.

The cables may not be 
connected properly.

Reconnect all cables.

Printer memory may be 
overloaded.

Reset the printer by turning it off for 
one minute, then turn it back on.

Printer is offline. The printer may be out 
of paper.

1. Check the paper tray and refill it 
if it is empty. 

2. Select online.
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5.6.8 solving keyboard and mouse problems

solving keyboard problems

problem cause solution

Keyboard commands and 
typing are not recognized 
by the workstation.

Keyboard connector 
is not properly 
connected.

1. Turn off the workstation.
2. Reconnect the keyboard to the 

back of the workstation and restart 
the workstation.

Program in use has 
stopped responding 
to commands.

Shut down the workstation using 
the mouse and then restart the 
workstation.

Keyboard needs 
repairs.

Replace the keyboard.

Workstation is in 
standby mode.

Press the power button to resume from 
standby mode.

ÄWhen attempting to resume from standby mode, do not hold down the power button for 
more than four seconds. Otherwise, the workstation will shut down and you will lose 
your data.

Cursor will not move using 
the arrow keys on the 
keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on 
if you want to use the arrow keys. The 
Num Lock key can be disabled 
(or enabled) in Computer Setup.

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged 
into the back of the 
workstation.

1. Shut down the workstation using 
the keyboard.

2. Plug the mouse connector into the 
back of the workstation (or the 
keyboard) and restart the 
workstation.

Program in use has 
stopped responding 
to commands.

Shut down the workstation using the 
keyboard and then restart the 
workstation.

Mouse needs repairs. Replace the mouse.

Workstation is in 
standby mode.

Press the power button to resume from 
standby mode.

ÄWhen attempting to resume from standby mode, do not hold down the power button for 
more than four seconds. Otherwise, the workstation will shut down and you will lose 
your data.

Mouse will only move 
vertically or horizontally, 
or movement is jerky.

Mouse roller ball is 
dirty.

Remove roller ball cover from the 
bottom of the mouse and clean it.
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5.6.9 solving front panel component problems
If you are experiencing problems with one of the front panel ports, you might be able to try your 
device in the corresponding port on the back side of the computer. If this does not fix the 
problem, or you need to use the front panel ports, continue troubleshooting. 

Some problems in this section are also discussed in other troubleshooting suggestions in this 
chapter.

solving front panel component problems 
problem cause solution

If a USB device, 
headphone, or microphone 
is not recognized by the 
workstation.

It is not properly 
connected.

1. Turn off the workstation.
2. Reconnect the device to the front of 

the workstation and restart the 
workstation.

The device does not 
have power.

If the USB device requires AC power, 
be sure one end is connected to the 
device and one end is connected to a 
live outlet.

The correct device 
driver is not installed.

1. Install the correct driver for the 
device.

2. You might need to reboot the 
workstation.

The cable from the 
device to the computer 
does not work.

1. If possible, replace the cable.
2. Restart the workstation.

The device is not 
working.

1. Replace the device.
2. Restart the workstation.

A device in the IEEE-1394 
port is not responsive.

Cable(s) of new 
external device are 
loose or power cables 
are unplugged.

Ensure that all cables are properly and 
securely connected.

The power switch on the 
device is not turned on. 

Turn off the workstation, turn on the 
external device, then turn on the 
workstation to integrate the device 
with the workstation system.

The IEEE-1394 port is not 
active.

The port is not there 
because it was not 
purchased with the 
system. 

You can buy an IEEE1394 connection. 
Contact an HP seller. 
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The IEEE-1394 cable 
might not be connected 
to the adapter cable.

1. Turn off the workstation.
2. Remove the hood cover. See 

“hood cover” for more 
information.

3. Be sure the power cable is 
connected to the card. See 
“IEEE-1394 (optional)”

4. Be sure to connect the IEEE-1394 
cable adapter to the card. See 
“IEEE-1394 (optional)”

5. Be sure to connect the front 
IEEE-1394 pre-installed cable to 
the adapter cable. See “IEEE-1394 
(optional)”

solving front panel component problems (continued)
problem cause solution
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5.6.10 solving hardware installation problems
You may need to reconfigure the workstation when you add or remove hardware, such as an 
additional diskette drive. If you install a plug and play device, Windows 2000 and Windows XP 
automatically recognize the device and configure the workstation. If you install a non-plug and 
play device, you must reconfigure the workstation after completing installation of the new 
hardware. In Windows 2000, select the Add New Hardware icon in the Control Panel (for 
Windows XP, use the Add Hardware Wizard) and follow the instructions that appear on the 
screen.

solving hardware installation problems 

problem cause solution

A new device is not 
recognized as part of 
the system.

Device is not seated or 
connected properly.

Ensure that the device is properly and 
securely connected and that pins in the 
connector are not bent down.

Cable(s) of new 
external device are 
loose or power cables 
are unplugged.

Ensure that all cables are properly and 
securely connected and that pins in the 
cable or connector are not bent down.

Power switch of new 
external device is not 
turned on.

Turn off the workstation, turn on the 
external device, then turn on the 
workstation to integrate the device 
with the workstation system.

When the system 
advised you of changes 
to the configuration, you 
did not accept them.

Reboot the workstation and follow the 
instructions for accepting the changes.

A plug and play board 
may not automatically 
configure when 
added if the default 
configuration conflicts 
with other devices.

Use Windows 2000 or Windows XP 
Device Manager to deselect the 
automatic settings for the board and 
choose a basic configuration that does 
not cause a resource conflict. You 
can also use Computer Setup to 
reconfigure or disable devices to 
resolve the resource conflict.

Workstation will not start. Wrong memory 
modules were used in 
the upgrade or memory 
modules were installed 
in the wrong location.

1. Review the documentation that 
came with the system to determine 
if you are using the correct 
memory modules and to verify the 
proper installation.

2. Observe the beeps and LED lights 
on the front of the workstation. See 
the “Power-On Self-Test (POST) 
and error messages” section to 
determine possible causes.
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5.6.11  solving network problems
These guidelines do not discuss the process of debugging the network cabling.

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the workstation 
beeps five times.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs.
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory with 

HP memory.
4. Replace the system board.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the workstation 
beeps six times.

Video card is not seated 
properly or is bad, or 
system board is bad.

For systems with a graphics card:
1. Reseat the graphics card. Power 

on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, 
replace the system board.

solving hardware installation problems (continued)

problem cause solution

solving network problems 

problem cause solution

Wake-on-LAN feature is 
not functioning.

Wake-on-LAN is not 
enabled.

Use the Network control application 
to enable Wake-on-LAN.

Network driver does 
not detect network 
controller.

Network controller is 
disabled.

Run Computer Setup and enable 
network controller.

Incorrect network driver. Check the network controller 
documentation for the correct driver 
or obtain the latest driver from the 
manufacturer’s Web site.

Network status link light 
does not turn on or it 
never flashes.

NOTE: The 
network status 
light should flash 
when there is 
network activity.

No active network is 
detected.

Check cabling and network 
equipment for proper connection.

Network controller is not 
set up properly.

Use the Network control application 
to verify that the device is working 
properly.

Network driver is not 
properly loaded.

Reinstall network drivers.

System cannot autosense 
the network.

Disable auto-sensing capabilities and 
force the system into the correct 
operating mode.
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Diagnostics reports a 
failure.

The cable is not securely 
connected.

Ensure that both ends of the data 
cable are securely connected. 

The cable is attached to 
the incorrect connector.

Ensure that the cable is attached to 
the correct connector.

There is a problem with 
the cable or a device at 
the other end of the cable.

Ensure that the cable and device at 
the other end are operating correctly.

Network controller 
interrupt is shared with 
an expansion board.

Under the Computer Setup Advanced 
menu, change the resource settings 
for the board.

The network controller 
is defective.

Replace the NIC.

Diagnostics passes, but 
the workstation does not 
communicate with the 
network.

Network drivers are 
not loaded, or driver 
parameters do not match 
current configuration.

1. Make sure the network drivers 
are loaded and that the driver 
parameters match the 
configuration of the network 
controller.

2. Make sure the correct network 
client and protocol is installed.

The network controller 
is not configured for this 
workstation.

Select the Network icon in the Control 
Panel and configure the network 
controller.

Network controller 
stopped working when 
an expansion board was 
added to the workstation.

Network controller 
interrupt is shared with an 
expansion board.

Under the Computer Setup Advanced 
menu, change the resource settings 
for the board.

The network controller 
requires drivers.

Verify that the drivers were not 
accidentally deleted when the drivers 
for a new expansion board were 
installed.

The expansion board 
installed is a network card 
(NIC) and conflicts with 
the embedded NIC.

Under the Computer Setup Advanced 
menu, change the resource settings 
for the board.

Network controller stops 
working without apparent 
cause.

The files containing the 
network drivers are 
corrupted.

Reinstall the network drivers, using the 
Restore Plus! CD.

The cable is not securely 
connected.

Ensure that both ends of the cable are 
securely attached to the correct 
devices.

The network controller is 
defective.

Replace the NIC.

solving network problems (continued)

problem cause solution
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5.6.12  solving memory problems

Ä
CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-ECC 
memory. Otherwise, the system will not boot the operating system.

New network card will 
not boot.

New network card may be 
defective or may not meet 
industry-standard 
specifications.

Install a working, industry-standard 
NIC, or change the boot sequence to 
boot from another source.

Cannot connect to 
network server when 
attempting Remote 
System Installation.

The network controller is 
not configured properly.

Verify Network Connectivity, that a 
DHCP Server is present, and that the 
Remote System Installation Server 
contains the NIC drivers for your NIC.

System setup utility 
reports unprogrammed 
EEPROM.

Unprogrammed EEPROM. Flash the ROM.

solving network problems (continued)

problem cause solution

solving memory problems 

problem cause solution

System will not boot or 
does not function properly 
after installing additional 
memory modules.

Memory module is not 
the correct type or 
speed or the new 
memory module is not 
seated properly.

Replace module with the correct 
industry-standard device for the 
workstation.

On some models, ECC and non-ECC 
memory modules cannot be mixed.

Out of memory error. Memory configuration 
may not be set up 
correctly.

Use the Device Manager to check 
memory configuration.

You have run out of 
memory to run the 
application.

Check the application documentation 
to determine the memory requirements.

Memory count during POST 
is wrong.

The memory modules 
may not be installed 
correctly.

Check that the memory modules have 
been installed correctly and that 
proper modules are used.

Insufficient memory error 
during operation.

Too many Terminate 
and Stay Resident 
programs (TSRs) are 
installed.

Delete any TSRs that you do not need.

You have run out of 
memory for the 
application.

Check the memory requirements for 
the application or add more memory 
to the workstation.
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5.6.13  solving processor problems
.

5.6.14  solving CD-ROM and DVD problems

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the workstation 
beeps five times.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. 
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory with 

HP memory.
4. Replace the system board.

solving memory problems (continued)

problem cause solution

solving processor problems

problem cause solution

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
workstation is not blocked.

2. Make sure the fans are connected 
and working properly (some fans 
only operate when needed).

3. Make sure the processor heatsink 
is installed properly.

Power LED is Red and 
stays on.

Processor is not seated 
properly or not 
installed.

1. Check to see that the processor is 
present.

2. Reseat the processor.

solving CD-ROM and DVD problems 

problem cause solution

System will not boot from 
CD-ROM or DVD drive.

The CD-ROM or DVD 
boot is not enabled 
through the Computer 
Setup utility.

Run the Computer Setup utility and 
enable booting to removable media 
and verify boot order settings.

Non-bootable CD in 
drive.

Try a bootable CD in the drive.

CD-ROM or DVD devices 
are not detected or driver is 
not loaded.

Drive is not connected 
properly or not properly 
configured.

1. Reconnect power and data cables 
to the drive.

2. Install correct device driver.

Movie will not play in the 
DVD drive.

Movie may be 
regionalized for a 
different country.

See the documentation that came with 
the DVD drive.

Decoder software is not 
installed.

Install decoder software.
hp workstation xw4100 service and technical reference guide 5–39



system diagnostics and troubleshooting
5.6.15  solving DiskOnKey problems

Cannot eject compact disc 
(tray-load unit).

Disc not properly seated 
in the drive.

1. Turn off the workstation and 
insert a thin metal rod into the 
emergency eject hole and push 
firmly. 

2. Slowly pull the tray out from 
the drive until the tray is fully 
extended, then remove the disc.

CD-ROM, CD-RW, 
DVD-ROM, or DVD-R/RW 
drive cannot read a disc 
or takes too long to start.

CD has been inserted 
upside down.

Re-insert the CD with the label 
facing up.

The DVD-ROM drive 
takes longer to start 
because it has to 
determine the type of 
media played, such as 
audio or video.

Wait at least 30 seconds to let the 
DVD-ROM drive determine the type of 
media being played. If the disc still 
does not start, read the other solutions 
listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD 
cleaning kit.

Windows does not 
detect the CD-ROM or 
DVD-ROM drive.

1. Use Device Manager to remove or 
uninstall the device in question.

2. Restart the workstation and let 
Windows detect the device.

Recording audio CDs is 
difficult or impossible.

Wrong or poor quality 
media type.

1. Try using a slower recording 
speed.

2. Verify that you are using the 
correct media for the drive.

3. Try a different brand of media. 
Quality varies widely between 
manufacturers.

solving CD-ROM and DVD problems (continued)

problem cause solution

solving DiskOnKey problems

problem cause solution

DiskOnKey is not seen as a 
drive letter in Windows XP.

The drive letter after the 
last physical drive is not 
available.

Change the default drive letter for the 
DiskOnKey in Windows XP.

The workstation boots to 
DOS after making a 
bootable DiskOnKey.

DiskOnKey is bootable. Install the DiskOnKey after the 
operating system boots.
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5.6.16  solving Internet access problems

solving internet access problems 

problem cause solution

Unable to connect to the 
Internet.

Internet Service Provider 
(ISP) account is not set 
up properly.

Verify Internet settings or contact the 
ISP for assistance.

Modem is not set up 
properly.

Reconnect the modem. Verify the 
connections are correct using the quick 
setup documentation.

Web browser is not set 
up properly.

Verify that the Web browser is 
installed and set up to work with 
your ISP.

Cable/ DSL modem is 
not plugged in.

Plug in cable/DSL modem. You should 
see a “power” LED light on the front of 
the cable/DSL modem.

Cable/DSL service is 
not available or has 
been interrupted due to 
bad weather.

Try connecting to the Internet at a 
later time or contact your ISP. (If the 
cable/DSL service is connected, the 
“cable” LED light on the front of the 
cable/DSL modem will be on.)

The CAT5 10/100 
cable is disconnected.

Connect the CAT5 10/100 cable 
between the cable modem and the 
workstations’s RJ-45 connector. (If the 
connection is good, the “PC” LED light 
on the front of the cable/DSL modem 
will be on.)

IP address is not 
configured properly.

Contact the ISP for the correct IP 
address.

Cookies are corrupted. Windows 2000
1. Select Start > Settings > Control 

Panel.
2. Double-click Internet Options.
3. On the General tab, click the 

Delete Cookies button.
Windows XP
1. Select Start > Control Panel.
2. Double-click Internet Options.
3. On the General tab, click the 

Delete Cookies button.

Cannot automatically 
launch Internet programs.

You must log on to the 
ISP before some 
programs will start.

Log on to the ISP and launch the 
desired program.
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Internet takes too long to 
download Web sites.

Modem is not set up 
properly.

Verify that the correct modem speed 
and COM port are selected.
For Windows 2000
Select Start > Settings > Control Panel.
Continue with step #2.
For Windows XP
1. Select Start > Control Panel.

Continue with step #2.
2. Double-click System.
3. Click the Hardware tab.
4. In the Device Manager area, click 

the Device Manager button.
5. Double-click Ports (COM & LPT).
6. Right-click the COM port your 

modem uses, then click Properties.
7. Under Device status, verify that the 

modem is working properly.
8. Under Device usage, verify the 

modem is enabled.
9. If there are further problems, click 

the Troubleshoot button and follow 
the on-screen instructions.

solving internet access problems (continued)

problem cause solution
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5.7 Power-On Self-Test (POST) and error messages
POST is a series of diagnostic tests that runs automatically when the system is turned on. An 
audible and/or visual message occurs if the POST encounters a problem. POST checks the 
following items to ensure that the workstation system is functioning properly:

■ Keyboard

■ Memory modules

■ Diskette drives

■ All IDE and SCSI mass storage devices 

■ Processors

■ Controllers

NOTE: If the Power-On Password is set, a key icon appears on the screen while POST is running. 
You will need to enter the password before continuing.

POST error messages  

screen message probable cause recommended action

101-Option ROM Error System ROM checksum. Verify the correct ROM.
Flash the ROM if needed.
If an expansion card was recently added, 
remove it and see if the problem remains. 
Clear CMOS.
If the message disappears, there may be 
a problem with the expansion card.
Replace the system board.

102-System Board 
Failure

DMA, timers, etc. Clear CMOS.
Remove expansion boards.
Replace the system board.

103-System Board 
Failure

DMA, timers, etc. Clear CMOS.
Remove expansion boards.
Replace the system board.

110-Out of Memory for 
Option ROMs

Option ROM for a device was 
unable to run due to memory 
constraints.

Run Computer Setup and enable the 
ACPO/USB Buffers @ Top of Memory under 
the Advanced > Power-On option.

150-SafePost Active A PCI expansion card is not 
responding.

Restart the workstation.
Disable SafePost.
If the expansion card does not respond, 
replace the card.
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162-System Options 
Not Set

Configuration incorrect. RTC 
(real-time clock) battery may 
need to be replaced.

Run Computer Setup (F10 Setup).
Set the date and time under Control Panel or 
in F10 Setup depending on the operating 
system.
If the problem persists, replace the RTC 
battery.

163-Time & Date 
Not Set

Invalid time or date in 
configuration memory.
RTC (real-time clock) battery 
may need to be replaced.
CMOS jumper may not be 
properly installed.

Set the date and time under Control Panel or 
in F10 Setup depending on the operating 
system.
If the problem persists, replace the RTC 
battery.

164-Memory Size Error Memory configuration is 
incorrect.

Run Computer Setup (F10 Setup) or Windows 
utilities.
Make sure memory module(s) (if any) are 
installed properly.
If third party memory has been added, test 
using HP-only memory.
Verify proper memory module type.

183-Invalid Processor 
Jumper Setting

System board jumper 
improperly set.

Reset system board jumpers to match 
processor and bus speeds (select models).

201-Memory Error RAM failure. Run Computer Setup (F10 Setup) or Windows 
utilities.
Ensure memory and continuity modules are 
installed correctly.
Verify proper memory module type.
Remove and replace memory module(s) one 
at a time to isolate faulty module.
Replace the faulty memory module(s).
If error persists after replacing memory 
modules, replace the system board.

202-Memory Type 
Mismatch

Memory modules do not 
match each other.

Replace memory modules with matched sets.

207-ECC Corrected 
Single Bit Errors in 
Memory Socket(s) y,y

Single Bit ECC error. Verify proper memory module type.
Try another memory socket.
Replace memory module if problem persists.

212-Failed Processor Processor has failed to 
initialize.

Reseat the processor in its socket.
If the processor does not respond, replace it.

POST error messages (continued) 

screen message probable cause recommended action
5–44 hp workstation xw4100 service and technical reference guide



system diagnostics and troubleshooting
213-Incompatible 
memory Module in 
memory Socket(s) 
X,X, X

A memory module in memory 
socket identified in the error 
message is missing critical 
SPD information, or is 
incompatible with the chipset.

Verify proper memory module type.
Try another memory socket.
Replace memory with a module conforming 
to the SPD standard.

214-DIMM 
Configuration Warning

DIMMs not installed correctly 
(not paired correctly).

Refer to the “ memory” section of Chapter 4 
for the correct memory configurations and 
reseat the DIMMs accordingly.

301-Keyboard Error Keyboard failure. Reconnect keyboard with workstation 
turned off.
Check connector for bent or missing pins.
Ensure that none of the keys are depressed.
Replace keyboard.

303-Keyboard 
Controller Error

I/O board keyboard 
controller.

Reconnect keyboard with workstation 
turned off.
Replace the system board.

304-Keyboard or 
System Unit Error

Keyboard failure. Reconnect the keyboard with workstation 
turned off.
Ensure that none of the keys are depressed.
Replace keyboard.
Replace system board. 

401-Parallel Port 1 
Address Assignment 
Conflict

IRQ address conflicts with 
another device.

Reset the IRQ.

402-Parallel Port 2 
Address Assignment 
Conflict

IRQ address conflicts with 
another device.

Reset the IRQ.

403-Parallel Port 3 
Address Assignment 
Conflict

IRQ address conflicts with 
another device.

Reset the IRQ.

404-Parallel Port 
Address Conflict 
Detected

Both external and internal 
ports are assigned to parallel 
port X.

Remove any parallel expansion cards.
Clear CMOS.
Reconfigure card resources and/or run 
Computer Setup (F10 Setup).

410-Audio Interrupt 
Conflict

IRQ address conflicts with 
another device.

Reset the IRQ.

411-Network Interface 
Card Interrupt Conflict

IRQ address conflicts with 
another device.

Reset the IRQ.

POST error messages (continued) 

screen message probable cause recommended action
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501-Display Adapter 
Failure

Graphics display controller. Reseat the graphics card (if applicable).
Clear CMOS.
Verify that the monitor is attached and 
turned on.
Replace the graphics controller.

510-Splash Screen 
image corrupted

Splash Screen image has 
errors.

Install latest version of ROMPaq to restore 
image.

511-CPU, CPUA, or 
CPUB Fan not detected

Fan is not connected or may 
have malfunctioned.

Reseat fan cable.
Reseat the fan.
Replace the fan.

512-Chassis, rear 
chassis, or front chassis 
fan not detected

Fan is not connected, may 
have malfunctioned.

Reseat chassis, rear chassis, or front chassis 
fan cable.
Reseat chassis, rear chassis, or front 
chassis fan.
Replace chassis, rear chassis, or front 
chassis fan.

514-CPU or Chassis 
Fan not detected.

CPU fan is not connected or 
may have malfunctioned.

Reseat CPU or chassis fan.
Replace CPU or chassis fan.

601-Diskette Controller 
Error

Diskette controller circuitry or 
diskette drive circuitry 
incorrect.

Run Computer Setup (F10 Setup).
Check and/or replace cables.
Clear CMOS.
Replace diskette drive.
Replace the system board.

602-Diskette Boot 
Record Error

Diskette in drive A not 
bootable.

Replace the diskette.

605-Diskette Drive Type 
Error

Mismatch in drive type. Run Computer Setup (F10 Setup).
Disconnect any other diskette controller 
devices (tape drives).
Clear CMOS.

610-External Storage 
Device Failure

External tape drive not 
connected.

Reinstall tape drive or press F1 and allow 
system to reconfigure without the drive.

611-Primary Diskette 
Port Address 
Assignment Conflict

Configuration error. Run Computer Setup (F10 Setup).
Remove expansion cards.
Clear CMOS.

612-Secondary Diskette 
Port Address 
Assignment Conflict

Configuration error. Run Computer Setup (F10 Setup).
Remove expansion cards.
Clear CMOS.

POST error messages (continued) 

screen message probable cause recommended action
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660-Display Cache is 
Detected Unreliable

Integrated video controller 
display cache not working 
properly and will be disabled.

Replace system board if minimal video 
degrading is an issue.

912-Computer Cover 
Has Been Removed 
Since Last System Start 
Up

No action required.

914-Hood Lock Coil is 
not Connected

Solenoid hood cover lock 
mechanism is missing or not 
connected.

Reconnect or replace hood locking 
mechanism.
Reseat or replace hood locking mechanism 
cable.

916-Thermal Sensor 
from Processor Heatsink 
is not Connected.

Processor heatsink cable not 
connected to system board.

Reseat or replace the processor heatsink cable 
going to the system board.

917-Expansion Riser not 
Detected

Riser board not seated or not 
installed.

Install riser board if missing or remove and 
reseat to ensure good connection.

919-Front Panel, 
MultiPort risers not 
Detected.

Riser card has been removed 
or has not been reinstalled 
properly in the system.

Unplug workstation and install/reinstall 
riser cord.

1151-Serial Port 1 
Address Conflict 
Detected

Both external and internal 
serial ports are assigned 
to COM1.

Remove any Comm port expansion cards.
Clear CMOS.
Reconfigure card resources and/or run 
Computer Setup (F10 Setup). Run Computer 
Setup or Windows utilities.

1152-Serial Port 2 
Address Conflict 
Detected

Both external and internal 
serial ports are assigned 
to COM2.

Remove any Comm port expansion cards.
Clear CMOS.
Reconfigure card resources and/or run 
Computer Setup (F10 Setup). Run Computer 
Setup or Windows utilities.

1155-Serial Port 
Address Conflict 
Detected

Both external and internal 
serial ports are assigned to 
same IRQ.

Remove any Comm port expansion cards.
Clear CMOS.
Reconfigure card resources and/or run 
Computer Setup (F10 Setup). Run Computer 
Setup or Windows utilities.

1201-System Audio 
Address Conflict 
Detected

Device IRQ address conflicts 
with another device.

Reset the IRQ.

1202-MIDI Port Address 
Conflict Detected

Device IRQ address conflicts 
with another device.

Reset the IRQ.

1203-Game Port 
Address Conflict 
Detected

Device IRQ address conflicts 
with another device.

Reset the IRQ

POST error messages (continued) 
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1720 SMART Hard 
Drive Detect Imminent 
Failure

Hard drive is about to fail. 
(Some hard drives have a 
firmware patch that will fix an 
erroneous error message.)

Determine if hard drive is giving correct error 
message. Run the Drive Protection System test 
if applicable.
Apply firmware patch if applicable. 
(see www.hp.com/support)
Back up contents and replace hard drive.

1782-Disk Controller 
Failure

Hard drive circuitry error. Run Computer Setup (F10 Setup).
Clear CMOS.
Check cable seating/jumper settings.
Run hard drive diagnostics.
Disconnect additional drives.
Run the Drive Protection System test 
if available.
Check www.hp.com\support\ 
techpubs\customer_advisories for possible 
changes when using Windows NT4.0 Service 
Pack 4.
Replace the hard drive.
Replace the system board.

1793-Secondary 
Controller or Disk 
Failure

Hard drive circuitry error. Run Computer Setup (F10 Setup).
Clear CMOS.
Check cable seating/jumper settings.
Run hard drive diagnostics.
Disconnect additional drives.
Run the Drive Protection System test 
if available.
Replace the hard drive.

1800-Temperature Alert Internal temperature exceeds 
specification.

Check that workstation air vents are not 
blocked and cooling fan is running.
Verify processor speed selection.
Replace the processor.
Replace the system board.

1801-Microcode Patch 
Error

Processor not supported by 
ROM BIOS.

Upgrade BIOS to proper version.

1998-Master Boot 
Record has been lost.

The previously saved copy of 
the MBR has been corrupted.

Run Computer Setup and save the MBR of the 
current bootable disk.

POST error messages (continued) 
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1998-Master Boot 
Record has been 
changed.

The current MBR does not 
match the previously saved 
copy of the MBR.

Use extreme caution, The MBR may have been 
updated due to normal disk maintenance 
activities (disk manager, fdisk, or format). 
Replacing the previously saved MBR in such 
situations can cause data loss. If certain 
that the MBR change is unintentional and 
undesired (e.g. due to a virus), run Computer 
Setup and restore the previously saved MBR 
copy. Otherwise, run Computer Setup and 
either disable MBR security or save the MBR 
of the current bootable disk.

2000-Master Boot 
Record Hard Drive has 
Changed.

The current bootable hard 
drive is not the same as the 
one that was present when 
MBR security was enabled.

Run Computer Setup and either disable MBR 
security or save the MBR of the current 
bootable disk.

Invalid Electronic Serial 
Number.

Electronic serial number has 
become corrupted.

Run Computer Setup. If Setup already has 
data in the field or will not allow the serial 
number to be entered, download from 
http://www.hp.com and run SP5572.EXE 
(SNZERO.EXE).
Run Computer Setup and try to enter serial 
number under Security, System ID, then save 
changes.

ECC Multiple Bit Error 
Detected in Memory 
Module.

Chipset has detected more 
than one bad bit in a 64-bit 
quadword of the memory 
array.

Replace the memory module.

Parity Check 2. Parity RAM failure. Run Computer Setup and Diagnostic utilities.

POST error messages (continued) 
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5.8 Remote Diagnostics Enabling Agent
This utility provides a Web browser interface to Diagnostics for Windows. It enables remote 
control of the diagnostics and facilitates easy transfer of workstation information from remote 
machines to a service provider.

The Remote Diagnostics Enabling Agent captures hardware configuration and provides the 
ability to perform tests remotely to diagnose workstation problems. In addition, the Remote 
Diagnostics Enabling Agent identifies any workstation hardware device problems signaled by the 
HP Management Agents. These hardware devices are automatically selected for testing by the 
Remote Diagnostics Enabling Agent.

NOTE: The Remote Diagnostics Enabling Agent only works if Diagnostics for Windows is also 
installed. 
 
The Remote Diagnostics Enabling Agent is pre-loaded on some workstations and is available 
through a SoftPaq at http://www.hp.com under Support and Drivers.

5.8.1 installing or upgrading Remote Diagnostics 
Enabling Agent

1. Visit http://www.hp.com/support/files and click on the applicable product.

2. Locate the appropriate software and download the latest version.

3. Execute the downloaded file. If you are upgrading an existing version, select Repair for the 
new version to overwrite the old version.

5.8.2 running the Remote Diagnostics Enabling Agent
Select the Remote Diagnostics icon located in the Control Panel.

NOTE: The Remote Diagnostics Enabling Agent allows you to run Diagnostic Test or the 
Configuration Record in a browser window. Both of these utilities can be run remotely or locally.

To exit Remote Diagnostics, click File and then click Close.
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A
Ultra ATA drive guidelines and features

Ultra ATA jumpers
Ultra ATA drives are configured by means of jumper settings. Factory-installed drives ship with 
the jumpers preset to the cable-select mode; therefore, no jumper setting changes are required on 
factory preinstalled, replacement, or option drives. With cable-select, the drive is configured as 
either Master (Drive/Device 0) or Slave (Drive/Device 1) by its physical attachment to the cable. 

If you purchase a third-party hard drive, refer to the documentation included with the drive kit to 
ensure proper cable installation and configuration.

NOTE: All drives on a controller channel need to have their jumpers either in the cable-select 
mode or have the individual drive jumper installed on the appropriate Master (Drive/Device 0) or 
Slave (Drive/Device 1) position.

Ultra ATA cables
When installing a second device on either the primary or secondary controller, you must use an 
industry standard 80-conductor Ultra ATA cable for optimal performance. These cables have a 
maximum length of 18 inches and a maximum distance of 6 inches between the two devices for a 
two-drive cable.

Drives operating at speeds faster than those of the Ultra ATA-33 devices require 
industry-standard 40-pin, 80-conductor cables to maintain the higher data transfer rates possible 
with the improved technology.

When using Ultra ATA-133, -100, -66, and slower -33 drives in the same system, each drive will 
operate at its appropriate data transfer rate.

cable layout
The faces of industry-standard cable connectors are color coded for easy recognition:

■ System board connector = blue face

■ Device 0 connector = black face

■ Device 1 connector = gray face

NOTE: The color code of an industry-standard cable is valid only if the drive’s jumper is in the 
cable-select position.
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Ultra ATA drive guidelines and features
single-drive cable

two-drive cable

On a two-drive cable, the Drive/Device 0 connector is always the farthest one from the system 
board connector and the Drive/Device 1 connector is always the closest to the system board 
connector.

NOTE: Some cables may be labeled “Drive 0” instead of “Device 0” and “Drive 1” instead of 
“Device 1”.

drive installation guidelines
Most workstation system boards have two ATA (IDE) controller channels with a dedicated 
connector for each controller. One controller is designated as the primary and the other as the 
secondary controller.

Each of the two controllers can have up to two devices attached to it. Each workstation system 
may therefore have a maximum of four ATA/ATAPI drives. All drives are connected to these 
controllers using an industry-standard 80-conductor cable.

NOTE: The industry standard 1.44 MB diskette drive has its own separate channel and is not 
included as a part of the maximum four drives.

Any drive attached to a controller must have a drive designation. If only a single drive is 
connected to a controller and its jumper is in the cable-select position, it is designated as the 
Master Drive (Drive/Device 0) by its attachment to the Drive/Device 0 cable position. If two 
cable-selected drives are connected to a single controller, one will be designated by its 
attachment to the cable as the Master (Drive/Device 0) and the other as Slave (Drive/Device 1).

For optimal performance of a workstation system, all drives need to be attached to the ATA 
controllers in a specified sequence. This sequence is determined by the device class of the drives 
and by specific attach sequence rules.

System 
Board

Device 0
(master)

Black 
Face

Blue 
Face

System 
Board

Device 1
(slave)

Device 0
(master)

Black 
Face

Blue 
Face

Gray 
Face
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Ultra ATA drive guidelines and features
device classes
In order to determine the best drive attach sequence, ATA/ATAPI drives are segregated into four 
different classes based upon the bandwidth demands they place on an ATA controller. The most 
demanding devices are in Class 1 and the least demanding are in Class 4.

general attach guidelines
■ The lower the device class number, the faster the device and the more bandwidth required.

■ Drives installed in the Device 0 positions on both the primary and secondary controllers 
receive the greatest possible bandwidth.

■ The bootable ATA hard drive should always be installed on the primary controller in the 
Device 0 position.

attach sequence rules by class priority
Drives should be attached in the sequence shown for optimum performance starting at 
position 1.

*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary controller first before following the General Attach Sequence Rule.

class 1 
hard  
drives

class 2 
high speed 
optical drives

class 3 
optical storage 
drives

class 4 
magnetic 
storage drives

ATA-100
ATA-66
ATA-33

DVD
DVD-CD R/W

R/W CD-ROM
CD-ROM 

LS-120
Tape
Zip 

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
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Ultra ATA drive guidelines and features
The attach sequence rule may also be stated in table format:

The rules allow for:

■ Keeping the hard drive on a separate controller channel maximizes drive performance until a 
fourth device is added.

■ Keeping the hard drives and removable media drives on separate controller channels 
maximizes compatibility.

■ Keeping the hard drive and the writable optical drive on separate controller channels 
maximizes optical drive reliability.

attach sequence worksheet
Use the worksheet below for obtaining optimum system performance when setting up a 
workstation with multiple drives. Use the General Attach Sequence Rule to determine the best 
drive installation sequence.

Two examples of how to use the worksheet are:

■ Three device installation

■ Four device installation

general attach sequence rule*

sequence description

1 The lowest class drive – bootable hard drive recommended.

2 If only two drives, the last drive goes here; otherwise the lowest class of the 
remaining drives.

3 If only three drives, attach the final drive here. If a fourth drive exists, attach the 
lowest class drive here.

4 If there is a fourth drive, attach the final drive here - the drive with the highest 
class number of all devices.

*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary controller first before following the General Attach Sequence Rule.

attach sequence worksheet

device name
device 
class

position 
number

controller 
name

device 
number
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Ultra ATA drive guidelines and features
example 1: three device installation sample
A system has three devices: Ultra ATA-100 hard drive, CD-ROM drive, and a DVD drive. Using 
the Device Class Table in Section 4.3.1, the devices may be identified as:

■ Ultra ATA-100 hard drive = Class 1

■ DVD drive = Class 2

■ CD-ROM drive = Class 3

attach sequence worksheet – three device installation (sample)

device name
device 
class

position 
number

controller 
name

device 
number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD drive 2 2 Secondary 0

CD-ROM drive 3 3 Secondary 1

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
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Ultra ATA drive guidelines and features
example 2: four device installation sample
A system has four devices: Ultra ATA-100 hard drive, Ultra ATA-100 hard drive, DVD-CDR/W 
drive, and a ZIP-250 drive. Using the Device Class Table in Section 4.3.1, the devices may be 
reidentified as:

■ Ultra ATA-100 hard drive = Class 1

■ Ultra ATA-100 hard drive = Class 1

■ DVD-CDR/W drive = Class 2

■ ZIP-250 drive = Class 4

*If there are three or more devices, two or more of which are hard drives, two hard drives should 
be attached to the primary controller first before following the General Attach Sequence Rule.

additional drive application notes
■ When replacing a hard drive, the replacement should be of the same type (Ultra ATA -33, 

-66, or -100) as that being removed to retain the same level of performance.

■ When Ultra ATA and SCSI hard drives are mixed in the same system, the Ultra ATA drive 
will become the boot drive unless the boot order is changed in Computer Setup (F10).

attach sequence worksheet – four device installation (sample)

device name
device 
class

position 
number

controller 
name

device 
number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD-CDR/W drive 2 2 Secondary 0

ZIP-250 drive 4 3 Secondary 1

Ultra ATA-100 hard drive* 1 4 Primary 1

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
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SMART
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for HP 
workstations have built-in drive failure prediction that warns the user or network administrator of 
an impending failure or crash of the hard drive. The SMART drive tracks fault prediction and 
failure indication parameters such as reallocated sector count, spin retry count, and calibration 
retry count. If the drive determines that a failure is imminent, it generates a fault alert.

jumpers
The specifications included below are the standard drive configurations.

CD-ROM or DVD-ROM drive

C S M
S L A

C S M
S L A

C S M
S L A

Use CSEL Slave Master
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Ultra ATA drive guidelines and features
Zip drive

NOTE: After changing the jumper settings, reboot the workstation to recognize the new address.

drive capacities
The combination of the file system and the operating system used in the workstation determines 
the maximum usable size of a drive partition. A drive partition is the largest segment of a drive 
that may be properly accessed by the operating system. A single hard drive may therefore be 
subdivided into a number of unique drive partitions in order to make use of all of its space.

The table that follows identifies the capabilities and restrictions imposed on the workstation by 
the combinations of file and operating systems.

jumper settings

configuration pair 1 pair 2 pair 3

Device 0 (Master) jumper

Device 1 (Slave)

Cable Select (Default) jumper

microsoft to drive manufacturer size conversion table*

drive size as identified by microsoft 
operating system

drive size as identified by  
drive manufacturers

2 GB 2.1 GB

4 GB 4.3 GB

32 GB 34.4 GB

*Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by 
Microsoft are bytes to the base 2.
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Ultra ATA drive guidelines and features
64 GB 68.7 GB

128 GB 137 GB

2 TB 2.199 TB

drive/partition capacity limits

maximum size

file 
system

controller 
type operating system

 
partition drive 

FAT 32 ATA Windows 2000/ XP 32 GB 128 GB

FAT 32 SCSI Windows 2000/ XP 32 GB 2 TB

NTFS ATA Windows 2000/XP 128 GB 128 GB

NTFS SCSI Windows 2000/XP 2TB 2TB

microsoft to drive manufacturer size conversion table*

drive size as identified by microsoft 
operating system

drive size as identified by  
drive manufacturers

*Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by 
Microsoft are bytes to the base 2.
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B
SCSI Devices

SCSI guidelines

NOTE: These systems support a mixed configuration of UATA/IDE and SCSI hard drives. In a 
mixed configuration the UATA/IDE drive must be specified as the boot drive.

When installing and operating SCSI devices, you must follow these guidelines:

■ A narrow (50-pin) SCSI controller allows you to daisy-chain up to 7 additional SCSI 
devices. Counting the controller, that amounts to 8 total SCSI devices.

■ A wide (68-pin) SCSI controller allows you to daisy-chain up to 15 additional SCSI devices. 
Counting the controller, that amounts to 16 total SCSI devices.

■ If two narrow (50-pin) SCSI controllers are each connected to separate system board SCSI 
connectors, each controller may have seven SCSI devices attached. Counting the controller, 
this gives a total of 16 SCSI devices on the system.

■ HP does not recommend mixing different width SCSI devices on the same SCSI chain or on 
the same SCSI channel. Mixing devices of different widths on the same chain or channel will 
always result in a data transfer rate of the slowest machine in that chain. The only exception 
to this is that Ultra Wide SCSI devices will cause a speed degradation when mixed with other 
68-pin devices.

■ If multiple SCSI devices are used, split the devices between Channels A and B for optimum 
performance. Cable length for the second channel should not be longer than 18 inches.

■ If two controllers are used, each may use SCSI devices having widths and speeds different 
from the other. If a 68-pin data cable is used on a controller having 50-pin SCSI devices, use 
an internal cable adapter or an external cable adapter. 

Ä
CAUTION: Do not route data cables near the air intake to the power supply. Cables routed in this 
manner may block the airflow and cause the workstation to overheat.

■ All SCSI controllers require a unique SCSI ID (0-7 or 8-15) for each SCSI device installed. 
The controller identifies a SCSI device by its SCSI ID number rather than its location. 
Moving a SCSI device from one position to another on the SCSI chain does not affect 
communication between the controller and the device. The reserved and available SCSI ID 
numbers for SCSI devices are:

❏ 0 is reserved for the primary hard drive.

❏ 7 is reserved for the SCSI controller.

❏ 1 through 6 and 8 through 15 are available for all other SCSI devices.

■ 68-pin SCSI controllers require a 53 inch maximum length-twisted pair, LVD cable with 
built-in terminator, maximum of 5 drives with a minimum driving spacing of 5.25 inches.
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SCSI Devices
■ Every SCSI chain or circuit must be terminated (closed) at both ends. Some system boards 
have both ends of the SCSI cable connected to, and terminated by, the system board. 
Termination can be accomplished in one of several ways:

❏ Use a cable with a built-in terminator.

❏ Use a cable with a terminating resistor plug in the last connector.

❏ Connect a SCSI device with its termination enabled into the last connector.

❏ Connect an external SCSI device with its termination enabled to the external SCSI 
connector on the rear panel of the workstation.

■ Turn on all external SCSI devices before turning on the power to the workstation. This 
enables the SCSI controller to recognize the external devices.

using the Multi-Mode SCSI cable
Some products ship standard with a multi-mode SCSI cable having a terminator 1 on one end. 
This cable supports both low voltage differential (LVD) and single ended (SE) devices. One end 
of the cable connects to the internal LVD/SE connector on the system board, with the remaining 
connectors used on the hard drives.

NOTE: The multi-mode cable included with the workstation may differ from the one pictured.

For additional information about installing optional SCSI devices, refer to the documentation 
included with the device option kit.

1
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SCSI Devices
using SCSISelect with SCSI devices
The Ultra160 and faster SCSI host adapters include the SCSISelect utility to configure the host 
adapter and to run the SCSI disk utilities. To run the SCSISelect utility:

■ In POST Messages Enabled mode: Press Ctrl+A when the “Press<Ctrl><A> for SCSISelect 
Utility” message appears during POST.

■ In POST Messages Disabled mode: When the HP logo screen appears, press any key to exit 
the logo screen. Immediately after exiting the logo screen, press Ctrl+A to access the 
SCSISelect utility.

A menu appears with the following options:

■ Configure/View Host Adapter Settings

❏ SCSI Bus Interface Definitions

◆ Host Adapter SCSI ID

◆ SCSI Parity Checking

◆ Host Adapter SCSI Termination

❏ Additional Options

◆ Boot Device Options

◆ SCSI Device Configuration

◆ Advanced Configuration Options

■ SCSI Disk Utilities

❏ Lists all SCSI devices and SCSI ID numbers

NOTE: For additional information about configuring POST message display status, refer to the 
“Computer Setup menu” section in this guide.

SMART
The Self Monitoring Analysis and Reporting Technology (SMART) IDE and SCSI hard drives 
for HP workstations have built-in drive failure prediction that warns the user or the network 
administrator of an impending failure or crash of the hard drive. SMART drives track fault 
prediction and failure indication parameters such as re-allocated sector count, spin retry count, 
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault 
alert.
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SCSI Devices
jumpers
The specifications included below are the standard drive configurations. 

U320 SCSI hard drive

1. Drive intended only for non-pluggable applications. Migration to a 
hot-pluggable drive tray is not supported.

2. All jumper and switch settings shown in the factory default setting, including 
those not labeled.

3. Termination is disabled/removed.

NOTE: After changing the jumper settings, reboot the workstation to recognize the new address.

SCSI ID settings

SCSI ID bit 2 bit 1 bit 0

0

1 jumper

2 jumper

3 jumper jumper

4 jumper

5 jumper jumper

6 jumper jumper

default settings

signal description jumper

S Start unit command 
enabled

P Parity enabled jumper

W Write protect disabled

X Switch data transfer 
enabled

jumper
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C
SATA Devices

SATA guidelines

NOTE: These systems support a mixed configuration of UATA/IDE, SCSI, and SATA hard drives. 
Review the following diagram and table to determine the correct drive configuration for your 
system.

When installing and operating SATA devices, you must follow these guidelines:

■ Use the SATA data cables with the 90 degree connector (326965-001) for the hard drive 
bays. The 90 degree connector goes to the hard drive. 

■ Use the longest data cable with the straight connectors (326965-002) if installing a hard drive 
in an optical bay.

■ Connect the 4-2 pin LED cable (225537-001, included with SATA RAID controller kit) from 
the RAID card header “JP1” (4 pin header) to the system board header labeled “SCSI LED” 
(2 pin header).

Ä
CAUTION: Do not route data cables near the air intake to the power supply. Cables routed in this 
manner may block the airflow and cause the workstation to overheat.
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SATA Devices
boot order
The following flow diagram shows the boot order of hard drives (C:) connected to the different 
controllers in the workstation system.

You can modify the boot order in the Computer Setup Utility by arranging the Controller Order 
on the Storage tab.

The diagram does not show other bootable device options such as a diskette, CD-ROM, USB, 
network, and so on. In the Computer Setup Utility, you can arrange the boot order on the Storage 
tab.
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SATA Devices
hard drive configurations
The following table presents common physical hard drive configurations for the HP workstation 
xw4100. Many other possible different configurations are not listed in the table, but for optimal 
performance and disk space usage, the following configurations are recommended.

*Part of logical hard drive in a RAID array.

** This could be part of logical hard drives in a RAID array or stand alone physical drive.

NOTE: The first hard drive bay is the recommended position for the drive containing the bootable 
OS.  
 
For systems with bootable RAID array, the bootable logical drive can exist on multiple physical 
hard drives. SATA plug-in Controller is only recommended for RAID purposes. 

First Hard Drive Bay Second Hard Drive Bay Third Hard Drive at 
Optical Bay

IDE/SATA/SCSI (plug in 
Controller)

empty empty

IDE/SATA/SCSI (plug in 
Controller)

IDE empty

IDE/SATA/SCSI (plug in 
Controller)

IDE IDE

IDE/SATA/SCSI (plug in 
Controller)

SATA empty

IDE/SATA/SCSI (plug in 
Controller)

SATA SATA

IDE/SATA/SCSI (plug in 
Controller)

SATA (plug-in Controller)* SATA (plug-in Controller)*

IDE/SATA/SCSI (plug in 
Controller)**

SCSI (plug-in Controller)** empty

IDE/SATA/SCSI (plug in 
Controller)**

SCSI (plug-in Controller)** SCSI (plug-in Controller)**

SCSI (plug-in Controller)** SCSI (plug-in Controller)** IDE

SCSI (plug-in Controller)** SCSI (plug-in Controller)** SATA

SATA (plug-in Controller)* SATA (plug-in Controller)* empty

SATA (plug-in Controller)* SATA (plug-in Controller)* SATA (plug-in Controller)*

SATA (plug-in Controller)* SATA (plug-in Controller)* IDE 

SATA (plug-in Controller)* SATA (plug-in Controller)* SCSI (plug-in Controller)
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D
system board and riser board 

reference designators

These reference designators are used on most but not all hp system and riser boards.

designator component 

BT1 
CR1 
CR2 
CR3 
CR11

Battery socket/Battery 
LED - 3.3V Aux 
LED - Power button press 
LED - PS_ON (off), 5.5V Aux (on) 
CPU reset LED

CR34 
CR35 
E14 
E49 
E50

Power ON LED 
Hard drive activity LED 
Boot block header/jumper 
Clear Password header/jumper 
Clear CMOS header

H5 
J6 
J7 
J8

RTC clock crystal/Tie-down 
BNC 
RJ-45 Jack 
IEEE 1394

J9 
J10 - 19 
J20 - 29 
J30 
J31 - J35

Stacked RJ45/Dual USB connector 
ISA slots 
PCI slots 
Riser board socket 
Device Bay connectors

J36 
J37 
J38 
J39 
J40

AC97 connector 
Primary SCSI connector 
Secondary SCSI connector 
Stacked parallel/SCSI connector 
AGP slot

J50 
J51 
J52 
 

First parallel port 
Second parallel port 
Double-stacked parallel port 
Top Port B 
Bottom Port A

J53 
J54 
J55 
J65 
J66 
J67

Parallel port over single Serial Port 
Parallel port over Serial Port and Video Port 
Parallel port over dual VGA ports 
DVI connector 
Keyboard connector (Closest to power supply) 
Mouse connector
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system board and riser board reference designators
J68 
 
 
J69 
J70

Double-stacked mouse/keyboard connector 
Top      Mouse 
Bottom  Keyboard 
Video connector 
Primary single USB connector

J71 
J72 
J73 
J74 
J75

Secondary single USB jack 
Microphone jack 
Line-in jack 
Line-out jack 
Headphone jack

J76 
J77 
 

Volume control 
Double-stacked headphone/microphone connector 
Top Microphone 
Bottom Headphone

J78 
 
 
J80

Double-stacked line-in/line-out connector 
Top Line in 
Bottom Line out 
Stacked serial/audio connector

J81 
 
 
J82 
 

Primary double-stack USB 
Top Port 2 
Bottom Port 1 
Secondary double-stack USB 
Top Port 4 
Bottom Port 3

J83 
J101 
J113 
JP49 
L1

Triple-stacked audio jack (line in, line out/headphone, microphone) 
Security board connector for security card 
Video cache connector 
Clear password header/jumper 
USB front port choke

L2 
L3 
L4 
P1

USB rear port choke (1st) 
USB rear port choke (2nd) 
USB rear port choke (3rd) 
P/S connector

P2 
P3 
P5 
P6

Second P/S connector (as required) 
VCCP 12V header  
Main Power/HDD LED connector  
Speaker connector

P7 
P8 
P9 
P10 
P11

Audio connector (from CD-ROM) 
Primary chassis fan connector 
Wake on LAN (WOL) connector (NIC cable) 
Diskette drive connector 
Second Audio connector

P12 
P15 
P16 
P20 
P21

Alert on LAN NIC connector 
AUI connector 
Fan command/fan sink header 
Primary IDE connector 
Secondary IDE connector

designator component (continued)
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system board and riser board reference designators
P22 
P23 
P24 
P25 - P26

Slimline CD-ROM connector 
Header for front audio panel 
Header for front panel USB 
Video memory upgrade connector

P29 
P30 
P31 
P50 
P52

SCSI LED connector 
Primary serial ATA (SATA) port 
Secondary serial ATA (SATA) port 
Serial debug header 
Serial port header

P53 
P54 
P55 
 

First serial port 
Second serial port 
Double stack serial port 
Top            Serial B 
Bottom        Serial A

P58 
P64 
P65 
P70 
P71

Riser edge connector (male-mates with J30) 
VSFF expansion connector 
Graphics option connector 
Primary (CPU) fan header for fansink 
Secondary CPU fan header for fansink

P89 
P100 
P101 
P120 
P124

Floating serial port /COM port header 
ITP connector 
Security card connector, system board 
Secondary chassis fan header 
Hood lock header

P125 
P216 
SW1 
SW2 
SW50

Hood sensor header 
White box chassis fan 
Processor speed switch 
Security hood switch 
Clear CMOS switch/push button

SW51 
SW52 
U15 
U100
XBT1

Power button switch 
System reset switch 
ROM chip 
Security chip 
Battery socket

XMM1 
XMM2 - XMM5 
XU1 
XU2 
XU15

Memory slot. DIMM1 or RIMM1 populated and tested 
Following memory slots 
Primary processor socket Secondary processor socket 
ROM socket 
ROM socket

XU100 
Y1 
Y2 
Y3 
Y4 
Y5

Security chip socket 
Primary (TH) system clock crystal 
Secondary (SMT) system clock crystal 
Primary (YTH) NIC clock crystal 
Secondary (SMT) NIC clock crystal 
RTC clock crystal/tie-down

designator component (continued)
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E
connector pin assignments

This appendix contains the pin assignments for many workstation connectors. Some of these 
connectors may not be used on the product being serviced.

enhanced keyboard

mouse

Ethernet RJ-45

connector and icon pin signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

connector and icon pin signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

connector and icon pin signal

1 
2 
3 
4

(+) Transmit Data 
(-) Transmit Data 
(+) Receive Data 
Unused

5 
6 
7 
8

Unused 
(-) Receive Data 
Unused 
Unused
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connector pin assignments
parallel interface

serial interface

USB

connector and icon

pin signal pin signal pin signal

1 
2 
3

Strobe 
Data Bit 0 
Data Bit 1

7 
8 
9

Data Bit 5 
Data Bit 6 
Data Bit 7

13 
14 
15

Select 
Auto Linefeed 
Error

4 
5 
6

Data Bit 2 
Data Bit 3 
Data Bit 4

10 
11 
12

Acknowledge 
Busy 
Paper End

16 
17 
18-25

Initialize Printer 
Select IN 
Signal Ground

connector and icon pin signal

1 
2 
3

Carrier Detect 
Receive Data 
Transmit Data

4 
5 
6

Data Terminal Ready 
Signal Ground 
Data Set Ready

7 
8 
9

Request to Send 
Clear to Send 
Ring Indicator

connector and icon pin signal

1 
2 
3 
4

+5 VDC 
- Data 
+ Data 
Ground
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connector pin assignments
microphone

headphone

line-in audio

line-out audio

connector and icon (1/8”) pin signal

1 (Tip)
2 (Ring)
3(Shield)

Audio
Power
Ground

connector and icon (1/8”) pin signal

1 (Tip)
2 (Ring)
3(Shield)

Audio_Left
Audio_Right
Ground

connector and icon (1/8”) pin signal

1 (Tip)
2 (Ring)
3(Shield)

Audio_In_Left
Audio_In_Right
Ground

connector and icon (1/8”) pin signal

1 (Tip)
2 (Ring)
3(Shield)

Audio_Out_Left
Audio_Out_Right
Ground
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connector pin assignments
Ultra SCSI

SATA

connector and icon

pin signal pin signal pin signal pin signal

1-11 
12 
13 
14

Ground 
Reserved 
Open 
Reserved

29 
30 
31 
32

DB3 
DB4 
DB5 
DB6

37 
38 
39 
40

Reserved 
TERMPWR 
Reserved 
Ground

45 
46 
47 
48

RST # 
MSG # 
SEL # 
C/D

15-25 
26 
27 
28

Ground 
DB0 
DB1 
DB2

33 
34 
35 
36

DB7 
DBP 
Ground 
Ground

41 
42 
43 
44

ATN # 
Ground 
BSY # 
ACK #

49 
50

REQ # 
Input/Output

connector

pin usage pin usage pin signal

data 
cable

power 
cable

power 
cable

S-1 Ground P-1 3.3 V power P-8 5 V power

S-2* A+ P-2 3.3 V power P-9 5 V power

S-3* A- P-3 3.3 V power P-10 Ground

S-4 Ground P-4 Ground P-11 Reserved

S-5** B- P-5 Ground P-12 Ground

S-6** B+ P-6 Ground P-13 12 V power

S-7 Ground P-7 5 V power P-14 12 V power

* S2 and S3 differential signal pair
**S5 and S6 differential signal pair

P-15 12 V power
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connector pin assignments
monitor

NOTE: Monitor connectors may vary depending on your configuration.

ATA/ATAPI (IDE) standard drive cable

connector and icon

pin signal pin signal pin signal

1 
2 
3

Red Analog 
Green Analog 
Blue Analog

6 
7 
8

Ground 
Ground 
Ground

11 
12 
13

Monitor ID 
DDC Serial Data 
Horizontal Sync

4 
5

Monitor ID 
Ground

9 
10

+5V DC 
Ground

14 
15

Vertical Sync 
DDC Serial Clock

connector

pin signal pin signal pin signal

1 
2 
3 
4 
5

Reset 
Ground 
DD7 
DD8 
DD6

15 
16 
17 
18 
19

DD1 
DD14 
DD0 
DD15 
Ground

29 
30 
31 
32 
33

DMAK 
Ground 
INTRQ 
IOCS16 
DA1

6 
7 
8 
9 
10

DD9 
DD5 
DD10 
DD4 
DD11

20 
21 
22 
23 
24

(Key) 
DMARQ 
Ground 
DIOW 
Ground

34 
35 
36 
37 
38

PDIAG (cable detect) 
DA0 
DA2 
CS1FX 
CS3FX

11 
12 
13 
14

DD3 
DD12 
DD2 
DD13

25 
26 
27 
28

DIOR 
Ground 
IORDY 
CSEL

39 
40 
 

DASP 
Ground 
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connector pin assignments
accelerated graphics port (AGP)
connector

pin signal A signal B pin signal A signal B

1 
2 
3 
4 
5

+12 V 
TYPEDET# 
Reserved 
USB- 
Ground

OVRCNT# 
+ 5V  
+ 5V  
USB+ 
Ground

34 
35 
36 
37 
38

Vddq  
AD22 
AD20 
Ground 
AD18

Vddq  
AD21 
AD19 
Ground 
AD17

6 
7 
8 
9 
10

INTA# 
RST# 
GNT# 
VCC3.3 
ST1

INTB# 
CLK 
REQ# 
VCC3.3 
ST0

39 
40 
41 
42 
43

AD16 
Vddq 
FRAME# 
Reserved 
Ground

C/BE2# 
Vddq 
IRDY# 
3.3VAux 
Ground

11 
12 
13 
14 
15

Reserved 
PIPE# 
Ground 
WBF# 
SBA1

ST2 
RBF# 
Ground 
Reserved 
SBA0

44 
45 
46 
47 
48

Reserved 
VCC 3.3 
TRDY# 
STOP# 
PME#

Reserved 
VCC 3.3 
DEVSEL# 
Vddq  
PERR#

16 
17 
18 
19 
20

VCC 3.3 
SBA3 
SB_STB# 
Ground 
SBA5

VCC 3.3 
SBA2 
SB_STB 
Ground 
SBA4

49 
50 
51 
52 
53

Ground 
PAR 
AD15 
Vddq 
AD13

Ground 
SERR# 
C/BE1# 
Vddq 
AD14

21 
22 
23 
24 
25

SBA7 
Reserved 
Ground 
Reserved 
VCC 3.3

SBA6 
Reserved 
Ground 
3.3 Vaux 
VCC 3.3

54 
55 
56 
57 
58

AD11 
Ground 
AD9 
C/BE0# 
Vddq 

AD12 
Ground 
AD10 
AD8 
Vddq 

26 
27 
28 
29 
30

AD30 
AD28 
VCC 3.3 
AD26 
AD24

AD31 
AD29
VCC 3.3 
AD27 
AD25

59 
60 
61 
62 
63

AD_STB0# 
AD6 
Ground 
AD4 
AD2

AD_STB0 
AD7 
Ground 
AD5
AD3

31 
32 
33

Ground 
AD_STB1# 
C/BE3#

Ground 
AD_STB1 
AD23

64 
65 
66

Vddq  
AD0 
VREFGC

Vddq 
AD1 
VREFCG
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connector pin assignments
20-pin power

4-pin power (for CPU)

connector

pin signal pin signal pin signal pin signal

1 
2 
3 
4 
5

+3.3 V 
+3.3 V 
GND 
+5 V 
GND

6 
7 
8 
9 
10

+5 V 
GND 
POK 
+5 Vaux 
+12 V

11 
12 
13 
14 
15

+3.3 V 
-12 V 
GND 
PSON 
GND

16 
17 
18 
19 
20

GND 
GND 
open 
+5 V 
+5 V

20

10

11�
�

1

connector and icon pin signal

1 GND

2 GND

3 +12 V

4 -12 V
hp workstation xw4100 service and technical reference guide E–7



connector pin assignments
E–8 hp workstation xw4100 service and technical reference guide



F
power cord set requirements

The power supply for this workstation has a power switch. This feature allows the workstation to 
be operated on an input voltage of 100-200V or 200-400V.

The power cord set (flexible cord or wall plug) received with this product meets the requirements 
for use in the country where you purchased the equipment.

If you need to obtain a power cord for a different country, you should purchase a power cord that 
is approved for use in that country.

The power cord must be rated for the product and for the voltage and current marked on the 
product’s electrical ratings label. The voltage and current rating of the cord should be greater 
than the voltage and current rating marked on the product. In addition, the diameter of the wire 
must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord must be between 6 feet 
(1.8 m) and 12 feet (3.6 m). If you have questions about the type of power cord to use, contact the 
HP authorized service provider.

A power cord should be routed so that it is not likely to be walked on or pinched by items placed 
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point 
where the cord exits from the product.
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G
routine care

general cleaning safety precautions
1. Never use solvents or flammable solutions to clean the workstation.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth 
and then use the cloth on the component.

3. Always unplug the workstation when cleaning with liquids or damp cloths.

4. Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

cleaning the workstation case
Follow all safety precautions stated earlier before cleaning the workstation.

To clean the workstation case, follow the procedures described below:

■ To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

■ For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it 
with a cloth or swab dampened with clear water.

■ For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will 
evaporate quickly and not leave a residue.

■ After cleaning, always wipe the unit with a clean, lint-free cloth.

■ Occasionally clean the air vents on the workstation. Lint and other foreign matter can block 
the vents and limit the airflow.
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routine care
cleaning the keyboard
Follow all safety precautions stated earlier before cleaning the keyboard.

When cleaning debris from under the keys, review all rules in Section before following these 
procedures:

Ä
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under 
the keys. 

■ Visible debris underneath or between the keys may be removed by vacuuming or shaking.

■ Canned, pressurized air may be used to clean debris from under the keys. Caution should be 
used as too much air pressure can dislodge lubricants applied under the wide keys.

■ If you remove a key, use a specially designed key puller to prevent damage to the keys. This 
tool is available through many electronic supply outlets.

Ä
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.

■ Cleaning under a key may be done with a swab moistened with isopropyl alcohol and 
squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. 
Use tweezers to remove any fibers or dirt in confined areas. Allow the parts to air dry before 
reassembly.

cleaning the monitor
■ Wipe the monitor screen with a clean cloth moistened with water or with a towelette 

designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the 
liquid may seep into the housing and damage a component. Never use solvents or flammable 
liquids on the monitor.

■ To clean the monitor body follow the procedures in Section .    

cleaning the mouse
Before cleaning the mouse, ensure that the power to the workstation is turned off.

■ Clean the mouse ball by first removing the retaining plate and the ball from the housing. 
Pull out any debris from the ball socket and wipe the ball with a clean, dry cloth before 
reassembly. 

■ To clean the mouse body, follow the procedures in.
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H
additional password security and 

resetting CMOS

This workstation supports security password features, which can be established through the 
Computer Setup Utilities menu. These features are:

■ setup password

■ power-on password

When you establish only a setup password, the power-on password is required to access 
Computer Setup and any other information on the workstation. When you establish both 
passwords, only the setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on 
password as an override to log in to the workstation. This is a useful feature for a network 
administrator.

If you forget the password for the computer, there are two method for clearing that password so 
you can gain access to the information on the workstation.

■ resetting the password jumper

■ using the Clear CMOS button

Ä
CAUTION: Pushing the CMOS button resets CMOS values to factory defaults and erases any 
customized information including passwords, asset numbers, and special settings. It is important to back 
up the workstation CMOS settings before resetting them in case they are needed later. To back up the 
CMOS settings, use Computer Setup and run the Save to Diskette option from the File menu.

resetting the password jumper
To disable the power-on or setup password features, or clear the power-on or setup passwords, 
complete the following steps:

1. Shut down the operating system and then turn off the workstation and any external devices. 
Disconnect the power cord of the workstation and any external devices from the power 
outlets.

2. Disconnect the keyboard, monitor, and any other external devices that are connected to the 
workstation.

Å
WARNING: To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching.

Ä
CAUTION: When the workstation is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in damage 
to the system.
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additional password security and resetting CMOS
Ä
CAUTION: Static electricity can damage the electronic components of the workstation or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

3. Remove the hood cover.

4. Locate the header and jumper.

NOTE: The password jumper is green so that it can be easily identified. For assistance locating the 
password jumper and other system board components, see the “system board components” 
section in Chapter 1.

5. Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so 
it does not get lost.

6. Replace the hood cover.

7. Reconnect the external equipment.

8. Plug in the workstation and turn on the power. Allow the operating system to start. This 
clears the current passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 
1 and 2, then repeat steps 6 through 8. Establish the new passwords in Computer Setup.

clearing and resetting the CMOS
The CMOS of the workstation stores password information and information about the 
workstation configuration. This section describes the steps to successfully clear and reset the 
CMOS.

using the CMOS button
1. Shut down the operating system and then turn off the workstation and any external devices. 

Disconnect the power cord of the workstation and any external devices from the power 
outlets.

2. Disconnect the keyboard, monitor, and any other external devices that are connected to the 
workstation.

Å
WARNING: To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching.

Ä
CAUTION: When the workstation is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in damage 
to the system.

Ä
CAUTION: Static electricity can damage the electronic components of the workstation or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.
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additional password security and resetting CMOS
3. Remove the hood cover.

Ä
CAUTION: Pushing the CMOS button resets CMOS values to factory defaults and erases any 
customized information including passwords, asset numbers, and special settings. It is important to back 
up the workstation CMOS settings before resetting them in case they are needed later. To back up the 
CMOS settings, use Computer Setup and run the Save to Diskette option from the File menu.

4. Locate, press, and hold the CMOS button in for five seconds.

NOTE: Make sure that the AC power cord is disconnected from the power outlet. The CMOS 
button does not clear CMOS if the power cord is connected.

NOTE: For assistance locating the CMOS button and other system board components, see the 
“system board components” section in Chapter 1.

5. Replace the hood cover.

6. Reconnect any external devices.

7. Plug in the workstation power and turn the power back on.

NOTE: The workstation passwords and any special configurations along with the system date and 
time will have to be reset.

using Computer Setup to reset CMOS
To reset CMOS using Computer Setup, access the Computer Setup Utilities menu. When the 
Computer Setup message appears in the lower-right hand corner of the screen, press the F10 key. 
Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, the workstation must be 
turned off, then on again, to access the utility.

From the Computer Setup menu, select File > Set Defaults and Exit. This restores the soft 
settings that include boot sequence order and other factory settings. It does not, however, force 
hardware rediscovery.

NOTE: The workstation passwords and any special configurations along with the system date and 
time will have to be reset.
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I
quick troubleshooting flowcharts

This appendix presents some quick troubleshooting flowcharts for some common issues. 
Additional information about troubleshooting can be found in Chapter 5 of this guide.

NOTE: The flowcharts presented here are for general troubleshooting purposes only and they may 
not apply to your specific workstation.
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quick troubleshooting flowcharts
initial troubleshooting
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quick troubleshooting flowcharts
no power

no power, part 1
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quick troubleshooting flowcharts
no power, part 2
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quick troubleshooting flowcharts
no power, part 3
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quick troubleshooting flowcharts
no video

no video, part 1
I–6 hp workstation xw4100 service and technical reference guide



quick troubleshooting flowcharts
no video, part 2
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quick troubleshooting flowcharts
no video, part 3
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quick troubleshooting flowcharts
error messages

error messages, part 1
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quick troubleshooting flowcharts
error messages, part 2
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quick troubleshooting flowcharts
error messages, part 3
hp workstation xw4100 service and technical reference guide I–11



quick troubleshooting flowcharts
no OS loading
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quick troubleshooting flowcharts
no OS loading from hard drive

no OS loading from hard drive, part 1
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quick troubleshooting flowcharts
no OS loading from hard drive, part 2
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quick troubleshooting flowcharts
no OS loading from hard drive, part 3
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quick troubleshooting flowcharts
no OS loading from diskette drive
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quick troubleshooting flowcharts
no OS loading from CD-ROM drive
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quick troubleshooting flowcharts
no OS loading from network
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quick troubleshooting flowcharts
non-functioning device
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20-pin power connector pin assignments E–7
4-pin power connector pin assignments E–7

A
access to computer, controlling 3–20
AGP

card installing and removing 4–19
connector pin assignments E–6
power specifications 1–5

Altiris eXpress 3–13
asset tracking and security 3–20
AssetControl 3–20

B
battery

disposal 4–7
handling 4–7
installing and removing 4–21
real-time clock 5–20

bezel blanks, installing and removing 4–10
blank screen 5–27
blinking power-on light 3–18
Boot Block ROM 3–15
boot order 3–5
bootable disk, important information 3–30
bus options 3–9

C
cable

multi-mode SCSI B–2
proper handling 4–6
SCSI adapter B–1

cable lock
Kensington 3–30
provision 3–30

cable select drive A–1
cables and connectors 4–6
categories, Diagnostics for Windows 5–3
cautions

adding devices 2–1
batteries 4–7
cable routing B–1, C–1
cables 4–6, 4–7

cooling fan 4–6, 4–7
cover lock security 3–27
FailSafe Key 3–28
installation 2–1
keyboard cleaning G–2
keyboard keys G–2
protecting ROM 3–14

CD-ROM and DVD-ROM
jumpers A–7

CD-ROM drive
See optical drive

chain termination, SCSI B–2
changing operating systems, important information 

3–19
changing password 3–24
chassis feet, installing and removing 4–11
cleaning

keyboard G–2
monitor G–2
mouse G–2

clearing password 3–25
cloning tools, software 3–12
CMOS

button H–2
clearing and resetting H–2

COA label location 1–4
components

front panel 1–1
rear panel 1–2

computer pauses 5–20
Computer Setup (F10)

Advanced functions 3–8
File functions 3–3
menu 3–3
overview 3–1
Security functions 3–5
Storage functions 3–3
using 3–2
utilities 3–2, 3–17

Configuration Record Utility 3–32
installing 3–32
running 3–32
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configuring power button 3–18
connectors

front panel 1–1
pin assignments E–1
rear panel 1–2
system board 1–3

controlling access to computer 3–20
cover lock security, caution 3–27
cover lock, SMART 3–27
customizing software 3–12

D
data integrity 3–31
date and time display 5–20
deleting password 3–24
delimiter characters, table 3–25
deployment tools, software 3–12
desktop management 3–12
Desktop Management Interface (DMI) 3–19
device

onboard 3–9
options 3–10
PCI 3–9
security 3–7

device configuration 3–3
device drivers

installing/upgrading 2–1
obtaining 2–4

diagnostic
error codes 5–9
light codes 5–7

diagnostic tool for hard drives 3–31
Diagnostics for Windows 5–2

categories 5–3
detecting 5–2
installing 5–2
Menu Bar 5–4
overview 5–2
running tests 5–5

DIMMs, installing and removing 4–18
disk, cloning 3–12
diskette drive

error codes 5–12
installing and removing 4–25
location 1–1
troubleshooting 5–23

DMI (Desktop Management Interface) 3–19
documentation library CD 1–8
drive

cable select A–1

capacities A–9
device designation A–1
Drive Protection System (DPS) 3–31
partition size A–9
protecting 3–31
replacement type A–6

Drive Protectioin System 3–31
DriveLock

applications and recommendations 3–26
overview 3–25
password setup 3–6
security purpose 3–21
using 3–26

dual-state power button 3–18
DVD-ROM drive

See optical drive

E
ECC Fault Prediction and Prefailure Warranty 3–31
energy savings, settings for 3–18
Energy Star 1–6
entering

power-on password 3–23
setup password 3–23

error codes
audio 5–16
CD-ROM and DVD-ROM 5–16
diskette drive 5–12
hard drive 5–13
keyboard 5–11
memory 5–11
modem 5–13
network interface 5–16
parallel port 5–12
pointing devices 5–17
serial port 5–12
special 5–17
tape drive 5–14
test 5–18
video 5–14

ESD (electrostatic discharge)
materials and equipment 4–4
preventing damage 4–3

Ethernet RJ-45 connector pin assignments E–1

F
FailSafe

Boot Block ROM 3–15
Key, caution 3–28
Key, ordering 3–28

FailSafe key
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obtaining 3–28
using 3–28

fault notification and recovery 3–30
formatting disk, important information 3–30
front bezel, installing and removing 4–10
front panel assembly, installing and removing 4–12
front panel components 1–1
front panel, troubleshooting 5–33

G
Getting Started Guide 1–8
graphics adapter location 1–2
graphics card

installing and removing 4–19
power specifications 1–5

grounding methods 4–4

H
handling the workstation 4–6
hard drive

diagnostic tool 3–31
error codes 5–13
IDE performance 4–26
installing and removing 4–25
jumper settings 5–25
proper handling 4–6
SCSI drives B–1
troubleshooting 5–25
Ultra ATA A–1

hardware
removal and replacement 4–1, 4–8
troubleshooting 5–35

headphone
jack location 1–1

heatsink, installing and removing 4–17
hood cover

installation and removal 4–9
removal and replacment warning 4–2

hood cover sensor
enabling 3–6
installing and removing 4–15
overview 3–27
purpose 3–21
setting protection level 3–27

HP Insight Manager LC 3–14
HP Intelligent Manageability 3–12
Hyper-Threading Technology 1–7

I
ID numbers, SCSI B–1
IDE connector pin assignments E–5

IEEE-1394
connector location 1–1
installing and removing 4–11

Illustrated Parts Map 1–8
information

finding additional 1–8
safety 4–2
system 3–3

initial configuration 3–12
Insight Manager LC 3–14
installing

AGP cards 4–19
battery 4–21
bezel blanks 4–10
chassis feet 4–11
Configuration Record Utility 3–32
Diagnostics for Windows 5–2
DIMMs 4–18
diskette drive 4–25
front bezel 4–10
front panel assembly 4–12
hard drive 4–25
heatsink 4–17
hood cover 4–9
hood cover sensor 4–15
IEEE-1394 4–11
Kensington cable lock 4–9
memory 4–18
optical drive (desktop) 4–23
optical drive (minitower) 4–21
PCI expansion cards 4–20
power button assembly 4–13
power supply 4–13
security lock 4–8
solenoid hood cover lock 4–16
speaker 4–16
system board 4–26
system fan 4–14

Intelligent Manageability 3–19
internal computer temperature 3–31
invalid system ROM 3–15

J
jumper positions

Zip drive A–8
jumpers

CD-ROM and DVD-ROM A–7
hard drive 5–25
resetting passwords H–1
SCSI drives B–4
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Zip drive A–8

K
Kensington cable lock 3–30

installation and removal 4–9
overview 3–30
purpose 3–22

keyboard
cleaning G–2
connector pin assignments E–1
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delimiter characters, national 3–25
error codes 5–11
light combinations 3–16
lights, ROM, table 3–16
PS/2 connector location 1–2
troubleshooting 5–32

L
lifting the workstation 4–6
line-in audio

connector location 1–2
line-out audio

connector location 1–2
Linux

device drivers 2–3
low voltage differential (LVD) B–2

M
Master Boot Record

restoring 3–7
saving 3–6
security 3–6
security overview 3–29
security purpose 3–21

memory
error codes 5–11
guidelines 4–18
installing and removing 4–18
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